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Preface

This section provides supporting information for the Oracle Financial Services International 
Financial Reporting Standards Application Pack (OFS IFRS) Installation and Configuration 
Guide and includes the following topics:

• Summary

• Audience

• Related Documents

• Conventions

• Abbreviations

Summary
You can find the latest copy of this document in OHC Documentation Library which includes 
all the recent additions/revisions (if any) done till date.

Before you begin the installation, ensure that you have access to the Oracle Support Portal with 
the required login credentials to quickly notify us of any issues at any stage. You can obtain the 
login credentials by contacting Oracle Support.

Audience
Oracle Financial Services International Financial Reporting Standards Application Pack 
Installation and Configuration Guide is intended for administrators, and implementation 
consultants who are responsible for installing and maintaining the application pack 
components. 

Prerequisites for the Audience
Following are the prerequisites for administrators installing OFS IFRS:

This document assumes that you have experience in installing Enterprise components and basic 
knowledge about the following are recommended:

• OFS IFRS components

• OFSAA Architecture

• UNIX Commands

• Database Concepts

• Web Server/ Web Application Server

http://docs.oracle.com/cd/E60058_01/homepage.htm
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Related Documents
For more information, see the following documents in the Oracle Financial Services 
International Financial Reporting Standards Application Pack 8.x documentation set:

• Oracle Financial Services Loan Loss Forecasting and Provisioning User Guide

• Oracle Financial Services Hedge Management User Guide

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an 
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which 
you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code in 
examples, text that appears on the window, or text that you enter.

Abbreviations
The following table lists the abbreviations used in this document:

Abbreviation Meaning

AIX Advanced Interactive eXecutive

DEFQ Data Entry Forms and Queries

DML Data Manipulation Language

EAR Enterprise Archive

EJB Enterprise JavaBean

ERM Enterprise Resource Management

FTP File Transfer Protocol

GUI Graphical User Interface

HTTPS Hypertext Transfer Protocol Secure

Infodom Information Domain

J2C J2EE Connector

J2EE Java 2 Enterprise Edition

JDBC Java Database Connectivity

JDK Java Development Kit

JNDI Java Naming and Directory Interface

JRE Java Runtime Environment

JVM Java Virtual Machine

LDAP Lightweight Directory Access Protocol

LHS Left Hand Side
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MFA Multi-Factor Authentication

MOS My Oracle Support

OFSAAI Oracle Financial Services Analytical Application Infrastructure

OHC Oracle Help Center

OLAP On-Line Analytical Processing

OS Operating System

RAM Random Access Memory

RDMS Relational Database Management System

SFTP Secure File Transfer Protocol

SID System Identifier

SSL Secure Sockets Layer

TDE Transparent Data Encryption

TNS Transparent Network Substrate

URL Uniform Resource Locator

VM Virtual Machine

Web Archive WAR

XML Extensible Markup Language

Abbreviation Meaning
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1About OFSAA and OFSAA Application Packs

This chapter includes the following topics:

• About Oracle Financial Services Analytical Applications (OFSAA)

• About Oracle Financial Services Analytical Applications (OFSAA) Application Packs

• About Oracle Financial Services Financial Accounting and Reporting Standards (IFRS and 
CECL) Application Pack

• About Oracle Financial Services Analytical Applications Infrastructure (OFS AAI)

About Oracle Financial Services Analytical Applications 
(OFSAA)

In today's turbulent markets, financial institutions require a better understanding of their 
risk-return, while strengthening competitive advantage and enhancing long-term customer 
value. Oracle Financial Services Analytical Applications (OFSAA) enable financial institutions 
to measure and meet risk adjusted performance objectives, cultivate a risk management culture 
through transparency, lower the costs of compliance and regulation, and improve insight into 
customer behavior.

OFSAA uses industry-leading analytical methods, shared data model and applications 
architecture to enable integrated risk management, performance management, customer insight, 
and compliance management. OFSAA actively incorporates risk into decision making, enables 
to achieve a consistent view of performance, promote a transparent risk management culture, 
and provide pervasive intelligence.

Oracle Financial Services Analytical Applications delivers a comprehensive, integrated suite of 
financial services analytical applications for both banking and insurance domain. 

About Oracle Financial Services Analytical Applications 
(OFSAA) Application Packs

The following figure depicts the various application packs that are available across the OFSAA 
Banking and Insurance domains: 
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Figure 1–1 OFSAA Application Packs

 

About Oracle Financial Services Financial Accounting and 
Reporting Standards (IFRS and CECL) Application Pack

OFS IFRS Pack includes the following applications:

• Oracle Financial Services Loan Loss Forecasting and Provisioning: International 
Financial Reporting Standards (IFRS) guidelines have set out new requirements on 
classification and measurement of financial assets and liabilities. It specifies two 
approaches for the measurement of assets namely Amortized Cost and Fair Value 
approach. The scope of Oracle Financial Services Loan Loss Forecasting and Provisioning 
is to focus only on the amortized cost approach.
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• Oracle Financial Services Hedge Management: To help financial institutions grow, 
manage risk, and optimize shareholder value, Oracle delivers a comprehensive, integrated 
suite of financial services analytical applications for enterprise performance management 
(EPM).

More than ever, financial institutions, their regulators as well as their shareholders are 
focused on the need to measure and meet risk-adjusted performance objectives, price 
products to reflect their true risk, and better understand how their institution is impacted by 
threats to liquidity, capital adequacy, and exposure to market rate volatility.

About Oracle Financial Services Analytical Applications 
Infrastructure (OFS AAI)

Oracle Financial Services Analytical Applications Infrastructure (OFS AAI) powers the Oracle 
Financial Services Analytical Applications family of products to perform the processing, 
categorizing, selection and manipulation of data and information required to analyze, 
understand and report on specific performance, risk, compliance and customer insight issues by 
providing a strong foundation for the entire family of Oracle Financial Services Analytical 
Applications across the domains of Risk, Performance, Compliance and Customer Insight.

Components of OFSAAI
The OFSAA Infrastructure includes frameworks that operate on and with the Oracle Financial 
Services Analytical Applications Data Model and forms the array of components within the 
Infrastructure. 

The OFSAA Infrastructure components/ frameworks are installed as two layers; primarily the 
metadata server and Infrastructure services run on one layer, and the UI and presentation logic 
runs on the other. The UI and presentation layer is deployed on any of the supported J2EE 
Servers.

The following figure depicts the various frameworks and capabilities that make up the OFSAA 
Infrastructure:

Figure 1–2 Components of OFSAAI
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OFSAA Infrastructure High Availability
The current release of the OFSAA Infrastructure supports only "Single Instance" installation for 
the Infrastructure components. However, the High Availability (HA) for the Database Server 
and/ or the Web Application Server clustering and deployment are supported in this 
release.This release supports Active-Passive model of implementation for OFSAAI 
components. For more information, see Configuration for High Availability- Best Practices 
Guide.

About Data Security Configurations
Data Security refers to the protection of data against unauthorized access and data theft. 
OFSAA ensures Data Security with the following features:

• Multi-Factor Authentication

• Transparent Data Encryption (TDE)

• Data Redaction

• Key Management

• HTTPS

• CSRF

• Logging

For more details on the features in the previous list, see the relevant topics in this guide and the 
Data Security and Data Privacy section in the Administration and Configuration Guide.
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2Understanding OFS Financial Accounting and 
Reporting Standards (IFRS and CECL) Pack 

Installation

This chapter includes the following topics:

• Installation Overview

• Deployment Topology

• Hardware and Software Requirements

• Verifying System Environment

• Understanding the Installation Modes

Installation Overview 
This release (8.0.7.0.0) of the OFS Financial Accounting and Reporting Standards (IFRS and 
CECL) Application Pack (also referred as IFRS in this document) bundles the upgrade patch 
set along with the base installer. Users/Administrators who wish to install a new OFS Financial 
Accounting and Reporting Standards (IFRS and CECL) Application Pack 8.0.7.0.0 instance or 
upgrade an existing OFS IFRS Application Pack 8.0.x instance to 8.0.7.0.0 should download 
this installer. The following figure depicts the order of procedures required to follow to install a 
new OFS IFRS Pack 8.0.7.0.0 instance. To upgrade an existing OFS IFRS Application Pack 
8.0.x.x.x instance to 8.0.7.0.0 release, refer to Upgrading the OFS Financial Accounting and 
Reporting Standards (IFRS and CECL) Application Pack Chapter.
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Figure 2–1 Installation Overview

Table 2–1 provides additional information and links to specific documentation for each task in 
the flowchart.

Table 2–1 OFSAA Application Pack Installation Tasks and Descriptions

Tasks Details and Documentation

Verify Systems Environment To verify that your system meets the minimum necessary requirements 
for installing and hosting the OFSAA Application Pack, see Verifying 
System Environment.

Obtain the software To access and download the OFSAA Application Pack, see Obtaining 
the Software.

Configure and Execute the 
Schema Creator Utility

To create the database schemas, see Configuring and Executing the 
Schema Creator Utility. 
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Deployment Topology
The following figure depicts the logical architecture implemented for OFS IFRS Application 
Pack.

Figure 2–2 Deployment Topology

 

Hardware and Software Requirements
This section describes the various Operating Systems, Database, Web Server, and Web 
Application Server versions, and other variant details on which this release of the OFS IFRS 
Application Pack has been qualified. 

Note:

OFS IFRS Application Pack installation can be performed on both Virtual and 
Physical servers.

The following tables show the minimum hardware and software requirements for installing 
OFS IFRS Application Pack:

Install OFS IFRS Pack To install the OFS IFRS Application Pack, see Installing the OFS IFRS 
Application Pack.

Configure OFS IFRS Pack To configure the OFS IFRS Application Pack post installation, see Post 
Installation Configuration.

Table 2–1 OFSAA Application Pack Installation Tasks and Descriptions

Tasks Details and Documentation
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Configurations supported for Java 7

Table 2–2  Configurations Supported for Java 7

Operating System

Oracle Linux / Red Hat 
Enterprise Linux (x86-64 bit)

• Red Hat Enterprise Linux or Oracle Linux Server release 6 
update 6 and above

• Red Hat Enterprise Linux or Oracle Linux Server release 7 
update 1 and above

Note: Same version of RHEL is supported.

Note: Oracle Enterprise Linux and Red Hat Enterprise Linux  5.x 
releases and AIX 5.3 are not supported in this release

Oracle Solaris (SPARC)/ 
Solaris x86-64 bit

• Oracle Solaris 5.10 update 11 with OS patches supporting Oracle 
Devstudio 12.5

• Oracle Solaris 5.11 update 3 with SRU9 or Higher

IBM AIX - PowerPC_
POWER7  (64 bit)  and 
PowerPC_POWER8 (64 bit)

• AIX 6.1 (TL 09 and above) - 64 bitx

AIX 7.1 (TL 03 and above) - 64 bit

Shell • KORN Shell (KSH)

Note: 

• If the OS is IBM AIX 6.1  and the file size limit for the AIX user on the target server is too small, 
configure the size parameter setting for "Large File Support". Follow these steps:

Change the file size limit for the user that initiates the transfer on the AIX system. To change the 
file size limit for a particular user, add or edit the fsize attribute for the user in the 
/etc/security/limits  file on the AIX system. Change the file size limit to unlimited (fsize = -1) or to 
a size equal to the size of the file being transferred. This may require an restart of the AIX server to 
pick up the new configuration. For more information refer IBM Support.

• If the operating system is RHEL, install the package lsb_release with one of the following 
commands by logging in as root user:

• yum install redhat-lsb-core

yum install redhat-lsb

Java Runtime Environment

Oracle Linux / Red Hat 
Enterprise Linux

Oracle Solaris

• Oracle Java Runtime Environment (JRE) 1.7.x - 64 bit

IBM AIX • IBM AIX Runtime, Java Technology JRE 1.7.x - 64 bit

Oracle Database Server and Client
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• Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC 
with/ without partitioning option

• Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.4.0 +) - 64 bit RAC/Non-RAC 
with/ without partitioning option, Advanced Security Option**.

• Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1.0 +) - 64 bit RAC/ Non-RAC 
with/ without partitioning option, Advanced Security Option**

** Note: See the “Additional Notes” section in the Tech Matrix for details.

• Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1.0 +)- 64 bit RAC/ Non-RAC 
with/ without partitioning option

• Oracle Database Server Enterprise Edition 12c Release 2 (12.2.0.1+)  

• Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

• Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit

• Oracle Client 12c Release 2 (12.2.0.1.0+) - 64 bit

• Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)

• Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver)

• Oracle 12C Release 2 (12.2.0.1+) JDBC driver (Oracle thin driver)

•  Oracle R Distribution version 3.2.0/3.3.0 (Optional)

• Oracle R Enterprise (Server) version 1.5 with ORD 3.2.0 and version 1.5.1 with ORD 3.3.0 
(Optional).

Note:

Ensure that the following patches are applied:

• For Oracle DB Server 12.1.0.1 and 12.1.0.2, download the patches 27010930 and 22205607 from 
My Oracle Support and apply them.

• For Oracle DB Server 11.2.0.4, download the patch 22205607 from My Oracle Support and apply.

• Also for latest information, refer http://support.oracle.com/, 12.1.0.2 Bundle Patches for 
Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1).

OLAP

Oracle Hyperion Essbase • V 11.1.2.1+ (Server and Client) with Oracle 11g Database

• V 11.1.2.3+ (Server and Client) with Oracle 12c Database

Note: Oracle Hyperion Essbase is required only if you are using the OLAP feature of OFSAAI.

Note:

• Oracle Hyperion Essbase and Oracle OLAP is required only if you are using the OLAP feature of 
OFSAAI. For Oracle OLAP, ensure that you have configured the Oracle Database server with 
OLAP option.

Web Server/ Web Application Server

Oracle Linux / Red Hat 
Enterprise Linux/ IBM AIX 

Oracle Solaris

Oracle HTTP Server 11.1.1.7.1/Oracle HTTP Server 12c/ Apache 
HTTP Server 2.2.x/ IBM HTTP Server 8.5.5

• Oracle Weblogic Server 12.2.x with jersey 2.25 (64 bit)

OFS IFRS is compatible with WebLogic 12.2.x and does not 
support WebLogic 12.1.3. If the WebLogic version is 12.1.3, 
upgrade to WebLogic 12.2.x.

• IBM WebSphere Application Server 8.5.5.9+ (Full Profile) with 
IBM Java Runtime - 64 bit

• Apache Tomcat 8.5.32

Table 2–2 (Cont.) Configurations Supported for Java 7

https://docs.oracle.com/cd/E55339_01/homepage.htm
http://support.oracle.com/
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Configurations supported for Java 8

Note:

• OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle 
JRockit is not supported.

Desktop Requirements

Operating System Microsoft Windows 7/Windows 8 /Windows 10

Browser • Microsoft Internet Browser 11.x

• Chrome 57.x

• FireFox 52.x

Turn on Pop-up blocker settings. For more information, see 
Configuring Internet Explorer Settings.

Office Tools • MS Office 2007/2010/2013 

• Adobe Acrobat Reader 8 or above

Screen Resolution 1024*768 or 1280*1024

Other Software

Directory Services OFSAAI is qualified on both OPEN LDAP 2.2.29+ and Oracle 
Internet Directory v 11.1.1.3.0. However, it can be integrated with 
other directory services software such as MS Active Directory.

Note:

• Configuration of Directory services software for OFSAAI installation is optional. For more 
information on configuration, see Setting Infrastructure LDAP Configuration. 

• Open LDAP must be installed on MS Windows Server machine.

Table 2–3  Configurations Supported for Java 8

Operating System

Oracle Linux / Red Hat 
Enterprise Linux (x86-64 bit)

• Red Hat Enterprise Linux or Oracle Linux Server release 6 
update 6 and above

• Red Hat Enterprise Linux or Oracle Linux Server release 7 
update 1 and above

Note: Same version of RHEL is supported.

Note: Oracle Enterprise Linux and Red Hat Enterprise Linux 5.x 
releases and AIX 5.3 are not supported in this release

Oracle Solaris (SPARC)/ 
Solaris x86-64 bit

• Oracle Solaris 5.10 update 11 with OS patches supporting Oracle 
Devstudio 12.5

• Oracle Solaris 5.11 update 3 with SRU9 or Higher

IBM AIX - PowerPC_
POWER7  (64 bit)  and 
PowerPC_POWER8 (64 bit)

• AIX 6.1 (TL 09 and above) - 64 bitx

AIX 7.1 (TL 03 and above) - 64 bit

Shell • KORN Shell (KSH)

Table 2–2 (Cont.) Configurations Supported for Java 7
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Note: 

• If the OS is IBM AIX 6.1 and the file size limit for the AIX user on the target server is too small, 
configure the size parameter setting for “Large File Support”. Follow these steps:

Change the file size limit for the user that initiates the transfer on the AIX system. To change the 
file size limit for a particular user, add or edit the fsize attribute for the user in the 
/etc/security/limits file on the AIX system. Change the file size limit to unlimited (fsize = -1) or to 
a size equal to the size of the file being transferred. This may require an restart of the AIX server to 
pick up the new configuration. For more information refer IBM Support.

• If the operating system is RHEL, install the package lsb_release using one of the following 
commands by logging in as root user:

• yum install redhat-lsb-core

yum install redhat-lsb

Java Runtime Environment

Oracle Linux / Red Hat 
Enterprise Linux

Oracle Solaris

• Oracle Java Runtime Environment (JRE) 1.8.x - 64 bit

IBM AIX • IBM AIX Runtime, Java Technology JRE 1.8.x - 64 bit

Oracle Database Server and Client

• Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC 
with/ without partitioning option

• Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.4.0 +) - 64 bit RAC/Non-RAC 
with/ without partitioning option, Advanced Security Option**.

• Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1.0 +) - 64 bit RAC/ Non-RAC 
with/ without partitioning option, Advanced Security Option**.

** Note: See the “Additional Notes” section in the Tech Matrix for details.

• Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

• Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit

• Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)

• Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver)

•  Oracle R Distribution version 3.2.0/3.3.0 (Optional)

• Oracle R Enterprise (Server) version 1.5 with ORD 3.2.0 and version 1.5.1 with ORD 3.3.0 
(Optional).

Note:

Ensure that the following patches are applied:

• Oracle Server 12c, v12.1.0.1 - 17082699

• Oracle Server 12c, v12.1.0.2 - 20698050

• For Oracle DB Server 12.1.0.1 and 12.1.0.2, download the patches 27010930 and 22205607 from 
My Oracle Support and apply them. 

• For Oracle DB Server 11.2.0.4, download the patch 22205607 from My Oracle Support and apply.

• Also for latest information, refer http://support.oracle.com/, 12.1.0.2 Bundle Patches for 
Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1).

• Oracle R Enterprise 1.5 and 1.5.1 requires Oracle Database Enterprise Edition 11.2.0.3/ 11.2.0.4/ 
12.1.0.1/12.1.0.2/12.2.0.1.

OLAP

Note: Oracle Hyperion Essbase is required only if you are using the OLAP feature of OFSAAI.

Web Server/ Web Application Server

Table 2–3 (Cont.) Configurations Supported for Java 8

http://support.oracle.com/
https://docs.oracle.com/cd/E55339_01/homepage.htm
https://docs.oracle.com/cd/E55339_01/homepage.htm
https://docs.oracle.com/cd/E55339_01/homepage.htm
https://docs.oracle.com/cd/E55339_01/homepage.htm
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Following are the ORD and ORE versions compatible along with Oracle DB version:

Table 2–4 

SLl No.
Oracle R 
Enterprise

Oracle R 
Advanced 
Analytics for 
Hadoop

Open source R 
or Oracle R 
Distribution

Oracle Database 
Enterprise 
Edition

1 1.5.1 2.7.1 3.3.0 11.2.0.4, 12.1.0.1, 
12.1.0.2, 12.2.0.1

2 1.5.0 2.5.1, 2.6.0, 2.7.0 3.2.0 11.2.0.4, 12.1.0.1, 
12.1.0.2

Oracle Linux / Red Hat 
Enterprise Linux / IBM AIX

Oracle Solaris

Oracle HTTP Server 11.1.1.7.1/Oracle HTTP Server 12c/ Apache 
HTTP Server 2.2.x/ IBM HTTP Server 8.5.5

• Oracle Weblogic Server 12.2.x with jersey 2.25 (64 bit)

• IBM WebSphere Application Server 8.5.5.9+ (Full Profile) with 
IBM Java Runtime - 64 bit

• Apache Tomcat 8.5.32

Note:

• OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle 
JRockit is not supported.

• For deployment on Oracle WebLogic Server 12.2.x+ (64 bit) with Java 8, download and install 
patch 18729264 from http://support.oracle.com/. 

Desktop Requirements

Operating System Microsoft Windows 7/Windows 8 /Windows 10

Browser • Microsoft Internet Browser 11.x

• Chrome 57.x

• FireFox 52.x

Turn on Pop-up blocker settings. For more information, see 
Configuring Internet Explorer Settings.

Office Tools • MS Office 2007/2010/2013 

• Adobe Acrobat Reader 8 or above

Screen Resolution 1024*768 or 1280*1024

Other Software

Directory Services OFSAAI is qualified on both OPEN LDAP 2.2.29+ and Oracle 
Internet Directory v 11.1.1.3.0. However, it can be integrated with 
other directory services software such as MS Active Directory.

Note:

• Configuration of Directory services software for OFSAAI installation is optional. For more 
information on configuration, see Setting Infrastructure LDAP Configuration. 

• Open LDAP must be installed on MS Windows Server machine.

Table 2–3 (Cont.) Configurations Supported for Java 8

http://support.oracle.com/


Note: To upgrade an existing OFSAA 8.0.x Java 7 instance to Java 8, refer 
Appendix P.

To configure the Oracle Database 19c Server and Client on a

new installation, see MOS Doc ID: 2691006.1.
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Following table provides the recommended software combinations for OFS IFRS Applications 
Pack deployment

Table 2–5 Recommended Software Combinations

Operating System Database
Web Application 
Server Web Server

Oracle Linux 5.3 up 
to 5.10/ 6.0 and 
above 

Oracle Database Oracle WebLogic Server 
/Apache Tomcat Server

Oracle HTTP Server/ 
Apache HTTP Server

Oracle Solaris 5.10/ 
5.11

Oracle Database Oracle WebLogic Server 
/Apache Tomcat Server

Oracle HTTP Server/ 
Apache HTTP Server

IBM AIX 6.1 Oracle Database IBM WebSphere 
Application Server 
/Apache Tomcat Server

IBM HTTP Server/ 
Apache HTTP Server

Verifying System Environment
To verify your system environment meets the minimum requirements for the installation, a 
Pre-Install Check utility is available within the Install Kit archive file. This utility can also be 
obtained separately by contacting Oracle Support.

Though the system environment verification is an integral and automated part of the installation 
of this software product, Oracle strongly recommends running this utility prior to beginning the 
installation as part of your organization's “Installation Readiness Verification Process”.

Note: For more details on download and usage of this utility, see Oracle 
Financial Services Analytical Applications Infrastructure Environment Check 
Utility Guide given in the Related Documents section.

Understanding the Installation Modes
The following modes of installation are available for the OFS IFRS Applications Pack.

• Installing in GUI Mode

• Installing in SILENT Mode

Installing in GUI Mode
This mode launches the product installation in a Graphical User Interface (GUI) mode. you 
must enter the required information on various windows within the UI in a user interactive 
format at various stages.

Note: For more information on configuration required for GUI mode 
installation, see Configuration for GUI Mode Installation.
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Installing in SILENT Mode
This mode mandates updating the installation configuration files with required details and 
performs installation in a “Silent” non user interactive format.
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3Preparing for Installation

This chapter provides necessary information to review before installing the OFS IFRS 
v8.0.7.0.0. This chapter includes the following topics:

• Installer and Installation Prerequisites

• Obtaining the Software

• Performing Common Installation Tasks

Installer and Installation Prerequisites
Table 3–1 provides the list of prerequisites required before beginning the installation for OFS 
IFRS application. The Installer/ Environment Check Utility notifies you if any requirements are 
not met.
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Table 3–1  Prerequisite Information

Category Sub-Category Expected Value

Environment 
Settings

Java Settings • PATH variable in .profile file must be set to include 
the Java Runtime Environment absolute path. The 
path should include Java version (7 or 8) based on 
the configuration.

Note:

• Ensure that the absolute path to JRE/bin is set at the 
beginning of PATH variable.
For example, 
PATH=/usr/java/jre1.7/bin:$ORACLE_
HOME/bin:$PATH 

• JAVA_HOME variable must be set in .profile file, 
pointing to the appropriate Java Runtime 
Environment Path.
For example, export JAVA_
HOME=/usr/jdk/instances/jdk1.6.0

• Ensure that SYMBOLIC links to JAVA installation 
are not set in the PATH variable.

• Ensure that you set the Heap Size in .profile file, 
using following command:
export _JAVA_OPTIONS="-Xms512m 
-Xmx1024m"
Heap size is a validation to get the memory size for 
Model Upload. If the Heap size is less than the ten 
times as of the Model, then it returns an error. 

Enable unlimited 
cryptographic policy 
for Java

For more information, see the section Enabling 
Unlimited Cryptographic Policy from the OFS Analytical 
Applications Infrastructure Administration Guide.

Oracle Database 
Settings

Oracle Database Server

• TNS_ADMIN variable must be set in .profile file 
pointing to appropriate tnsnames.ora file.

• Enable Transparent Data Encryption (TDE) and/ or 
Data Redaction**.

** Note: For more information, see Configuring 
Transparent Data Encryption (TDE) and Data 
Redaction in OFSAA. 

Oracle Processing Server

• ORACLE_HOME must be set in .profile file 
pointing to appropriate Oracle DB Client 
installation.

• PATH in .profile must be set to include appropriate 
$ORACLE_HOME/bin path.

• Ensure that an entry (with SID/SERVICE NAME) is 
added in the tnsnames.ora file.

Oracle Essbase 
Settings

• ARBORPATH, ESSBASEPATH, and HYPERION_
HOME variables must be set in the .profile file, 
pointing to an appropriate Oracle Essbase Client 
installation.

Note: 

These settings are required only if you want to use Oracle 
Hyperion Essbase OLAP features.

https://docs.oracle.com/cd/E60058_01/homepage.htm
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OS/ File System 
Settings

File Descriptor 
Settings

• Greater than 15000

Note: The value specified here is the minimum value to 
be set for the Installation process to go forward. For other 
modules, this value may depend on the available 
resources and the number of processes executed in 
parallel.

Total Number of 
Process Settings

• Greater than 4096

Note: The value specified here is the minimum value to 
be set for the Installation process to go forward. For other 
modules, this value may depend on the available 
resources and the number of processes executed in 
parallel.

Port Settings • Default port numbers to be enabled on the system 
are 6500, 6501, 6505, 6507, 6509, 6510, 6666, 
9999, and 10101.

.profile 
permissions

• User to have 755 permission on the .profile file.

Installation 
Directory

• A directory where the product files will be installed.

• Assign 755 permission to this directory. 

• This directory needs to be set as FIC_HOME.

Temporary Directory Default temporary directory where installation files are 
stored for a short period of time to support faster 
installation. 

• For installation on UNIX OS, your UNIX 
administrator must give you the required read-write 
permissions for the /tmp directory and disable the 
NOEXEC option.

• Configure adequate space on the /tmp directory. It is 
recommended that you allocate more than 10 GB of 
space.

Note: If NOEXEC is enabled, the extraction of files by 
the installer into the /tmp directory is prevented and the 
binaries will not execute in the directory, which will fail 
the installation.

Staging Area/ 
Metadata Repository

• A directory to hold the application metadata artifacts 
and additionally act as staging area for flat files. 

• The directory should exist on the same system as the 
OFSAA Installation. This directory can be 
configured on a different mount or under a different 
user profile. However, the owner of the installation 
directory that is mentioned in the previous row, must 
have RWX permissions on this folder.

• Assign 777 permission to this directory.

Note: This directory is also referred to as FTPSHARE 
folder.

Download Directory • A directory where the product installer files will be 
downloaded/ copied.

• Set 755 permission on this directory.

OS Locale • Linux: en_US.utf8

• AIX: EN_US.UTF-8

• Solaris: en_US.UTF-8

To check the locale installed, execute the following 

command:

locale -a | grep -i 'en_US.utf'

Table 3–1 (Cont.) Prerequisite Information

Category Sub-Category Expected Value
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Following step is applicable only if existing OFSAA setup version is 8.0.5.x.x and 
Configuration and Atomic Schema(s) were restored from exported dumps of other 
environment: 

Login to Configuration Schema and execute the following SQL statements:

alter table AAI_AOM_APP_COMP_ATTR_MAPPING drop constraint AOM_
APP_COMP_ATTR_PK drop index 

/

alter table AAI_AOM_APP_COMP_ATTR_MAPPING add constraint AOM_
APP_COMP_ATTR_PK primary key (APP_COMP_ATTR_MAP_ID) 

/

Note: Ensure that the tablespace(s) used for the database user(s) is set to 
AUTOEXTEND ON.

OFS IFRS Application pack v8.0.7.0.0 installer download contains only the ERwin XML file 
that is required for uploading the model. This file is sufficient to install the v8.0.7.0.0 
Application pack. However, this XML file cannot be opened in the ERwin Data modeler tool 
and hence cannot be used for any data model customization. ERwin file is delivered as a patch 
and need to be downloaded separately. This ERwin file should be used for any customization of 
the data model. To download the Data Model Erwin file, Login to https://support.oracle.com/ 
and search for 29320518 under the Patches & Updates tab. If customization to the data model 
has been done in environment being upgraded, then before uploading the same, customizations 
need to be applied again in merged data model.

Database Settings Database Instance 
Settings

• NLS_CHARACTERSET to be AL32UTF8

• NLS_LENGTH_SEMANTICS to be BYTE

OPEN CURSORS limit to be greater than 1000

Web Application 
Server

WebSphere/ 
WebLogic/ Tomcat

• Web Application Server should be installed and 
profile/domain created.

• You will be prompted to enter the WebSphere 
Profile path or WebLogic Domain path or Tomcat 
Deployment path during OFSAAI installation.

Note: See Configuring Web Server section for 
WebSphere Profile and WebLogic Domain Creation.

Web Server Apache HTTP 
Server/ Oracle 
HTTP Server/

IBM HTTP Server

.

This is an optional requirement. HTTP Server Installation 
to be present. You are prompted to enter the Web Server 
IP/Hostname and Port details during installation.

Note: See Configuring Web Server section for Web 
Server installation.

Others Oracle R/ Oracle R 
Enterprise

• This is an optional requirement.

• See section Installing Oracle R distribution and 
Oracle R Enterprise (ORE) for more details.

Table 3–1 (Cont.) Prerequisite Information

Category Sub-Category Expected Value

https://support.oracle.com/
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Obtaining the Software
The 8.0.7.0.0 release of OFS IFRS Application Pack can be downloaded from My Oracle 
Support (https://support.oracle.com/). You must have a valid Oracle account to download the 
software.

Performing Common Installation Tasks
The common pre-installation activities that you must carry out before installing the OFS IFRS 
application pack are the following:

• Configuration for GUI Mode Installation

• Identifying the Installation, Download, and Metadata Repository Directories

• Downloading and Copying the OFS IFRS Applications Pack Installer

• Extracting the Software

• Setting Up the Web Application Server 

• Installing Oracle R distribution and Oracle R Enterprise (ORE)

Configuration for GUI Mode Installation
To install OFS IFRS Application Pack in GUI mode, you need to ensure the below software 
and configurations are available:

• Install and configure any PC X Server software such as Open Text Exceed (formerly 
Hummingbird Exceed) on the user desktop system from which the installation is triggered.

• Configure the DISPLAY variable.

Ensure to set the DISPLAY variable on the system on which the OFSAA will be installed, 
to point to the user desktop system where the PC X Server software is installed.

Syntax:

export DISPLAY=hostname:n.n1 

where hostname is the IP Address/ Host Name of the user desktop system 
and n is the sequence number (usually 0).

For example, 10.11.12.13:0.0 or myhostname:0.0

Identifying the Installation, Download, and Metadata Repository 
Directories

To install OFSAA Application Packs, create the following directories.

• OFSAA Download Directory (Optional): Create a download directory and copy the 
OFSAA Application Pack Installer File (archive). This is the directory where the 
downloaded installer/ patches can be copied.

• OFSAA Installation Directory (Mandatory): Create an installation directory where the 
product binaries will be installed. Set the variable FIC_HOME in the .profile file to point 
to the OFSAA Installation Directory.

• OFSAA Staging/Metadata Directory (Mandatory): Create a Staging/Metadata 
Repository Directory to copy data files, save data extracts, and so on. Additionally, this 
directory also maintains the OFSAA metadata artifacts. This directory is also referred to as 
"FTPSHARE". This directory must be created on the same host as the OFSAA Installation 
Directory mentioned in the previous point in this list.

https://support.oracle.com/


Note:

? Assign 755 user permission to the Installation Directory.

• Assign 775 user permission to the Staging Directory.

• Ensure the OFSAA staging directory is not set to the same path as the OFSAA 
installation directory and is not a sub-folder inside the OFSAA installation 
directory.
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Downloading and Copying the OFS IFRS Applications Pack Installer
To download and copy the OFS IFRS Applications Pack Installer, follow these steps:

• To download the OFS IFRS Applications Pack, login to My Oracle Support 
(https://support.oracle.com/). You need to have a valid Oracle account in order to 
download the software.

• Copy the downloaded installer archive to the Download Directory (in Binary Mode) on the 
setup identified for OFS IFRS installation.

• If you have OFS IFRS Application pack version 8.0.4.0.0 onwards, then you can upgrade it 
to version 8.0.7.0.0.

• Download the mandatory one-off patches 29965853 and 29843175 from 
http://support.oracle.com/.

Extracting the Software
Once you obtain the installer, copy the installer (in BINARY mode) to the system on which the 
OFSAA Infrastructure components will be installed.

Note: : You must be logged in to the UNIX operating system as a non-root 
user.

1. Download the unzip utility (OS specific) unzip_<os>.z and copy it in Binary mode to the 
directory that is included in your PATH variable. If you already have the unzip utility to 
extract the contents of the downloaded archive, skip this step.

2. Uncompress the unzip installer file using the command:

uncompress unzip_<os>.Z

Note: If an error message “uncompress: not found [No such file or 
directory]” is displayed, contact your UNIX administrator.

3. Assign EXECUTE (751) permission to the file using the command:

chmod 751 unzip_<OS>

For example, chmod 751 unzip_sparc

4. Extract the contents of the OFS IFRS Application Pack 8.0.7.0.0 installer archive file in the 
download directory with the following command:

unzip OFS_IFRS_PACK.zip

http://support.oracle.com/
https://support.oracle.com/
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5. Extract and apply the patches 29965853 and 29843175. See the Readme available with the 
patch for further instructions on installing the patch.

6. Navigate to the download directory and assign execute (750) permission to the installer 
folder with the following command: 

chmod -R 755 OFS_IFRS_PACK

Setting Up the Web Application Server
For setting up the environment based on your selected Web Application Server, see 
Configuring Web Server section.

Installing Oracle R distribution and Oracle R Enterprise (ORE)
This is an optional step and required only if you intend to use Oracle R scripting in the Oracle 
Financial Services Enterprise Modeling Application or if the OFSAA Application that you have 
licensed uses this feature. For information on applications that use this feature, see the Tech 
Matrix.

The following is the instruction to install ORD and ORE:

Install Oracle R Distribution and Oracle R Enterprise (Server Components) on the Oracle 
Database server. See Oracle® R Enterprise Installation and Administration Guide for Windows, 
Linux, Solaris and AIX - Release 1.5 at Oracle R Enterprise Documentation Library.

ORD and ORE versions compatible along with Oracle DB version

Table 3–2 

Sl No.
Oracle R 
Enterprise

Oracle R 
Advanced 
Analytics for 
Hadoop

Open source R 
or Oracle R 
Distribution

Oracle Database 
Enterprise 
Edition

1 Oracle R 
Enterprise 1.5.1 
with Oracle R 
Distribution 3.3.0

Oracle  R 
Enterprise 1.5 with 
Oracle R 
Distribution 3.2.0 

2.6.0, 2.7.0 3.2.0 "Oracle Database 
Server 11g Release 
2 (11.2.0.3+ )  
Enterprise Edition

Oracle Database 
Server 11g Release 
2 (11.2.0.4+ ) (12) 
Enterprise Edition

Oracle Database 
Server 12c Release 
1(12.1.0.1+) 
Enterprise Edition

Oracle Database 
Server 12c Release 
2 (12.2.0.1+)(12) 
Enterprise Edition

• Oracle R Distribution versions supported- Oracle Distribution of R version 3.3.0 and 3.3.1.

• ORE version supported- Oracle R Enterprise (Server) version 1.5 with ORD 3.2.0.

Note: Oracle R Enterprise 1.5 requires Oracle Database Enterprise Edition 
11.2.0.4/ 12.1.0.1/12.1.0.2/12.2.0.1.

https://docs.oracle.com/cd/E55339_01/homepage.htm
https://docs.oracle.com/cd/E55339_01/homepage.htm
https://docs.oracle.com/cd/E67822_01/index.htm


Note: If you use ORE 1.5 for Oracle Financial Services Enterprise 
Modeling, you must set the session time zone in '$R_HOME/etc/Rprofile.site' 
file on the database server, where $R_ HOME is the home directory of the R 
instance on which ORE server packages are installed. Alternatively, you can 
set session time zone in scripts registered within OFS EM by using the 
'Sys.env(TZ=<time zone>)' R function.
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4Installing the OFS IFRS Application Pack

This chapter provides instructions to install the OFS IFRS pack.

This chapter includes the following sections:

• About Schema Creator Utility

• Configuring and Executing the Schema Creator Utility

• Installing the OFS IFRS Application Pack

Note: The Schema Creator job needs to be run first, if you are doing OFS 
IFRS 8.0.7.0.0 fresh installation on an existing pack. This will append the 
new artifacts in the existing instance.

Note: To configure the Oracle Database 19c Server and Client on a new 
installation, see MOS Doc ID: 2691006.1.

About Schema Creator Utility
Creating database users/schemas is one of the primary steps in the complete OFS IFRS 
installation process. Schema Creator utility facilitates you to quickly get started with the 
installation by creating Database User(s)/Schema(s), assigning the necessary GRANT(s), 
creating the required entities in the schemas, and so on.

The schema creator utility must be configured and executed before installation of any OFS 
IFRS Application Pack.

This section includes the following topics:

• About Schema Creator Utility

• Selecting Execution Modes in Schema Creator Utility

• Selecting Execution Options in Schema Creator Utility

About Schema Creator Utility
The schema creator utility should be configured and executed mandatorily every time prior to 
installation of any OFSAA Application Pack.

The following are the types of schemas that can be configured in the OFSAA:

• CONFIG - Denotes the unique OFSAA setup configuration schema. It contains entities 
and other objects required for OFSAA setup information.



Note: There can be only one CONFIG schema per OFSAA instance.
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• ATOMIC - Denotes the schema that contains the data model entities. One ATOMIC 
schema is attached to one Information Domain. 

Note:  There can be multiple ATOMIC schemas per OFSAA Instance, if you have 
multiple application packs being installed.

• SANDBOX - Denotes the schema that contains the data for all Sandbox executions. One 
SANDBOX schema is attached to one Sandbox Information Domain.

Note: There can be multiple SANDBOX schemas per OFSAA Instance.

Selecting Execution Modes in Schema Creator Utility
Schema creator utility supports the following two modes of execution:

• Online Mode: In this mode, the utility connects to the database and executes the Data 
Definition 

• Language (DDL) for User, Objects, and Grants. If you have the SYSDBA privileges you 
can execute the Schema Creator Utility in Online mode and create Users, Objects, and 
Grants during the execution process.

Note: To execute the utility in Online mode, you must connect as “<User> 
AS SYSDBA”

• Offline Mode: In this mode, the utility generates a SQL script with all the required DDLs 
for User, Objects and GRANTS. This script must be executed by the DBA on the 
appropriate database identified for OFSAA usage. If you do not have SYSDBA privileges, 
you can execute the Schema Creator Utility in Offline mode and generate the script file 
that contains the Schemas, Objects, and GRANTS information. Subsequently, a SYSDBA 
user must execute the script file manually.



Note: : 

1. To execute the utility in Offline mode, you need to connect as any user with the 
following grants (alternatively, you can also connect as a user with SYSDBA 
privileges):

• SELECT ON DBA_ROLES

• SELECT ON DBA_USERS

• SELECT ON DBA_DIRECTORIES

• SELECT ON DBA_TABLESPACES

• CREATE SESSION

2. If there are any errors during the script execution, reconfigure the OFS_IFRS_
SCHEMA_IN.XML file and execute the utility. This regenerates the scripts with 
corrected information.

For more information, see Configuring OFS_IFRS_SCHEMA_IN.XML File.

3. Do not modify the OFS_IFRS_SCHEMA_OUT.XML file generated after the 
execution of this utility.
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Selecting Execution Options in Schema Creator Utility
Depending on the option selected to run the OFSAA Application Pack Installer, you must select 
the appropriate schema creator utility execution option. To run the OFSAA Application Pack 
installer in Silent mode, it is mandatory to execute the schema creator utility with -s option.

Note: If the schema creator utility is executed without the option -s, it is 
mandatory to run the OFSAA Application Pack Installer in GUI mode.

Configuring and Executing the Schema Creator Utility
This section includes the following topics:

• Prerequisites

• Configuring the Schema Creator Utility

• Executing the Schema Creator Utility

Prerequisites
The prerequisites you must have before configuring the Schema Creator Utility are the 
following:

• Oracle User ID/Password with SYSDBA privileges.

• JDBC Connection URL for RAC/Non RAC database.

• HOSTNAME/IP of the server on which OFSAA is being installed.

• For enabling Transparent Data Encryption (TDE) in your OFSAA instance during 
installation, perform the steps explained in the Configuring Transparent Data Encryption 
(TDE) and Data Redaction in OFSAA.

Configuring the Schema Creator Utility
This section explains the steps to configure the Schema Creator Utility.
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To configure the Schema Creator Utility, follow these steps:

1. Log in to the system as non-root user.

2. Navigate to the following path: OFS_IFRS_PACK/schema_creator/conf directory.

3. Edit the OFS_IFRS_SCHEMA_IN.xml file in a text editor.

4. Configure the elements as described in the sectionConfiguring OFS_IFRS_SCHEMA_
IN.XML File.

5. Save the OFS_IFRS_SCHEMA_IN.xml file.

Note: On successful execution of the utility, the entered passwords in the 
OFS_IFRS_SCHEMA_IN.xml file are nullified.

Executing the Schema Creator Utility 
You can execute the schema creator utility in Online or Offline mode. This section includes the 
following topics:

• Executing the Schema Creator Utility in Online Mode

• Executing the Schema Creator Utility in Offline Mode

• Executing the Schema Creator Utility with -s Option

• Executing the Schema Creator Utility while Installing Subsequent Applications Pack

Executing the Schema Creator Utility in Online Mode
In Online mode, the Schema Creator Utility creates all the Schemas, Schema Objects, 
Tablespaces, Grants, and Roles in the database during the execution process.

To execute the Schema Creator Utility in Online mode, follow these steps:

1. Log in to the system as non-root user.

2. Navigate to the following path: OFS_IFRS_PACK/schema_creator/bin/

3. Execute the osc.sh file using the following command:

./osc.sh
The following message is displayed: 

You have chosen ONLINE mode. Triggering the utility in ONLINE mode will execute the 
DDLs directly on the Database. Do you wish to proceed? (Y/y or N/n).

4. Enter Y/ y to proceed with the script generation.

5. Enter the DB user name with SYSDBA Privileges. For example: SYS as SYSDBA.

6. Enter the User Password.

7. The console runs the initial validation checks and then displays the following message: 

You have chosen to install this Application Pack on <Name of the Atomic 
Schema>ATOMIC schema. Do you want to proceed? (Y/N). 

8. Enter Y/y to proceed with the schema creation.

 The following message is displayed.

You have chosen to install this Application Pack on <Name of the Infodom>. Do you want 
to proceed? (Y/N).
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Figure 4–1 Schema Creation - Online Mode

9. Enter Y/y to start the schema creation.

Note: 

• On successful execution of schema creator utility, the console displays 
the following status message:

Schema Creator executed successfully. Please proceed with the installation. 

• See log file in OFS_IFRS_PACK/schema_creator/logs directory for 
execution status. If there are any errors, contact Oracle Support.

Executing the Schema Creator Utility in Offline Mode
In Offline Mode, the Schema Creator Utility creates an output in SQL file format. This script 
must be executed manually by logging as database user with SYSDBA privileges. The SQL file 
contains the creation of Schemas, Schema Objects, Tablespaces, Grants, and Roles.

Prerequisites:

To execute the utility in Offline mode, you must connect a database user with the following 
grants (alternatively, you can also connect as a user with SYSDBA privileges):

• SELECT ON DBA_ROLES

• SELECT ON DBA_USERS

• SELECT ON DBA_DIRECTORIES

• SELECT ON DBA_TABLESPACES

• CREATE SESSION

Note: Explicit Grants to the user are required. Grants assigned through 
Roles are not supported.

To execute the schema creator utility in Offline mode, follow these steps:
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1. Log in to the system as non-root user.

2. Navigate to the OFS_IFRS_PACK/schema_creator/bin directory.

3. Execute the osc.sh file using the following command:

./osc.sh -o -s

4. The following message is displayed: 

You have chosen OFFLINE mode. Triggering the utility in OFFLINE mode will generate 
the script. Do you wish to proceed? (Y/y or N/n).

5. Enter Y /y to generate the script.

6. Enter the DB user name with SELECT privileges.

7. Enter the User Password.

Figure 4–2 Schema Creation - Offline Mode

 

8. The console runs the initial validation checks and displays the following message:

 You have chosen to install this Application Pack on <Name of the Atomic 
Schema>ATOMIC schema. Do you want to proceed? (Y/N). 

9. Enter Y/y to start the script generation.

The following message is displayed.

You have chosen to install this Application Pack on <Name of the Infodom>. Do you want 
to proceed? (Y/N)
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Figure 4–3 Schema Creation - Offline Mode

10. Enter Y/y to start the script generation. 

Figure 4–4 Schema Creator Utility - Offline

On successful execution of schema creator utility, the console displays the following status 
message: 

Schema Creator executed successfully. Please execute scratch/ofsaaapp/OFS_IFRS_
PACK/schema_creator/sysdba_output_scripts.sql before proceeding with the installation.

11. Navigate to the directory: 

OFS_IFRS_PACK/schema_creator
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12. Log in to SQLPLUS with a user having SYSDBA Privileges.

13. Connect to the Oracle DB Server on which the Application Pack installation is to be 
performed and execute the sysdba_output_scripts.sql file using the following command:

SQL>@sysdba_output_scripts.sql

Alternatively, you can copy the sysdba_output_scripts.sql file and SQLScripts directory 
to a remote server and execute the sysdba_output_scripts.sql file.

Note: See log sysdba_output_scripts.log file for execution status. If 
there are any errors, contact Oracle Support. If there are no errors in the 
execution, the log file is empty.

Executing the Schema Creator Utility with -s Option
If you intend to run the OFS IFRS Application Pack Installer in Silent mode, it is mandatory to 
execute the schema creator utility with -s option.

To execute the utility with -s option, follow these steps:

1. Edit the file OFS_IFRS_PACK/schema_creator/conf/OFS_IFRS_SCHEMA_IN.xml in 
text editor.

2. Execute the utility with -s option.

For example ./osc.sh -s.

Figure 4–5 Schema Creator Utility with -s Option

 

Note: 

• If the utility is executed without the -s option, it is mandatory to launch the 
OFSAA Applications Pack Installer in GUI mode.

• To execute the utility in OFFLINE mode with SILENT option, enter the 
following command
 ./osc.sh -o -s

3. Make a TNS entry for the new users created. For details, see Adding TNS entries in the 
TNSNAMES.ORA File section.
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Figure 4–6 Schema Creator Utility with -s Option

 

Executing the Schema Creator Utility while Installing Subsequent 
Applications Pack
While executing the schema creator utility for subsequent Applications Pack, you can choose to 
install the pack either on the same Information Domain/Atomic Schema or on a new 
Information Domain/Atomic Schema. You can execute the Schema Creator Utility either in 
Online or Offline Mode.

To execute the schema creator utility while installing OFS IFRS Application Pack over an 
existing Application Pack, follow these steps:

1. Repeat the steps 1 to 9 from the Executing the Schema Creator Utility section.

Note: Ensure to use the same config schema user name as the previous 
Application Pack.

2. The utility identifies the Application Packs that are already installed on the current OFSAA 
setup and displays the following on console:

• Atomic schema of the Existing Application Pack 

• Information Domain Name of the Existing Pack

• List of Installed Application Packs

3. Enter Y/y to start the schema creation.

If you enter N/n, the list of Atomic Users is displayed.

4. Select the Atomic User, on which you want to install the Application Pack.

5. Make a TNS entry for the new users created. For details, see Adding TNS entries in the 
TNSNAMES.ORA File section.

On successful execution of schema creator utility, the console displays the following status 
message:

Success. Please proceed with the installation. 

Note: 

• Refer log file in OFS_IFRS_PACK/schema_creator/logs folder for execution 
status.

• Refer log sysdba_output_scripts.log file for execution status, if executed in 
offline mode. This log would be empty if there are no errors in the execution.

• In case of any errors, contact Oracle Support.
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Installing the OFS IFRS Application Pack
This section provides instructions to install the OFS IFRS Application Pack depending on the 
mode of installation.

This section includes the following topics:

• Installing in SILENT Mode

• Installing in GUI Mode

• Verifying the Log File

Installing in SILENT Mode 
In the SILENT Mode Installation you must configure the product XML files and follow 
instructions in the command prompt.

To install OFS IFRS in SILENT mode, follow these steps:

1. Log in to the system as non-root user.

2. Identify a directory for installation and set the same in the user .profile file as follows:

FIC_HOME=<OFSAA Installation Directory>

export FIC_HOME

3. Execute the user .profile.

4. Navigate to OFS_IFRS_PACK directory.

5. Edit the OFS_IFRS_PACK/conf/OFS_IFRS_PACK.xml to enable the product licenses.

Note: •Ensure to enter Yes in ENABLE tag for OFS_AAI/APP_ID to install IFRS 
applications.

• See Configuring OFS_IFRS_PACK.xml File for details on configuring this XML 
file.

6. Edit the OFS_IFRS_PACK/schema_creator/conf/OFS_IFRS_SCHEMA_IN.xml file to set 
the appropriate attribute values.

Include INFODOM = "<Infodom Name>" in OFS_IFRS_SCHEMA_IN.xml file

Note: •Refer Configuring OFS_IFRS_SCHEMA_IN.XML File for details on 
configuring this XML file.

• Ensure to make a TNS entry for the new users created. For details, see Adding 
TNS entries in the TNSNAMES.ORA File section.

7. Edit the OFS_IFRS_PACK/OFS_AAI/conf/OFSAAI_InstallConfig.xml file to set the 
appropriate infrastructure installation attribute values.

Note: See Configuring OFSAAI_InstallConfig.xml file for details on 
configuring this XML file.

8. Execute the schema creator utility. 



Note: 

• This step is mandatory and should be executed before every OFSAA 
Application Pack installation.

• Ensure to execute with -s option in Online/Offline Mode. 

• For more information, see Executing the Schema Creator Utility.

Installing the OFS IFRS Application Pack

                                Installing the OFS IFRS Application Pack 4-33

9. Create a copy of the Silent.template file present in the installer folder OFS_IFRS_
PACK/OFS_IFRS/conf and rename it as Silent.props.

10. Edit the file Silent.props and specify the parameters as per the requirements.

SILENT installation is achieved via a properties file (Silent.props) that must be updated 
with proper values, before attempting to install using the silent mode. The following table 
lists all the properties that need to be specified.

Note: 

• The values of sources (ETL_SRC_1_NAME, and ETL_SRC_2_NAME) 
in silent.props file should be the same in both OFS ALM (if installed) 
and OFS IFRS.

Elements in Silent.props file

Table 4–1 

Property Name Description of Property
Permissible 
Values Comments

LOG_MODE Specify Log Mode 1 = Debug 
Mode

0= General 
Mode

Password will be printed in the 
log file

Default is GENERAL

SEGMENT_1_
CODE

Specify the Common Segment 
for IFRS.

User Input

SEGMENT_2_
CODE

Specify the Transitional Matrix 
Segment Code

User Input

APPFTP_LOG_
PATH

Specify the Infodom 
Maintenance log path (existing 
or new) for the Infodom.

If new Infodom, log path will 
be created accordingly.

User Input Do not ignore this property if 
the installation is being 
performed on an existing 
information domain.

DBFTP_LOG_PATH Specify the Infodom 
Maintenance log path (existing 
or new) for the Infodom.

If new Infodom, log path will 
be created accordingly.

User Input Do not ignore this property if 
the installation is being 
performed on an existing 
information domain.
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UPLOAD_MODEL Specify whether you want to 
perform Model Upload.

0 = If you 
have already 
performed 
Model Upload 
and want to 
skip model 
upload 
process.

1 = If you 
want to 
perform 
Model 
Upload.

MODEL_TYPE Specify whether you want to 
use the released data model or 
customized data model for 
model upload process

# 0 = If you 
want to upload 
the released 
data model.

# 1 = If you 
want to upload 
the 
customized 
data model.

DATAMODEL

DM_DIRECTORY

Specify the path (DM_
DIRECTORY) and file 
(DATAMODEL) name for the 
customized data model. 
Mandatory only if you want to 
upload the customized data 
model, that is you have 
specified MODEL_TYPE=1.

User Input

OBI_HOST Specify the Host Name of the 
OBIEE Server

User Input This field should NOT be left 
blank. If OBIEE is not 
configured at the moment, 
ensure that you provide 
dummy value in this field.

OBI_PROTOCOL Specify the protocol name of 
the OBIEE Server

User Input This field should not be left 
blank. If OBIEE is not 
configured at the moment, 
ensure that you provide a 
dummy value in this field.

OBI_PORT Specify the Port Number of the 
OBIEE Server

User Input This field should NOT be left 
blank. If OBIEE is not 
configured at the moment, 
ensure that you provide 
dummy value in this field.

OBI_CONTEXT Specify the Context Name of 
the OBIEE Server

User Input This field should NOT be left 
blank. If OBIEE is not 
configured at the moment, 
ensure that you provide 
dummy value in this field.

Table 4–1 

Property Name Description of Property
Permissible 
Values Comments
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11. Give a path for installation log file in log4j.xml in OFS_IFRS_PACK/OFS_IFRS/conf 
location.

12. Navigate to OFS_IFRS_PACK/bin/ directory, on successful execution of the schema creator 
utility.

13. Enter the following command in the console to execute the application pack installer with 
Silent option.

./setup.sh SILENT

ETL_APPSRC_
TYPE

Specify if you want create new 
ETL App/Src pair or use an 
existing one.

0 = If you 
want to create 
a new ETL 
app/src pair.

1 = If you 
want to use an 
existing pair

ETL_SRC_1_DESC ETL Staging source description User Input Give description for the ETL 
App/Src pair.

Mandatory if you want to 
create new ETL app/src pair. 
That is, if you have specified 
ETL_APPSRC_TYPE=0.

ETL_SRC_2_DESC ETL Processing source 
description

User Input Provide description for the 
ETL App/Src pair.

Mandatory if you want to 
create new ETL app/src pair. 
i.e you have specified ETL_
APPSRC_TYPE=0

ETL_SRC_1_NAME ETL Staging source name User Input Specify the ETL Application 
and Source Name into ETL 
Area Definitions will be 
deployed.

The value of this element in 
silent.props file should be 
the same in both OFS ALM 
(if installed) and OFS IFRS.

ETL_SRC_2_NAME ETL Processing source name User Input Specify the ETL Application 
and Source Name into ETL 
Area Definitions will be 
deployed.

The value of this element in 
silent.props file should be 
the same in both OFS ALM 
(if installed) and OFS IFRS.

Table 4–1 

Property Name Description of Property
Permissible 
Values Comments
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Figure 4–7 Silent Mode Installation

 

14. Enter the OFSAA Processing Tier FTP/SFTP password value, when prompted at the 
command prompt

Figure 4–8 Silent Mode Installation

 



Table 4–2 Console Prompts - Silent Mode installation 

Console Prompts User Inputs

Please enter OFSAA 
Processing Tier FTP/SFTP 
password

Enter the password to access processing tier directory in the 
application server.

Note: In case the prompt reads as follows, enter the username/ 
password for accessing the product Staging/ Metadata Repository 
FTPSHARE.

• Kerberos username [user]

• Kerberos password for user
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15. Enter Always, when prompted to add host key fingerprint. 

The OFSAAI License Agreement is displayed.

 

16. Enter Y/y to accept the License Agreement. 

Note: The installation process continues on the console. Do not close the 
console until the installation process is complete.

Once the platform is installed, it proceeds for the IFRS PACK installation. After successful 
IFRS pack installation, WAR file is generated and all the servers are verified.

17. The following message is displayed in the console:

Installation completed…
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18. On completion of installation, see the installation log files. 

For more information, see Verifying the Log File.

19. Download and install the mandatory one-off patch 29478356 from Patches & Updates tab 
of My Oracle Support portal.

20. Download and install the mandatory one-off patch 29004093 from Patches & Updates tab 
of My Oracle Support portal.

21. Download and install the mandatory one-off patch 29251384 from Patches & Updates tab 
of My Oracle Support portal.

22. Perform the steps mentioned in Post Installation Configuration section.

23. For enabling Transparent Data Encryption (TDE), see Configuring Transparent Data 
Encryption (TDE) and Data Redaction in OFSAA section.

24. For enabling Data Redaction, see Data Redaction section under Data Security and Data 
Privacy chapter in OFS Analytical Applications Infrastructure Administration Guide.

https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAAI_Administration_Guide_8.0.6.0.0.pdf
https://docs.oracle.com/cd/E60058_01/homepage.htm
https://support.oracle.com/
https://support.oracle.com/
https://support.oracle.com/
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Installing in GUI Mode

Note: 1.GUI mode of installation is supported only on RDBMS database 
server. For HDFS support of installation, see section Installing in Silent 
Mode

2. Ensure that you have followed the steps as mentioned in the Configuration 
for GUI Mode Installation section prior to proceeding with the next steps.

1. Log in to the system as non-root user.

2. Identify a directory for installation and set the same in the user .profile file as the 
following:

FIC_HOME=<OFSAA Installation Directory>
export FIC_HOME 

3. Execute the user .profile file.

4. Navigate to OFS_IFRS_PACK directory.

5. Edit the OFS_IFRS_PACK/schema_creator/conf/OFS_IFRS_SCHEMA_IN.xml file to set 
the appropriate attribute values.

Note: See Configuring OFS_IFRS_SCHEMA_IN.XML File for details on 
configuring this XML file.

6. Navigate to the path <OFS_IFRS_PACK>/schema_creator/bin in the console and execute 
the schema creator utility.

Note: This step is mandatory and should be executed before every OFSAA 
Application Pack installation.

See Executing the Schema Creator Utility for more details.

7. Navigate to OFS_IFRS_PACK/bin directory.

8. Execute the following command in the console.

./setup.sh GUI

Note: Refer the console for any errors during Pre-install checks.
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Figure 4–9 Initialization Window

9. The general License Agreement is displayed. 
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Figure 4–10 License Agreement

10. Select I accept the terms if the License Agreement option.

11. Click Next.

The Financial Services International Reporting Standards Application Pack Details 
window is displayed.
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Figure 4–11 OFS IFRS Applications Pack Details 

12. Select the product(s) for which you have already obtained the license(s). 

13. Click Next. 

The Application Pack - License Agreement window is displayed.
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Figure 4–12 Application Pack License Agreement page 

14. Select I accept the terms of the License Agreement option.

15. Click Next.

The Pre-Installation Summary window is displayed.
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Figure 4–13 Pre-Installation Summary

16. Click Next. 

The Manage Information Domains window is displayed.
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Figure 4–14 Manage Information Domains page 

17. The default Information Domain Name for this Application Pack is OFSIFRSINFO. 

Double-click the Information Domain Name field to edit. 

Note: For subsequent Application Pack installation on the same 
Information Domain, the Information Domain Name is not editable. 

Permissible length is 16 characters and only alphanumeric characters are 
allowed. No special characters are allowed.

18. Click Next. 

The User Installation Directory window is displayed.
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Figure 4–15 User Installation Directory

Note: The User Installation Directory path is auto-populated from the path 
you have set in the user .profile file in Step 2.

19. Click Next. 

The OFSAA Infrastructure Server Details window is displayed.
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Figure 4–16 OFSAA Infrastructure Server Details

20. Enter the IP address or hostname of the Database Server.

Note: The OFSAAI Server IP/Hostname is auto-populated by default.

21. Click Next. 

The Web Application Server window is displayed.
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Figure 4–17 Web Application Server

22. Select the appropriate Web Application Server. The options are Tomcat, WebSphere, and 
WebLogic.

23. Click Next. Based on the selection, corresponding windows are displayed.

24. For WebSphere: The WebSphere Setup Details window is displayed.

Enter the profile path (up to the Node Cell Name directory) of WebSphere.

The format is:

WebSphere path <WebSphere profile directory>/installedApps/ 
<NodeCellName>
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Figure 4–18 WebSphere Setup Details

a. Enter the installation path (up to the Node Cell Name directory) of WebSphere server. 
The format is <WebSphere profile 
directory>/installedApps/<NodeCellName>.

25. For Tomcat: The Absolute Tomcat Path window is displayed.
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Figure 4–19 Absolute Tomcat Path

a. Enter the Tomcat installation path (till/webapps) where OFSAAI is deployed.

26. For WebLogic: The WebLogic Home window is displayed.

Figure 4–20 WebLogic Home

 

a. Enter the WebLogic home directory path.

b. Enter the path of the Weblogic domain directory and click Next. 

The OLAP Details window is displayed.
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Figure 4–21 OLAP Details

27. Enter 1 if you want to configure OFSAA OLAP feature using Oracle Hyperion Essbase. 
By default, it is set to 0.

28. Click Next. The Web Server Details window is displayed.
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Figure 4–22 Web Server Details

29. Select ENABLE HTTPS check box to configure HTTPS, if required, and enter the WEB 
SERVER PORT (HTTP Server) PORT, Context name for deployment, and WEB LOCAL 
PATH to any folder on the Web Application Server (Tomcat/Websphere/WebLogic). 

30. Click Next. The Database Details window is displayed.
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Figure 4–23 Database Details

31. Enter Oracle SID / Service Name.

Note:

• The JDBC URL, CONFIG SCHEMA USER ID, Oracle Configuration Schema 
Password, and ABSOLUTE DRIVER PATH fields are auto-populated.

• ABSOLUTE DRIVER PATH can be the path where Oracle DB client is installed 
or JDBC driver is installed. For example, 
/scratch/oracle/app/oracle/product/11.2.0/client_1/jdbc/lib

32. Click Next. The Ports Configuration window is displayed.
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Figure 4–24 Ports Configuration

Note: The Java Port, Native Port, Agent Port, ICC Server Port, and ICC 
Native Port fields are auto-populated. You can also modify the Ports settings.

33. Click Next. The Ports Configuration window is displayed.
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Figure 4–25 Ports Configuration

Note: The OLAP Port, Message Server Port, Router Port, and AM Port 
fields are auto-populated. You can also configure the Ports settings. 

34. Click Next. The SFTP Details window is displayed.
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Figure 4–26 SFTP Details

Note: 

• ENABLE SFTP and FILE  TRANSFER PORT fields are auto-populated.

• Ensure that the system, on which the OFSAA Infrastructure is installed, has FTP 
or SFTP enabled.

• You can also modify the SFTP settings.

35. Click Next. The OFSAAI Post Install Details window is displayed.
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Figure 4–27 OFSAAI FTP/SFTP Details

36. Enter the FTPSHARE path. This is same as the OFSAA Staging/ Metadata directory.

37. Enter the FTP/SFTP User ID and Password for FTPSHARE directory access.

Note: The transfer of data (files) between the OFSAA Server and the Web 
Application Server happens through FTP/ SFTP. Ensure the necessary host 
configurations are made for a successful handshake. For more details, see 
Adding FTP/SFTP Configuration for File Transfer.

38. Click Next. The Pre Installation Summary window is displayed.
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Figure 4–28 Pre Installation Summary 

39. Click Install. The Installing OFSAA Infrastructure window is displayed.
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Figure 4–29 Installing OFSAA Infrastructure

Note: Anytime during the installation you can click Cancel to stop the 
installation. Once completed, the INSTALLATION SUMMARY window is 
displayed.

40. Once completed, the Installation Summary window is displayed.



Installing the OFS IFRS Application Pack

4-60 OFS IFRS Installation and Configuration Guide                     

Figure 4–30 INSTALLATION SUMMARY

The INSTALLATION SUMMARY window displays the number of Fatal Errors, Errors, 
Debug Statements, Informations, and Warnings along with the location of log files.

41. Click Next. The Installation Complete window is displayed.
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Figure 4–31 Installation Complete

42. Click Done. The following message is displayed: 

Please wait, pack_install is being configured for your system. This may take a moment.

Figure 4–32 Checking OFSAAI Services

 

43. The Checking OFSAA Service window is displayed.



Note: This step verifies the OFSAA services startup. In case of errors 
during services check, an appropriate error message is displayed.
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44. After checking the OFSAA services, installation proceeds with the OFS IFRS Application 
Pack Installation. 

The Installing Oracle Financial Services International Financial Reporting Standards 
Application Pack window is displayed.

Figure 4–33 Installing Application Pack

 

45. Upon invoking the installer, the Introduction window is displayed with the prerequisites for 
installation. Ensure that all the prerequisites are met before you proceed with the 
installation.
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Figure 4–34 Installation Introduction

46. Click Next. Choose the log mode for this installer. If Debug is selected, the Passwords will 
be printed in the log file. If General is selected then the general information will get printed 
in the log file.
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47. Click Next. Segment Creation window is displayed. Enter the Data Management Segment, 
Application Server ftpshare log path, and Database server ftpshare log path in the 
Information Domain window, and click Next.



Installing the OFS IFRS Application Pack

                                Installing the OFS IFRS Application Pack 4-65

48. Click Next. Pre-Infodom Creation Summary window is displayed.
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49. Click Next. The Infodom Creation window is displayed.

 

50. Enter the Tablespace name in the Pre-Setup Information window and click Next.

51. Enter the DB Name for Infodom Database, Application Schema User name, Application 
Schema Password, and Application Schema JDBC URL for Fair Value Sandbox. Click 
Next.
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52. Enter the Infodom name, Infodom Description, Segment Name, and Application Server 
ftpshare log path for Fair Value Sandbox. Click Next.

 

53. Verify the details and click Next. The Pre-Installation window is displayed.
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54. Click Next. The Creating Sandbox Infodom window is displayed.

 

Note: Similarly enter the details for HISTIRC Sandbox and FCSTIRC 
Sandbox.
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55. Click Next. The Pre-Setup Information window is displayed. Select Yes, if you want to 
perform model upload.

56. Select the data model type and click Next.
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57. Click Next, to copy data model to erwin.xml file.

58. Click Next, to upload the data model.
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59. Verify the Pre-Model Upload Summary and click Next.

60. Click Next. It will check for the Heap Memory Warning.

Model Heap Memory Warning Window:

 

61. Click Back, update your .profile entry with required heap memory size.

• Open a new session in Putty.

• Shutdown OFSAAI server using $FIC_
HOME/ficapp/common/FICServer/bin/stopofsaai.sh.

• Update the X_ARGS_APP entry in .profile file as mentioned in the following 
example:
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X_ARGS_APP="-Xms2g -Xmx18g -XX:+UseAdaptiveSizePolicy 
-XX:MaxPermSize=1024M -XX:+UseParallelOldGC 
-XX:+DisableExplicitGC"

Note: Ensure that, in an integrated environment for pack on pack 
installation the memory size is 10 times the value of all the datamodel sizes 
taken together.

• Execute .profile file.

• Start OFSAAI services using $FIC_HOME/ficapp/common/FICServer/bin/ 
startofsaai.sh.

• Proceed for model Upload.

62. After Model Upload completion, ETL Application/ Source Pair is displayed. The following 
window seeks input from the user on whether to create new ETL application/source pair or 
use an existing one.

Choose a desired option and click Next to continue.

If the option New application/source pair was chosen then the following window is 
displayed seeking the application and source name for creation of the same.
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63. Specify all the details required for application and source creation.

64. If you have selected Existing Source, click the drop down lists adjacent to ETL Staging 
FSAPPS SRC Selection and ETL Processing SRC Selection fields and select the required 
values.

This fields list the existing ETL Sources for Staging and Processing.
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65. Click Next to proceed. 

This creates application and source within OFSAAI. This also generates source model. 
This process takes some time depending on the number of entities / attributes in the atomic 
schema. This process cannot be rolled back.
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This window displays the pre-installation summary. Verify all details and proceed.

66. Click Install to proceed. A message appears asking for the confirmation.
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67. Click Yes, Installation is initiated. The Installation Progress is displayed in Installation 
Progress window.

Anytime during the installation you can click Cancel to stop the installation. Once 
completed, the Installation Summary window is displayed.

 

68. Click Next. The Sandbox Summary window is displayed.



 

Installing the OFS IFRS Application Pack

                                Installing the OFS IFRS Application Pack 4-77

69. Click Next to create sandbox. The following message is displayed.

70. Click Next. The Installing Financial Service International Financial Reporting Standards 
Application Pack window is displayed.
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71. Click Next. Installation Summary window is displayed.
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72. Click Done.

Note: The installation process continues on the console. Do not close the 
console until the installation process is complete.

The Post Install Health check results are displayed:



 

Installing the OFS IFRS Application Pack

4-80 OFS IFRS Installation and Configuration Guide                     

You have successfully installed the OFS IFRS Application Pack.

73. Download and install the mandatory one-off patch 29478356 from Patches & Updates tab 
of My Oracle Support portal.

74. Download and install the mandatory one-off patch 29004093 from Patches & Updates tab 
of My Oracle Support portal.

75. Download and install the mandatory one-off patch 29251384 from Patches & Updates tab 
of My Oracle Support portal.

76. Perform the steps mentioned in Post Installation Configuration section.

77. For enabling Transparent Data Encryption (TDE), see Transparent Data Encryption (TDE) 
section.

78. For enabling Data Redaction, see Data Redaction section under Data Security and Data 
Privacy chapter in OFS Analytical Applications Infrastructure Administration Guide.

Verifying the Log File
Verify the following logs files for more information: 

• See the Pack_Install.log file located at OFS_IFRS_PACK/logs/ directory for OFS 
IFRS Application Pack installation logs.

• See the log file(s) located in the OFS_IFRS_PACK/OFS_AAI/logs/ directory for 
Infrastructure installation logs.

• See the OFSAAInfrastucture_Install.log file located at $FIC_HOME directory for 
Infrastructure installation logs.

• See the OFS_IFRS_installation.log and OFS_IFRS_Installation_debug.log log files located 
at <OFS_IFRS_PACK>/OFS_IFRS/logs directory.

https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAAI_Administration_Guide_8.0.6.0.0.pdf
https://support.oracle.com/
https://support.oracle.com/
https://support.oracle.com/
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5Upgrading the OFS Financial Accounting and 
Reporting Standards (IFRS and CECL) 

Application Pack

Note: Data expectation for Instrument Type Codes has a minor update. 
Therefore, if you are upgrading to v8.0.7.0.0 from a previous version, it is 
advised to review the Instrument Type Codes used against the Instruments in 
Product Processor tables.

This chapter includes the following topics:

• Upgrading the OFS Financial Accounting and Reporting Standards (IFRS and CECL) 
Application Pack

Upgrading the OFS Financial Accounting and Reporting 
Standards (IFRS and CECL) Application Pack

Refer to the following instructions to download, extract, install, and configure this release.

1. Download the OFS IFRS Application Pack v8.0.7.0.0 archive file and copy it to your 
OFSAA server in Binary mode. For more information, see Downloading and Copying the 
OFS IFRS Applications Pack Installer section.

Note: The archive files are different for every operating system like AIX, 
Solaris, and RHEL/Oracle Linux.

2. Log in to the OFSAA Server with user credentials that was used to install OFSAA.

3. Shut down all the OFSAAI Services. For more information, refer to the Start/Stop 
Infrastructure Services section in Appendix D.

4. Execute the following command:

chmod -R 750 $FIC_HOME

5. If you have Unzip utility, skip to the next step. Download the Unzip utility (OS specific) 
and copy it in Binary mode to the directory that is included in your PATH variable, 
typically $HOME path or directory in which you have copied the 8.0.7.0.0 installer.

• Uncompress the unzip installer file using the command:

 uncompress unzip_<os>.Z



Note: In case you notice an error message “uncompress: not found [No 
such file or directory]” when the package is not installed, contact your 
UNIX administrator.
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• Give EXECUTE permission to the file using the command:

chmod 751 OFS_IFRS_80700_<OperatingSystem>.zip

6. Extract the contents of the Oracle Financial Services International Financial Reporting 
Standards Pack 8.0.7.0.0 in Download Directory installer archive file using the following 
command:

unzip_<os> <name of the file to be unzipped>

7. Give EXECUTE permission to the archive file. Navigate to the path OFS_IFRS_80700_
<OperatingSystem>.zip and execute the command: 

chmod -R 750 OFS_IFRS_80700_<OperatingSystem>

8. Ensure that required values for UPLOAD_MODEL and MODEL_TYPE parameters are 
set in Silent.props file present in OFS_IFRS_PACK/OFS_IFRS/conf  location.

9. Execute setup.sh file using the following command:

./setup.sh SILENT

Verify if the release is applied successfully by checking the log file generated in the 
installation folder. You can ignore ORA-00001, ORA-00955, ORA-02260, and 
ORA-01430 errors in the log file. In case of any other errors, contact Oracle Support.

You can also ignore “object already exists” error in the upgrade install log.

10. Download and install the mandatory one-off patch 29478356 from Patches & Updates tab 
of My Oracle Support portal.

11. Download and install the mandatory one-off patch 29004093 from Patches & Updates tab 
of My Oracle Support portal.

12. Download and install the mandatory one-off patch 29251384 from Patches & Updates tab 
of My Oracle Support portal.

13. For more information on securing your OFSAA Infrastructure, refer to the Security Guide 
in OHC Documentation Library.

14. Restart all the OFSAAI services. For more information, refer to the Start/Stop 
Infrastructure Services section in Appendix D.

15. Generate the application EAR/WAR file and redeploy the application onto your configured 
web application server. For more information on generating and deploying EAR / WAR 
file, refer Appendix C section.

16. After successful installation, follow these steps:

Log in to the web application server and clear the application cache. Navigate to the 
following path depending on the configured web application server and delete the files.

• Tomcat

<Tomcat installation 
folder>/work/Catalina/localhost/<Application 
name>/org/apache/jsp

• Weblogic

http://docs.oracle.com/cd/E61555_01/homepage.htm
http://docs.oracle.com/cd/E61555_01/homepage.htm
https://support.oracle.com/
https://support.oracle.com/
https://support.oracle.com/
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<Weblogic installation location>/domains/<Domain 
name>/servers/<Server name>/tmp/_WL_user/<Application 
name>/<auto generated folder>/jsp_servlet

In case of WebLogic version 12.2.x.x, delete the folder named “.WL_internal” present 
in the path <WebLogic installation location>/user_projects/domains/< Domain name 
>/applications/<context_name>.ear/META-INF/", if it exists.

• Websphere

<Websphere installation 
directory>/AppServer/profiles/<Profile name>/temp/<Node 
name>/server1/<Application name>/<.war file name>

17. Add umask 0027 in the .profile of the UNIX account which manages the WEB server to 
ensure restricted access permissions.

18. Verify the Log Files OFS_IFRS_installation.log and OFS_IFRS_Installation_debug.log 
located at OFS_IFRS_PACK/OFS_IFRS/logs/ folder. You can also verify the OFSAAI log 
files from OFS_IFRS_PACK/OFS_AAAI_PACK/logs folder.

19. If OFS Enterprise Modeling is licensed and enabled in your OFSAA instance, uninstall 
OFSAAIRunner package and reinstall the latest available OFSAAIRunner package. For 
more details, see Configuring Oracle R distribution and Oracle R Enterprise (ORE).

20. For enabling TDE, see Configuring TDE in case of Upgrade section in Transparent Data 
Encryption (TDE) section.

21. For enabling Data Redaction, see Enabling Data Redaction in case of Upgrade section.

22. If you have already executed Runs and have data present in Fact LLFP Account Summary 
table, you can migrate this data to the LLFP Aggregate Summary table by executing the 
following procedure, for the required Run Skeys:

ifrs9_aggregate_utilities.aggr_flas(p_v_batch_id,

p_v_mis_date,

p_v_run_id,

p_v_process_id,

p_v_run_execution_id,

 p_n_run_skey);

Note: All parameters are of varchar2 type.

Table 5–1 

Parameter Mandatory/Optional Format

p_v_batch_id Mandatory

p_v_mis_date Mandatory YYYYMMDD

p_v_run_id Optional

p_v_process_id Optional

p_v_run_execution_id Optional

p_n_run_skey Mandatory 0000000<<Run_skey>>

For example, 000000021
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If OFS Enterprise Modeling is licensed and enabled in your OFSAA instance, uninstall 
OFSAAIRunner package and reinstall the latest available OFSAAIRunner package. For 
more details, see Configuring Oracle R distribution and Oracle R Enterprise (ORE). 

23. The FV_QUOTE_TYPE column of FSI_HM_INSTR_FV_QUOTE_TYPE table includes 
the symbolic representation (W- Weighted and UW - Unweighted) to perform the Fair 
Value calculation of an Instrument Type (for both Level 1 and Level 2) for both weighted 
to unweighted. These Fair Values are populated at FCT_ACCOUNT_FAIR_VALUE.

To update the Weighted Fair Values of already executed Fair Value Runs in an upgraded 
system, execute the hm_populate_weighted_fv.sql file present in atomic\insert\ location.

Anonymization of Account Number in Upgrade Environment
In an upgrade environment, when you populate data in V_ACCOUNT_NUMBER and V_
ORIGINAL_ACCOUNT_NUMBER OR V_CONTRACT_CODE and V_ORIGINAL_
ACCOUNT_NUMBER of the Stage tables, ensure that you perform one-to-one mapping 
between the Account Number and the Original Account Number.

There should be a one-to-one mapping between the Account Number and the Original Account 
Number in all the Stage (STG_*), Product Processor (FSI_D_*), Metadata (FSI_M_HM_
HEDGED_INST_MAP, FSI_M_HEDGE_EFF_TEST_SUMMARY, FSI_M_HEDGED_INST_
MAP_SNP, and FSI_M_HM_EFF_TEST_SUMMARY_SNP) tables.

Note: Account number should be an anonymized number.

Example of this mapping is provided in the following table:

Table 5–2 

Table Name Sample Update Statememt Description

DIM_ACCOUNT update DIM_ACCOUNT set V_
ORIGINAL_ACCOUNT_
NUMBER = V_ACCOUNT_
NUMBER;

Updates the value in V_
ORIGINAL_ACCOUNT_
NUMBER column as in the V_
ACCOUNT_NUMBER column.

update DIM_ACCOUNT set V_
ACCOUNT_NUMBER = 
<anonymized value>;

Updates the anonymized value in 
Account Number.

STG_INVESTMENTS update STG_INVESTMENTS 
set V_ORIGINAL_ACCOUNT_
NUMBER = V_ACCOUNT_
NUMBER;

Updates the value in V_
ORIGINAL_ACCOUNT_
NUMBER column as in the V_
ACCOUNT_NUMBER column.

update STG_INVESTMENTS 
set V_ACCOUNT_NUMBER = 
<anonymized value>;

Updates the anonymized value in 
Account Number.

STG_OPTION_CONTRACTS update STG_OPTION_
CONTRACTS set V_
ORIGINAL_ACCOUNT_
NUMBER = V_CONTRACT_
CODE;

Updates the value in V_
ORIGINAL_ACCOUNT_
NUMBER column as in the V_
CONTRACT_CODE column.

update STG_OPTION_
CONTRACTS set V_
CONTRACT_CODE = 
<anonymized value>;

Updates the anonymized value in 
Account Number.
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FSI_M_HM_HEDGED_INST_
MAP

update FSI_M_HM_HEDGED_
INST_MAP set V_ACCOUNT_
NUMBER= <anonymized 
value>;

Updates the anonymized value in 
Account Number.

FSI_M_HEDGE_EFF_TEST_
SUMMARY 

update FSI_M_HEDGE_EFF_
TEST_SUMMARY set V_
ACCOUNT_NUMBER= 
<anonymized value>;

Updates the anonymized value in 
Account Number.

FSI_M_HEDGED_INST_MAP_
SNP

update FSI_M_HEDGED_
INST_MAP_SNP set V_
ACCOUNT_NUMBER= 
<anonymized value>;

Updates the anonymized value in 
Account Number.

FSI_M_HM_EFF_TEST_
SUMMARY_SNP

update FSI_M_HM_EFF_TEST_
SUMMARY_SNP set V_
ACCOUNT_NUMBER= 
<anonymized value>;

Updates the anonymized value in 
Account Number.

Table 5–2 

Table Name Sample Update Statememt Description
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6Post Installation Configuration

On successful installation of the OFS IFRS Application Pack, follow the post installation steps 
mentioned below.

This chapter includes the following sections:

•  Patches

• Configuring Work Manager in Web Application Server

• Configuring Resource Reference

• Starting OFSAA Infrastructure Services

• Adding TNS entries in the TNSNAMES.ORA File

• Configurations for Sandbox Model Creation

• Configuring Oracle R distribution and Oracle R Enterprise (ORE)

• Configuring Oracle Financial Services Inline Processing Engine (OFS IPE)

• Updating OBIEE URL

• Creating and Deploying the Application Pack Web Archive

• Accessing the OFSAA Application

• Performing Post Deployment Configurations

• Settings to Support Jersey 2.x on IBM WebSphere 8.5.5.9+

• Configurations for Multiple Rating Feature

• Update the Properties of ifrs-eir.ini File

• Creating Global Variables for OBIEE

• Deploying the Image for HM Reports

Note: Install the mandatory patch for OFS IFRS from the MOS Document 
2308427.1.

Note: Ensure to clear the application cache prior to the deployment of Applications 
Pack Web Archive. This is applicable to all Web Servers (WebSphere, WebLogic, and 
Tomcat). For more information, see Clearing Application Cache section.

https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=530072969287469&id=2308427.1
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=530072969287469&id=2308427.1
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Patches

Note: In an environment consisting of multiple OFSAA applications, if the October 
2020 Critical Patch Update is applied for any one application, it is mandatory to apply 
the respective October 2020 Critical Patch Updates for all other applications on that 
OFSAA instance, regardless of the application's version. See the My Oracle Support 
Doc ID 2724021.1 for details.

Mandatory Patch
You must download and install the mandatory patch 33663417. Ensure that whenever any 
installation or upgrade or an incremental patch is applied, the mandatory patch 33663417 for 
Log4J must be reapplied. For more information, see the MOS Doc ID 2827801.1.

Download and apply the AAI mandatory One-off Patch 33995556.

Analytical Applications Infrastructure (AAI)
You must download and install the following mandatory patches:

• Download and install the mandatory patch 30273976.

Hedge Management
If you have installed the OFS Hedge Management and IFRS Valuations application, then:

• Download and install the mandatory patch 30061442.

• Download and install the mandatory patch 31964306.

Loan Loss Forecasting and Provisioning (LLFP)
 If you have installed the OFS Loan Loss Forecasting and Provisioning application then:

• Download and install the mandatory patch 29002529.

• Download and install the mandatory patch 30831410.

• Download and install the mandatory patch 31719669.

Download and install the mandatory patch 32777218.

Configuring Tomcat for User Group Authorization, Data 
Mapping, and Disabling WADL for the Web Service

Users with system authorization roles can access User Group Authorization. However, to make 
it available on Tomcat web server, you have to perform the following configuration steps:

1. Navigate to the $FIC_WEB_HOME/webroot/WEB-INF/ folder and open web.xml file.

2. Enter the following in the web.xml file.
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<init-param>

<param-name>mappedfile</param-name>

<param-value>false</param-value>

</init-param>

3. To disable the WADL for the Web Service, navigate to the following snippet in the 
web.xml file.

<servlet>

<servlet-name>CommonRESTServlet</servlet-name>

<servlet-class>org.glassfish.jersey.servlet.ServletContainer</servlet-class>

<init-param>

<param-name>javax.ws.rs.Application</param-name>

<param-value>com.ofs.fsapps.commonapps.util.ApplicationResourceConfig</param-value
>

</init-param>

<load-on-startup>1</load-on-startup>

</servlet>

4. Add the following snippet before the <load-on-startup>1</load-on-startup> attribute.

<init-param>

<param-name>jersey.config.server.wadl.disableWadl</param-name>

<param-value>true</param-value>

</init-param>

5. 5.Save and close the file

Configuring Resource Reference
Configure the resource reference in the Web Application Server configured for OFSAA 
Applications. See Configuring Resource Reference in Web Application Servers section for 
details on configuring the resource reference in WebSphere, WebLogic, and Tomcat 
Application Servers. 

Configuring Work Manager in Web Application Server
Process Modelling framework requires creation of Work Manager and mapping it to OFSAA 
instance. This configuration is required for WebSphere and WebLogic Web Application Server 
types.

This section covers the following topics:

• Configuring Work Manager in WebSphere Application Server

• Configuring Work Manager in Weblogic Application Server

Configuring Work Manager in WebSphere Application Server
This section is applicable only when the Web Application Server type is WebSphere.

This section covers the following topics:
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• Creating Work Manager

• Mapping Work Manager to OFSAA WebSphere Instance

Creating Work Manager
1. Open the WebSphere admin console in the browser window: 

http://<ipaddress>:<administrative console port>/ibm/console. (https if SSL is enabled). 
The Login window is displayed.

2. Login with the user ID that has admin rights.

3. From the LHS menu, expand Resources > Asynchronous beans and select Work 
Managers.
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4. Select the required Scope from the drop-down list.

For example, Node=whf00aqnNode01, Server=server1.

5. Click New in the Preferences section.

6. Enter the Name as 'wm' and JNDI name as 'wm/WorkManager ' in the respective fields.

7. Enter the Thread pool properties.
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8. Click Apply.

9. Click Save. 

After creating work manager successfully, you have to map it to OFSAA instance.
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Mapping Work Manager to OFSAA WebSphere Instance
1. From the LHS menu, expand Applications > Application Types and select WebSphere 

enterprise applications.

2. Click OFSAAI instance hyperlink.
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3. Click Resource references link under References section.
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4. Click Browse corresponding to the Work Manager Resource Reference. The available 
resources are displayed.

5. Select the newly created Work Manager ('wm') and click Apply.
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6. Select the Work Manager ('wm/WorkManager') and click OK.

7. Click Save.
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Configuring Work Manager in Weblogic Application Server
This section is applicable only when the Web Application Server type is WebLogic.

Creating Work Manager
1. Open the WebLogic admin console in the browser window: 

http://<ipaddress>:<administrative console port>/console. (https if SSL is enabled).

The Welcome window is displayed.

2. Login with the user ID that has admin rights.

3. From the Domain Structure menu in the LHS, expand Environment and select Work 
Managers. The Summary of Work Managers window is displayed.
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4. Click New to create a new work manager component.

5. Select Work Manager and click Next.
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6. Enter the Name as 'wm/WorkManager'.

7. Click Next.

8. Select the required deployment target and click Finish.
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Starting OFSAA Infrastructure Services
Start the OFSAA Infrastructure Services prior to deployment or accessing the OFSAA 
Applications. See to the Starting/ Stopping Infrastructure Services section for details on Start/ 
Stop OFSAA Services.

Adding TNS entries in the TNSNAMES.ORA File
Add TNS entries in the tnsnames.ora file, for every schema created for the Application Pack.

To find the tnsname for the entries, follow these steps:

1. Login to the application using System Administrator privileges.

2. Navigate to System Configuration & Identity Management tab.

3. Click Administration and Configuration, select System Configuration, and click 
Database Details.

4. Expand Name to get the list of TNS entry names.

5. Alternatively, you can connect to the CONFIG schema and execute the below query:

select dbname from db_master where dbname !='CONFIG'

Configurations for Sandbox Model Creation
This configuration procedure is specific to OFS LLFP and is required only if you have licensed 
OFSAAI Enterprise Modelling Framework.

Important Note for Upgrade: If you are upgrading from any version 
other than 8.0.4.1.0, execute the following scripts present in $FIC_
HOME/scripts/config/insert directory, in Config schema, in the following 
order:

• delete_PD_model.sql

• LLFP_MF_Variable_Definitions.sql

• IFRS9_model_definition.sql
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Once you license OFS AAAI, the following configurations must be made to use the Modelling 
features in OFS LLFP application. These steps are required to verify and execute the models 
that are packaged with LLFP application. 

Note: Ensure that Oracle R Enterprise Server version 1.5.1 is installed on the 
database server and AAAI Runner Package is installed on the DB server, 
before you perform these configurations. Also, you must access the 
application with required privileges.

1. Create a new schema with the following grants:

grant create SESSION to <<schema_user>>;

grant create PROCEDURE to <<schema_user>>;

grant create SEQUENCE to <<schema_user>>;

grant create TABLE to <<schema_user>>;

grant create TRIGGER to <<schema_user>>;

grant create VIEW to <<schema_user>>;

grant create MATERIALIZED VIEW to <<schema_user>>;

grant create SYNONYM to <<schema_user>>;
grant unlimited TABLESPACE to <<schema_user>>; 

2. Grant RQADMIN role to the Config schema user:

grant RQADMIN to <<config_schema>>;

grant RQADMIN to <<atomic_schema>>;

grant RQADMIN to <<pdmodel_schema>>;

3. If Data Redaction is enabled, execute the following query: 

alter user <<pdmodel_schema>> default role RQADMIN;

grant OFS_SEC_DATA to <<schema_user>>;

grant OFS_NOSEC_DATA to <<schema_user>>;

4. Create a new database from System Configuration menu.

5. Add the TNS entry for the newly created database.

6. Create a new Information Domain for Sandbox and create a new Segment.

7. Map the Sandbox Information Domain to the group LLFP Admin Group.

8. Map the EMF groups to the LLFP admin user.

9. Login to Config schema and execute the file ofs_llfp_aai_model_menu.sql. This file is 
present in the folder $FIC_HOME/scripts_OFS_IFRS_8.0.7.0.0/config/insert.

Configurations for Verifying and Executing PD Model
Perform the following configurations to verify and execute the PD Model.

1. Log in as LLFP Admin user and create a Sandbox from OFSAAI menu. Use the dataset 
IFRS ECL Consolidated for creating this Sandbox.
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2. Disable the FK constraint (FK_MF_MODEL_DS_QUERY_1) defined in the table MF_
MODEL_DS_QUERY, in Config schema.

3. Replace the place holders ##LLFPSBXINFODOM## and ##LLFPSANDBOX_ID## with 
Sandbox Information Domain name and Sandbox ID respectively, in the following tables 
of Config schema:

• MF_MODEL_MASTER

• MF_MODEL_SCRIPT_MASTER

• MF_MODEL_DS_QUERY

4. Enable the FK constraint FK_MF_MODEL_DS_QUERY_1, in Config schema.

5. Update all the occurrences of the term "Timestamp" to "Date Time" in the following files, 
present in the folder ftpshare/<<SANDBOX_INFODOM>>/erwin/scripts/sandbox:

• FSI_TRANSITION_MATRIX_MST.xml

• FSI_PERIOD_TM_MAP_MST.xml

• FSI_IFRS_ECON_SCENARIO_MST.xml

Once these configurations are set, you can follow the OFSAAAI Installation Guide to view, 
execute, and deploy the model from Sandbox. For more information, see Oracle Financial 
Services Advanced Analytical Applications Infrastructure Application Pack Installation and 
Configuration Guide available in Oracle Help Centre Documentation Library. 

If your ORE version is 1.5.1, open the Model IFRS9_PD_Projection (Description: IFRS9 PD 
Projection model) in Sandbox Schema and update the following script:

Existing Script (ORE version 1.5.0):

if(MISDate!=-1)

{

OFSDATASET <- OFSDATASET[OFSDATASET$MIS_
DATE==as.Date(as.character(MISDate),"%Y%m%d"),1:15]

}

New Script (ORE version 1.5.1):

if(MISDate!=-1)

{

OFSDATASET <- OFSDATASET[as.ore.date(OFSDATASET$MIS_
DATE)==as.Date(as.character(MISDate),"%Y%m%d"),1:15]

}

Configurations for Verifying and Executing Survival Model
Perform the following configurations to verify and execute the Survival Model.

1. Log in as LLFP Admin user and create a Sandbox from OFSAAI menu. Use the following 
datasets for creating this Sandbox:

• Survival Model Input Dataset

• Survival Model Output Dataset

• Survival Rate Model Dataset

• Survival Model UI Data Dataset

http://docs.oracle.com/cd/E60058_01/homepage.htm
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2. Replace the place holders ##SURVIVALSBX## and ##SANDBOXID## with Sandbox 
Information Domain name and Sandbox ID respectively, in the following tables of Config 
schema:

• MF_MODEL_MASTER

• MF_MODEL_SCRIPT_MASTER

3. Execute VW_SURVIVAL_MODEL.sql and vw_survival_model_derived_entity.sql, after 
the Sandbox is created. These files are present in the folder $FIC_HOME/scripts_OFS_
IFRS_8.0.7.0.0/atomic/create.

Configurations for Verifying and Executing Vintage Model
Perform the following configurations to verify and execute the Vintage Model.

1. Log in as LLFP Admin user and create a Sandbox from OFSAAI menu. Use the following 
datasets for creating this Sandbox:

• IFRS - Vintage Model Historic Dataset

• IFRS - Vintage Model Prediction Dataset

• IFRS - Vintage Model Average Loss Rate

2. Replace the place holders ##VINTAGESBXINFO## and ##VINSANDBOXID## with 
Sandbox Information Domain name and Sandbox ID respectively, in the following tables 
of Config schema:

• MF_MODEL_MASTER

• MF_MODEL_SCRIPT_MASTER

Once these configurations are set, you can follow the OFSAAAI Installation Guide to view, 
execute, and deploy the model from Sandbox. For more information, see Oracle Financial 
Services Advanced Analytical Applications Infrastructure Application Pack Installation and 
Configuration Guide available in Oracle Help Centre Documentation Library. 

Configuring Oracle R distribution and Oracle R Enterprise 
(ORE)

This is an optional step and is required only if you use PD Model feature of OFS LLFP. Skip 
and proceed with the next steps if OFS Enterprise Modeling Application with R scripting is not 
enabled during installation.

1. Install OFSAAIRunner Package. For more information, see Installing OFS AAAI Runner 
Package. If you have already installed OFSAAIRunner package (as part of a previous 
installation), uninstall it. (For more information, see Uninstalling OFSAAIRunner Package 
section), and reinstall the latest available OFSAAIRunner package.

2. Log in to the database with dba privileges and provide the following privilege to 
Configuration Schema:

• RQADMIN by executing the command:

GRANT RQADMIN TO <config_schema>;

3. Log in to the database with dba privileges and provide the following privileges to Atomic 
Schema:

• CREATE MINING MODEL privilege (to execute the Data Mining models) by executing the 
command: 
GRANT CREATE MINING MODEL TO <atomic_schema>;

http://docs.oracle.com/cd/E60058_01/homepage.htm
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Installing OFS AAAI Runner Package
OFSAAIRunner is an R package built by the OFS Enterprise Modeling Application. It is a 
prerequisite for executing models developed using R scripts. This package helps in:

• Initializing inputs

• Mapping framework variables to R objects

• Configuring possible outputs of the script

• Storing results back to the Database

OFSAAIRunner package (OFSAAIRunner_1.0.0.tar.gz) is available under $FIC_DB_
HOME/lib.

Prerequisite
Oracle R & ORE must be installed on the Oracle Database server before installing 
OFSAAIRunner package.

Refer to the following instructions to install OFSAAIRunner package:

1. Log in to the OFSAA Server. Navigate to the folder $FIC_DB_HOME/lib.

2. Copy the file OFSAAIRunner_1.0.0.tar.gz in Binary mode to the Oracle Database 
Server.

3. Log in to the Oracle Database Server with the user using which Oracle Database Server 
installation is done.

4. Navigate to the directory where the file OFSAAIRunner_1.0.0.tar.gz is copied.

5. Install the package by executing the command:

ORE CMD INSTALL OFSAAIRunner_1.0.0.tar.gz

Successful installation is indicated in the installation log as:

* DONE (OFSAAIRunner)

Making packages.html ... done

Note: The OFSAAIRunner package is installed in 
/usr/lib64/R/library.

6. Navigate to the directory $ORACLE_HOME/R/library and check whether OFSAAIRunner 
package is listed there by executing the command:

>library(OFSAAIRunner)

>OFSAAIRunner::

Press TAB twice.

This lists out all the functions.

Uninstalling OFSAAIRunner Package

Note: This procedure is required only if you are uninstalling OFSAAI 
Runner Package.
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Perform the following instructions to uninstall the OFSAAIRunner package:

1. Log in to the Oracle Database Server with the same user name, using which Oracle 
Database Server installation is done.

2. Enter ORE in command prompt and execute the command:

#ORE

>remove.packages("OFSAAIRunner")

3. To save workspace image, enter the command:

>q()

4. Enter y when prompted to save the workspace image.

[y/n/c]: y

5. Navigate to the directory $ORACLE_HOME/R/library and verify the package is not listed 
there by executing the command:

ls –l

Configuring ORE Execution
Perform the following step to configure ORE execution:

1. Add a TNS entry in tnsnames.ora file with tns name same as that of value set for 
ORACLE_SID in database server.

Note: For RAC database, follow the preceding configuration in all 
machines.

Configuring Tomcat
To stop generating static content with one print statement per input line, you need to configure 
the web.xml file.

To configure web.xml file, perform the following steps:

1. Navigate to tomcat/conf directory.

2. Edit web.xml file as explained below:

Set the mapped file parameter to False in the servlet tag mentioned with 

<servlet-name>jsp</servlet-name>.

<init-param>

<param-name>mappedfile</param-name>

<param-value>false</param-value>

</init-param>

Configuring Oracle Financial Services Inline Processing 
Engine (OFS IPE)

This section is applicable only if OFS Inline Processing Engine is licensed and enabled in your 
OFSAA instance.
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You should create an additional resource reference as JDBC/<INFODOMNAME> pointing to 
the same infodom in which IPE is installed. For information on creating resource reference, see 
Configuring Resource Reference in Web Application Servers section.

Follow the instructions in OFS IPE Configuration Guide to configure the OFSAA instance for 
using OFS Inline Processing Engine. This step is mandatory if you have enabled OFS Inline 
Processing Engine during the installation.

Updating OBIEE URL
To access the respective Business Intelligence Analytics Application, you need to update the 
OBIEE URL in the table 'AAI_MENU_B', once the OBIEE environment is up and running.

Following statement needs to be executed in the config schema:

UPDATE AAI_MENU_B

SET V_MENU_URL = '<obieeURL>'

WHERE V_MENU_ID IN ('<List of enabled BI Analytical Links for a 
particular Media Pack >')

/

COMMIT

/

Example 1:

UPDATE AAI_MENU_B

SET V_MENU_URL = ' http://IFRSIP:port/analytics'

WHERE V_MENU_ID IN ('OFS_LLFP_ANALYTICS')

/

COMMIT

/

Example 2:

update AAI_MENU_B set V_MENU_URL 
='http://ofss2221196.in.oracle.com:7001/analytics'

where V_MENU_ID = 'OFS_HM_ANALYTICS';

commit;

Creating and Deploying the Application Pack Web Archive 
On successful installation of the OFSAA Application Pack, the web archive file is 
automatically generated. However, you need to deploy the generated web archive file on the 
Web Application Server. 

To identify the location of the generated web archive file and to generate and deploy the web 
archive file, see Creating and Deploying EAR/ WAR File section.

Note: See the Oracle Financial Services Forms Manager User Guide for 
instructions on Creating and Deploying the Forms Manager Web Archive.

http://docs.oracle.com/cd/E60058_01/homepage.htm
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Accessing the OFSAA Application
Prior to accessing the OFSAA application ensure the Configuring Internet Explorer Settings are 
configured.

Refer to Accessing OFSAA Application section for details on accessing the OFSAA 
Application on successful deployment of the application web archive.

You can follow the Run Charts shared in My Oracle Support to populate required data to 
respective tables.

Performing Post Deployment Configurations
Prior to using the OFSAA Application perform the Post Deployment Configuration steps 
detailed in Post Deployment Configurations section.

Settings to Support Jersey 2.x on IBM WebSphere 8.5.5.9+
Follow these steps before deployment of OFS IFRS 8.0.7.0.0 into WebSphere 8.5.5.9.X.

1. Change the WAS configuration from the administrative console as follows: Global 
security > Web and SIP security > General settings.

2. Then uncheck the check box Use available authentication data when an unprotected 
URI is accessed.

Note: This is to bypass the basic authentication from WebSphere.

3. Map all the Jersey2.x/Jackson related Jars to WebSphere Shared Lib directory. 

4. Create a shared Library (for example: JERSEY2x) after $FIC_WEB_HOME/ant.sh is 
triggered for WAR/EAR creation.

The WAR file excludes those.

5. Copy the jars from $FIC_HOME/utility/externalib/WEB-INF/lib to locally available path 
of Unix user (owner of  WebSphere).

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2017368.1
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6. Map the Shared-Lib reference with OFSA applications.
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7. Disable the built-in JAX-RS via JVM property. 

1. Navigate to WebSphere admin console in Servers > WebSphere Application Servers 
> yourServerName. 

2. Navigate to Java and Process Management > Process definition > Java Virtual 
Machine > Custom properties, in Server Infrastructure section.

3. Add the following property:

com.ibm.websphere.jaxrs.server.DisableIBMJAXRSEngine=true

Configurations for Multiple Rating Feature
Change the value of rating_type_CAT.category_id parameter from “7004” to “5504” in 
searchinput.xml file. This file is present in $FIC_WEB_HOME/WEB-INF/props location.

This is mandatory to save the Multiple Rating definitions and should be performed before 
creating WAR file for deployment using ant.sh script.

For example:
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select distinct fsi_llfp_rating_pref_master.v_name  "17",

fsi_llfp_rating_pref_master.v_description "23",

dim_org_structure.v_entity_name  "24",

DIM_PRODUCT.v_prod_type_desc "3",

rating_type_CAT.lookup_description "9",

dim_credit_rating.V_RATING_SRC_DESC "13",

fsi_llfp_rating_pref_master.n_preference_id "PrimaryKey"

from fsi_llfp_rating_pref_master

INNER JOIN dim_org_structure

on (fsi_llfp_rating_pref_master.V_lv_code = dim_org_structure.v_
entity_code)

INNER JOIN DIM_PRODUCT

on (fsi_llfp_rating_pref_master.V_prod_type = DIM_PRODUCT.V_
PROD_TYPE)

inner join fsi_llfp_rating_type_pref

on (fsi_llfp_rating_pref_master.n_preference_id = fsi_llfp_
rating_type_pref.n_preference_id and fsi_llfp_rating_type_
pref.n_pref_Sequence = 1)

inner join fsi_llfp_rating_provider_pref

on (fsi_llfp_rating_pref_master.n_preference_id = fsi_llfp_
rating_provider_pref.n_preference_id and fsi_llfp_rating_
provider_pref.v_rating_type_code = fsi_llfp_rating_type_pref.v_
rating_type_code and fsi_llfp_rating_provider_pref.n_pref_
Sequence = 1)

inner join dim_credit_rating

on (fsi_llfp_rating_provider_pref.v_rating_Src_code = dim_
credit_rating.V_RATING_SRC_CODE)

inner join fsi_m_lookup_tl rating_type_CAT

ON rating_type_CAT.category_id = 5504 AND rating_type_
CAT.lookup_cd = fsi_llfp_rating_type_pref.v_rating_type_code

Update the Properties of ifrs-eir.ini File
The behavior of the IFRS EIR engine is controlled by six execution properties, which are 
present in the ifrs-eir.ini located at $FIC_DB_HOME/conf folder. You can update these 
properties for the following purposes:

Table 6–1 

Property Update Required/Function/Description

EIR_CALC_SCRIPT This refers to the name of the stored procedure that computes/persists 
the EIR value.

Typically, this should be left unmodified from the factory-setting.
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Performance Tuning Parameters
For better performance of OFS LLFP application, ensure that the following parameters are set 
accordingly:

• Ensure that the following parameters are set in the file OracleDB.conf present under 
$FIC_DB_HOME/conf folder, as mentioned:

• CNF_PARALLEL_QUERY=FORCE

PARALLEL_TABLES Tune the engine performance.

If more than one instrument table is attached to an ALM-process, you 
can perform the EIR calculation for these tables in parallel.

For example, If you set this to 5, the EIR calculation for a max of 5 
tables will be started in parallel.

If property is not set or is set to an invalid value, it will be defaulted to 
1 - serial mode.

NUM_EIR_THREADS Tune the engine performance.

If instrument table has more than 1 instrument record, this property 
determines how many parallel EIR executions are launched - one for 
each instrument record. One database-connection will be opened for 
each instrument-record.

For example, if you set this to 5, then EIR calculation will be launched 
for 5 instrument records at a time - each having its own private 
connection to the database.

By controlling (PARALLEL_TABLES) & (NUM_EIR_THREADS) 
properties, you can control how many sessions are connected to the 
database.

NUM_ACCOUNTS Tune the engine performance.

The engine queries the list of instrument IDs into memory and then 
iterates through these instrument IDs. Since there can be any number of 
instrument records, there may or may not be sufficient memory to load 
the list of instrument IDs. The engine therefore fetches the instrument 
IDs from the table(s) in smaller batches. The NUM_ACCOUNTS 
setting specifies that batch size.

If the number is too low, that engine needs to query the instrument 
table multiple times, to load the next set of instrument IDs.

OFSRM_EXECUTOR The EIR engine internally triggers the Cash Flow engine to generate 
the cash flows. The CFE, by design, expects a user ID as one of the 
inputs; all subsequent Cash Flow generation is done using the 
application preference of this user ID. By default, the EIR engine uses 
the last modified by / creator ID of the Cash Flow process, for the CFE 
execution.

A different user ID can be forced by using of this property. However, it 
implies that the ALM application preferences are available for this 
overridden user ID.

By default, this setting is disabled in the application.

IGNORE_CFE_ERROR By default, the EIR engine skips EIR computation if the Cash Flow 
generation process fails (that is, returns a non-zero exit status).

If this property is set to Y (or y), the EIR computation is not skipped 
and EIR will be computed for the instruments, for which Cash Flows 
have been generated.

By default, this setting is disabled in the application.

Table 6–1 

Property Update Required/Function/Description
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• CNF_PARALLEL_DML=FORCE

• CNF_DEGREE_OF_PARALLELISM=##DOP##

• CNF_PARALLEL_DEGREE_POLICY=Manual

Note: Replace the placeholder ##DOP## according to the hardware 
configuration of the database server.

• In case of execution of large volumes of data, to ensure better performance of T2T's, make 
sure that you perform the following:

• Ensure that Degree of Parallelism is enabled in the database.

• Ensure that the DOP value is set accordingly in the SETUP_MASTER table. Following is 
a sample query:

UPDATE SETUP_MASTER SET V_COMPONENT_VALUE =##DOP## WHERE V_
COMPONENT_CODE='LLFP_PARALLEL_DOP';

Note: Replace the placeholder ##DOP## according to the hardware 
configuration of the database server.

Other Tuning Parameters
Following are few additional performance tuning parameters.

• Enable parallelism for Rules using the following query:

UPDATE configuration SET PARAMVALUE = 'alter session set 
star_transformation_enabled=true; alter session force 
parallel dml parallel ##DOP##; alter session force parallel 
query parallel ##DOP##;' where PARAMNAME = 'QRY_OPT_PRE_
SCRIPT';

Note: Replace the placeholder ##DOP## according to the hardware 
configuration of the database server.

• For large volumes of data, consider disabling foreign keys in FCT_ACCOUNT_
DETAILS and FCT_IFRS_STAGE_DETERMINATION tables before the execution of 
ECL and Stage Determination runs respectively. Also, ensure to re-enable these after the 
completion of the run.

Note: Re-enabling is required if the ECL rules need to be modified from 
the UI.

• Gather stats before and after SCD and LLFP runs.

• Consider list partitioning strategy to partition the FSI_CF_PROCESS_OUTPUTS table 
based on N_METHOD_SKEY column.

• If partitioning is enabled, as mentioned above, execute the following query:

ALTER TABLE FSI_CF_PROCESS_OUTPUTS ENABLE ROW MOVEMENT;
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• Place Gather stats tasks at different stages of the ECL/CECL runs, as follows:

• Gather table stats on FSI_CF_PROCESS_OUTPUTS after DT - IFRS9_Load_
Forward_Exposures.

• Gather table stats on FSI_CF_PROCESS_OUTPUTS/FCT_ACCOUNT_DETAILS 
before DT - IFRS9_PD_Cumulative_Loss_Rate.

• Gather table stats on LLFP_FCT_ACCOUNT_SUMMARY before DT - IFRS9_
REFRESH_MV.

Database Tuning Parameters
Ensure that the following parameters are set appropriately:

• Temporary space

• sga_max_size and sga_target.

• pga_aggregate_limit and pga_aggregate_target 

• open_cursors

Creating Global Variables for OBIEE
To create the global variables for OBIEE, in this release of IFRS application, perform the 
following procedure:

1. Host the RPD and Catalog for LLFP solution as part of this release.

2. Login into OBIEE/analytics using the application URL.

3. Click Analytics link.

4. Click and select the subject area as IFRS 9.

The subject area details are displayed.

5. Expand a folder and double click on any column from the subject area.

6. Click Edit formula menu item.
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7. Click Variables tab and select Global option from the menu.

8. Create a global variables with the following details:

• Variable Name: denomination

Value: case when '@{denomination}{in thousand}' = 'in thousand' then 1000 else 
1000000 end

This variable is used to divide all amount values by thousand or million, depending on 
the selected criteria.

• Variable Name: RSkey

Value: case when "Run"."Run Execution Id" = '@{RunId}{1476270723292}' then 
"Run"."Run Skey" end

• Variable Name: stage

Value: "Previous IFRS9 Stages"."IFRS Stage Code"

9. Refresh the materialized by executing the following queries:

• EXECUTE DBMS_MVIEW.REFRESH(LIST=>'FCT_IFRS_STG_
DETERMINATION_MV');

This refreshing of MV should be done when there is a change to the Stage 
Determination table.
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• EXECUTE DBMS_MVIEW.REFRESH(LIST=>'FCT_COLLECTIVE_
ASSESSMENT_MV');

Deploying the Image file for HM Reports
Perform the following steps to deploy the image file for HM reports.

1. Copy all the images from the source path Customer Deliverables\Images.

2. Navigate to the location where OBIEE 12c has been installed.

3. Place the images file in the location Oracle_Home/user_projects/domains/bi/servers/bi_
server1/tmp/_WL_user/analytics/za01ic/war/res/s_blafp/meters/light/stop

4. Restart the OBIEE services.
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AConfiguring Web Server

This section covers the following topics:

• Configuring Web Server

• Configuring Web Application Servers

Configuring Web Server
This step assumes the installation of a web server exists as per the prerequisites.

Refer the product specific installation guide to install and configure the web server. If an 
installation already exists, skip and proceed to the next step.

Note: •Make a note of the IP Address/ Hostname and Port of the web 
server. This information is required during the installation process.

• Refer Oracle Financial Services Analytical Applications Infrastructure 
Security Guide mentioned in the Related Documents section for additional 
information on securely configuring your web server.

• Ensure to enable sticky session/affinity session configuration on the web server. 
Refer the respective product specific Configuration Guide for more details. 
Additionally, you also need to enable the sticky session/affinity session 
configuration at Load Balancer level if you have configured a Load Balancer in 
front of the web server(s).

Configuring Web Application Servers
This step assumes an installation of a web application server exists as per the prerequisites. To 
configure the Web Application Server for OFSAA Deployment refer the following sections. 

This section includes the following topics:

• Configuring WebSphere Application Server for Application Deployment

• Configuring WebLogic for Application Deployment

• Configuring Apache Tomcat Server for Application Deployment



Note: 

• Make a note of the IP Address/ Hostname and Port of the web 
application server. This information is required during the installation 
process (required if web server is not configured).

• Make a note of the IP Address/ Hostname and Port of the web 
application server. This information is required during the installation 
process (required if web server is not configured).

• Refer OFSAA Secure Configuration Guide/ Security Guide mentioned in the 
Related Documents section for additional information on securely configuring 
your Web Server.
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 Configuring WebSphere Application Server for Application Deployment
You can deploy multiple OFSAA applications on different profiles of a stand-alone WebSphere 
application server. To create multiple WebSphere "Profiles" in a stand-alone server, use the 
command line option as explained in the following section. A profile is the set of files that 
define the runtime environment. At least one profile must exist to run WebSphere Application 
Server.

This section covers the following topics:

• Creating New Profile in WebSphere

• Managing IBM WebSphere SDK Java Technology Edition Versions

• Managing Applications in WebSphere

• Deleting WebSphere Profiles

• Configuring WebSphere Shared Library to Support Jersey 2x and Jackson 2.9x Libraries

• Configuring WebSphere HTTPS

• Configuring WebSphere Memory Settings

• Configuring WebSphere for REST Services Authorization

• Configuring Application Security in WebSphere

Creating New Profile in WebSphere
The Profile is created in WebSphere through command line using the manageprofiles.sh that 
resides in the <WebSphere Install directory>/AppServer/bin directory.

The command to create a profile without admin security through command line is as follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile_
path> -templatePath <template_path> -nodeName <node_name> -cellName <cell_
name> -hostName <host_name>"

Example:

$usr/home>./manageprofiles.sh -create -profileName mockaix 
-profilePath/websphere/webs64/Appserver/profiles/mockaix 
-templatePath/websphere/webs64/Appserver/profileTemplates/default 
-nodeName ipa020dorNode04 - cellName ipa020dorNode04Cell -hostName 
ipa020dor

The command to create a profile with admin security through command line is as follows:
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"manageprofiles.sh -create -profileName <profile> -profilePath <profile_
path> -templatePath <template_path> -nodeName <node_name> -cellName <cell_
name> -hostName <host_name> -enableAdminSecurity true -adminUserName 
<Admin User Name> -adminPassword < Admin User Password> -samplespassword 
<sample User Password>" 

Example:

$usr/home>./manageprofiles.sh -create -profileName mockaix 
-profilePath/websphere/webs64/Appserver/profiles/mockaix 
-templatePath/websphere/webs64/Appserver/profileTemplates/default 
-nodeName ipa020dorNode04 -cellName ipa020dorNode04Cell -hostName 
ipa020dor -enableAdminSecurity true -adminUserName ofsaai -adminPassword 
ofsaai -samplespassword ofsaai"

Note: While using the manageprofiles.sh command to create a New 
Profile in WebSphere, you can also use "-validatePorts" to validate if the 
specified ports are not reserved or in use. Additionally, you can specify new 
ports with "-startingPort <base port>" which specifies the starting port 
number to generate and assign all ports for the profile. For more information 
on using these ports, refer WebSphere manageprofiles command.

Managing IBM WebSphere SDK Java Technology Edition Versions
By default, WebSphere Application Server V8.5.5.X uses the Java 6.0 SDK. You must upgrade 
to Java 7.X SDK or JAVA 8.X SDK.

Prerequisites: Install the IBM WebSphere SDK Java Technology Edition Versions 1.7.X_64 or 
1.8.X_64.

Perform the following steps to upgrade to Java 7.X SDK or JAVA 8.X SDK:

1. Enter the WebSphere URL in the format http://HOST_NAME:PORT_
NUMBER/ibm/console (use https if SSL is enabled.). For example, 
http://192.168.1.0:9000/ibm/console. 

2. Login with your administrator user ID and password. 

3. From the LHS menu, click Servers to expand and view the menu.

4. Click Server Types to expand the menu further and then click WebSphere Enterprise 
Application Servers to view the Application servers window. 

5. On Application servers window, click the required Application Server link. For example, 
server1 in the following illustration:   

http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=%2Fcom.ibm.websphere.base.doc%2Finfo%2Faes%2Fae%2Frxml_manageprofiles.html
http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=%2Fcom.ibm.websphere.base.doc%2Finfo%2Faes%2Fae%2Frxml_manageprofiles.html


Configuring Web Application Servers

A-4 OFS IFRS Installation and Configuration Guide                  

Figure A–1 Application Server - Java SDKs

6. Click Java SDKs link from Server Infrastructure to view the list of Java SDKs.

Figure A–2 Application Server - List of Java SDKs 
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7. Select either 1.7_64 or 1.8_64 based on the JVM version with which you plan to install 
OFSAA or have installed with. 

8. Click Make Default button and save to master repository.

9. Restart the WebSphere Application Server to apply the changes to the IBM application 
profile.

Managing Applications in WebSphere
To manage the installed applications in WebSphere, follow these steps:

1. Open the administrator console using the following URL:

http://<ipaddress>:<Administrative Console Port>/ibm/console

For example: http://10.111.222.333:9003/ibm/console (https if SSL is enabled)

Note: Administrative Console Port value is available in serverindex.xml 
file within <WebSphere Profile Directory>/config/cells/<Node 
Cell>/nodes/<Node Name> directory.

The Integrated Solutions Console Login window is displayed.

Figure 6–1 Integrated Solutions Console Login

2. Log on with the User ID provided with the admin rights.

3. From the LHS menu, expand the Applications > Application Type> WebSphere 
Enterprise Applications.

The Enterprise Applications window is displayed.
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Figure 6–2 Enterprise Applications

 This Enterprise Applications window helps you to:

• Install new application

• Uninstall existing applications

• Start or Stop the installed applications

Configuring WebSphere Application Server to Use a Load Balancer or 
Proxy Server
The configuration prevents the process server from redirecting to an internal port when using a 
load balancer or proxy server.

The following steps describe the configuration:

1. Enter the WebSphere URL in the format http://HOST_NAME:PORT_
NUMBER/ibm/console (use https if SSL is enabled.). For example, 
http://192.168.1.0:9000/ibm/console. 

2. Login with your administrator user ID and password. 

3. From the LHS menu, click Servers to expand and view the menu.

4. Click Server Types to expand the menu further and then click WebSphere Enterprise 
Application Servers to view the Application servers window. 

5. On Application servers window, click the required Application Server link. For example, 
server1 in the following illustration:   
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Figure A–3 Application Servers - Load Balancer Proxy Server

6. Click Web Container Settings > Custom Properties.

7. Add the following properties:

• Name: trusthostheaderport

Value: true

• Name: com.ibm.ws.webcontainer.extractHostHeaderPort

Value: true

8. Restart the WebSphere Application Server to apply the changes. 

Deleting WebSphere Profiles
To delete a WebSphere profile, follow these steps:

1. Select the check box adjacent to the required application and click Stop.

2. Stop the WebSphere profile to be deleted.

3. Navigate to WebSphere directory:

<WebSphere_Installation_Directory>/AppServer/bin/

4. Execute the command:

manageprofiles.sh -delete -profileName <profile_name>

5. Delete profile folder.

Example: <WebSphere_Installation_Directory>/AppServer/profiles/<profile_
name>

6. Execute the command:

manageprofiles.sh -validateAndUpdateRegistry
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Configuring WebSphere Shared Library to Support Jersey 2x and 
Jackson 2.9x Libraries
Perform the following configuration to set WebSphere shared library to support jersey 2x and 
Jackson 2.9x libraries. 

1. Click Environment from the menu on the left to expand and view the list. Click Shared 
Libraries to open the Shared Libraries window.

2. Enter details as shown in the following:

1. Name: Enter a unique identifiable name.

2. Description: Enter a valid description.

3. Classpath: Enter the absolute path where the JARs related to Jersey 2.x and Jackson 
2.9x are copied. These jars are available in the <OFSAA_
HOME>/utility/externallib/WEB-INF/lib directory after creation of the EAR file.

3. Select Use an isolated class loader for this library.

4. Click OK to save to master configuration. 

5. Select the application or module and map the shared libraries. Click OK. In the following 
illustration, ofsa is selected.
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6. From the Shared Library Mapping window, move the required shared libraries from 
Available to Selected. In the following illustration, JERSEY2x is selected.

7. Click OK.

8. Similarly, select the next application or module and repeat the procedure from steps 5 to 7.
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9. Disable the built-in JAX-RS via JVM property.

1. Go to WebSphere admin console in Servers > WebSphere Application Servers > 
yourServerName. 

2. In Server Infrastructure section, go to Java and Process Management > Process 
definition > Java Virtual Machine > Custom properties.

3. Add the following property:

com.ibm.websphere.jaxrs.server.DisableIBMJAXRSEngine=true

10. Restart the application.

Configuring WebSphere HTTPS
To configure an HTTPS Transport on WebSphere, follow these steps:

1. Create a profile using the Profile Creation Wizard in WebSphere.

Note: Note down the https port specified during this process and use the 
same as servlet port or web server port during OFSAAI installation.

2. To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ENABLE" in 
OFSAAI_InstallConfig.xml for Silent mode OFSAAI installation.

Configuring WebSphere Memory Settings
To configure the WebSphere Memory Settings, follow these steps:

1. Navigate to Websphere applications server > Application servers > server1 
> Process definition > Java Virtual Machine.

2. Change the memory setting for Java Heap:

Initial heap size = 512

Maximum heap size = 3072

Configuring WebSphere for REST Services Authorization
Configure the following in WebSphere to enable REST API authorization by OFSAA:
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1. Log on to WebSphere console with the User ID provided with the admin rights.

2. Expand Security menu in the LHS and click Global security > Web and SIP security > 
General settings. 

3. De-select the Use available authentication data when an unprotected URI is accessed 
check box.

4. Click OK.

5. Click Save to save the changes to master configuration.
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Configuring Application Security in WebSphere
This is a mandatory security procedure for WebSphere to restrict the unauthorized access of 
configuration files in directories. For detailed information, see the Oracle Financial Services 
Analytical Applications Infrastructure Security Guide.

Configuring WebLogic for Application Deployment
You can deploy multiple Infrastructure applications on different domains of a stand-alone 
WebLogic application server. To create multiple WebLogic "Domains" in a stand-alone server 
you can use the Domain Creation wizard. A domain is the set of files that define the runtime 
environment. At least one domain must exist to run WebLogic Application Server.

This section covers the following topics:

• Creating Domain in WebLogic Server

• Deleting Domain in WebLogic

• Configuring WebLogic Memory Settings

• Configuring WebLogic for REST Services Authorization

Creating Domain in WebLogic Server
To create a new domain using Configuration Wizard in WebLogic, follow these steps:

1. Navigate to the directory <WLS_HOME>/wlserver/common/bin and execute the 
command:

./config.sh

The Welcome window of the Configuration Wizard is displayed.

https://docs.oracle.com/cd/E61555_01/books/OFSAAI_Security_Guide.pdf
https://docs.oracle.com/cd/E61555_01/books/OFSAAI_Security_Guide.pdf
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2. Select Create a new WebLogic domain option and click Next.

The Templates window is displayed.
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3.  Select the Create Domain Using Product Templates option and click Next.

The Administrator Account window is displayed.
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4. Enter the user name to be assigned to the administrator, the password and confirm the 
password. Click Next.

The Domain Mode and JDK window is displayed.
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5. Select from the following options:

• In the Domain Mode section, select the required mode (Development or Production).

• In the JDK section, select the required option. If you select Other JDK Location, click 
Browse, navigate to the JDK location, and select. Click Next.

The Advanced Configuration window is displayed.
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6. Select Administration Server. A WebLogic Server domain must have an Administration 
Server. You can also select Manages Servers, Clusters and Machines and RDBMS Security 
Store, if required. Click Next.

The Administration Server window is displayed.
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7. Enter Administration Server details such as the Server Name, Listen address, Listen Port, 
Enable SSL(for secure login using https, select this check box), and SSL listen port. Click 
Next.

The Configuration Summary window is displayed

Note: Make a note of the Listen Port or SSL Listen Port value (for 
example: 7007), since the same has to be re-entered in the Servlet port field 
during Infrastructure installation.
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8. Verify the configuration details of the WebLogic domain and click Create.

The Configuration Progress window is displayed with the status indication of the domain 
creation process.



Configuring Web Application Servers

A-20 OFS IFRS Installation and Configuration Guide                  

9. Click Next when 100% of the activity is complete.

The End of Configuration window is displayed
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10. Click Finish. The domain server is created enabling the deployment of multiple 
Infrastructure applications on a single WebLogic.

Note: 

• Note down the HTTPS port specified during this process and use the 
same as servlet port or web server port during OFSAAI Installation.

To enable https configuration on Infrastructure, assign value 1 to "HTTPS_
ENABLE" in OFSAAI_InstallConfig.xml for silent mode OFSAAI 
installation

11. Add a java option entry -DUseSunHttpHandler=true in WLS_HOME/bin/ 
"setDomainEnv.sh" file (Required only if self signed certificate is used).

Deleting Domain in WebLogic
To delete a domain in WebLogic, follow these steps:

1. Navigate to the following directory:

<WebLogic Installation directory>/user_projects/domains/<domain 
name>/bin

2. Execute stopWebLogic.sh to stop the Weblogic domain.
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3. Delete the Weblogic domain.

Configuring WebLogic Memory Settings
To configure the WebLogic Memory Settings, follow these steps:

1. Change the memory setting for Java Heap to -Xms512m -Xmx3072m in setDomainEnv.sh 
file, which resides in the folder <DOMAIN_HOME>/bin and in CommEnv.sh file which 
resides in the folder common/bin.

2. Edit this file for customizing memory settings and garbage collector settings depending on 
the available hardware configuration.

Example 1:

if [ "${JAVA_VENDOR}" = "Sun" ] ; then

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_64BIT

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_32BIT

else

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_64BIT

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_32BIT

Example 2:

JAVA_VM=

MEM_ARGS="-Xms256m -Xmx1024m"

Configuring WebLogic for REST Services Authorization
To enable REST API authorization by OFSAA in WebLogic, perform the following steps:

1. Open the config.xml file located in the domain where OFSAA is deployed, that is 
<domain_home>/config/config.xml.

2. Add the following in the security-configuration tag:

<enforce-valid-basic-auth-credentials>false</enforce-valid-ba
sic-auth-credentials>

Configuring Apache Tomcat Server for Application Deployment
This section is applicable only when the Web Application Server type is Tomcat.

This section includes the following topics:

• Tomcat User Administration

• Configuring Tomcat to use JAVA 64 bit Executables

• Configuring Servlet Port

• Configuring SSL Port

• Apache Tomcat Memory Settings
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• Configuration for Axis API

• Uninstalling WAR Files in Tomcat

Tomcat User Administration
The Tomcat administration and manager application does not provide a default login. You are 
required to edit "$CATALINA_HOME/conf/tomcat-users.xml" as instructed below.

This file contains an XML <user> for each individual user, which will display the user name 
and password used by admin to log on to Tomcat, and the role names to which the admin user 
is associated with. For example, <user name="admin" password="admin" 
roles="standard,manager" />

1. Add the manager role to any one of the existing user name/password combination as 
shown in the preceding example.

2. Use the same user name/password to which the manager role has been assigned to access 
the Tomcat Application Manager.

3. If the Tomcat server is already running, it requires a re-start after the aforementioned 
configuration is done.

Configuring Tomcat to use JAVA 64 bit Executables
To configure Tomcat to use JAVA 64 bit, follow these steps:

1. Navigate to the "$CATALINA_HOME/bin" folder.

2. Edit the setclasspath.sh file as follows:

3. Replace the following block of text

# Set standard commands for invoking Java.

_RUNJAVA="$JRE_HOME"/bin/java

if [ "$os400" != "true" ]; then

_RUNJDB="$JAVA_HOME"/bin/jdb

With:

# Set standard commands for invoking Java.

_RUNJAVA="$JAVA_BIN"/java

if [ "$os400" != "true" ]; then

_RUNJDB="$JAVA_BIN"/jdb

4. If the Tomcat server is already running, it requires a re-start after the aforementioned 
configuration is done.

Note: In case tomcat is installed under different Unix profile, set JAVA_
BIN environment variable in .profile to include the Java Runtime 
Environment absolute path.

For example:

export JAVA_BIN /usr/java7_64/jre/bin

export JAVA_BIN = /usr/java7_64/jre/bin//sparcv9 for Solaris 
Sparc
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Configuring Servlet Port
The default servlet port configured for the Tomcat installation is 8080. Ignore this section if 
you need to use the default port.

If you need to use a different port number, you must first configure the port in the server.xml 
file in the conf directory of Tomcat Installation directory. 

To configure the Servlet Port, follow these steps:

1. Navigate to $CATALINA_HOME/conf. Open server.xml and locate the tag:

2. "Define a non-SSL HTTP/1.1 Connector on port 8080 " 

3. Against this tag, a parameter is specified 'Connector port = "8080" '. Edit this value to 
the new port number that was used during the Infrastructure installation process. 

4. Save your changes in server.xml file.

Note: Make a note of the servlet port configured. This information is 
required during the installation of OFSAA Application Pack.

Configuring SSL Port 
If you need to configure and access your OFSAA setup for HTTPS access, ensure that the 
following connect tag under Define a SSL HTTP/1/1 Connector on port 8443 in <Tomcat_
installation_folder>/conf/server.xml file is uncommented for SSL Configuration. (By 
default, it is commented).

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"

maxThreads="150" scheme="https" secure="true"

clientAuth="false" sslProtocol="TLS"

Note: 

• Make a note of the servlet port configured. This information would be 
required during the installation of OFSAA Application Pack.

• To enable https configuration on Infrastructure, assign value 1 to 
"HTTPS_ENABLE" in OFSAAI_InstallConfig.xml file for SILENT 
mode OFSAAI installation.

For more information related to SSL Configuration on Tomcat, see to 
http://tomcat.apache.org/.

Apache Tomcat Memory Settings
To configure the Apache Tomcat Memory Settings, follow these steps:

1. Locate the catalina.sh file that resides in  <CATALINA_HOME>/bin  directory.

2. Edit this file for customizing the memory settings and garbage collector settings depending 
on the available hardware configuration.

3. Add the memory setting for Java Heap to -Xms512m -Xmx1024m.

4. For example:

if [ -z "$LOGGING_MANAGER" ]; then

http://tomcat.apache.org/
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JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m

-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager"

else

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m $LOGGING_MANAGER"

fi

Configuring Axis API
Copy the jaxrpc.jar from the <OFSAA Installation Directory>/axis-1_ 
4/webapps/axis/WEB-INF/lib and place it inside the <Tomcat Installation Directory>/lib folder 
and restart the Tomcat Server.

Configuring Tomcat for User Group Authorization and Data Mapping
Users with system authorization roles can access User Group Authorization. However, to make 
it available on Tomcat web server, you have to perform the following configuration steps:

1. Navigate to the $CATALINA_HOME/conf  directory and open web.xml file.

2. Enter the following in the web.xml  file.

<init-param> 

<param-name>mappedfile</param-name>

<param-value>false</param-value>

</init-param>

3. Save and close the file.

Uninstalling WAR Files in Tomcat
To uninstall WAR files in tomcat, refer Uninstalling WAR Files in Tomcat.

Configuration for Axis API
Copy the jaxrpc.jar from the <OFSAA Installation Directory>/axis-1_
4/webapps/axis/WEB-INF/lib and place it in under <Tomcat Installation 
Directory>/lib and restart the Tomcat Server.
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BConfiguring Resource Reference in Web 
Application Servers

This section covers the following topics:

• Configuring Resource Reference in WebSphere Application Server

• Configuring Resource Reference in Weblogic Application Server

• Configuring Resource Reference in Tomcat Application Server

Configuring Resource Reference in WebSphere Application 
Server

This section is applicable only when the Web Application Server type is WebSphere.

This section covers the following topics:

• Creating JDBC Provider

• Creating a Data Source

• Creating J2C Authentication Details

• Defining JDBC Connection Pooling

Creating JDBC Provider
1. Open the WebSphere admin console in the browser window: 

http://<ipaddress>:<administrative console port>/ibm/console. (https if 
SSL is enabled). The Login window is displayed. 

2. Log in with the user id that has admin rights.

3. Expand the Resources option in the LHS menu and click JDBC > JDBC Providers. The 
JDBC Providers window is displayed.
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Figure 6–3 JDBC Providers

4. Select the Scope from the drop-down list. Scope specifies the level at which the resource 
definition is visible.

5. Click New to add new JDBC Provider under the Preferences section. The Create new 
JDBC provider window is displayed.

Figure 6–4 Create a new JDBC Provider

6. Enter the following details:



Table B–1 Fields and their description

Field Description

Database Type Oracle

Provider Type Oracle JDBC Driver

Implementation Type  Connection pool data source

Name The required display name for the resource

Description The optional description for the resource
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7. Click Next. 

Enter database class path information

8. Specify the directory location for "ojdbc<version>.jar" file. Ensure that you do not use 
the trailing slash file separators. 

The Oracle JDBC driver can be downloaded from the following Oracle Download site:

? Oracle Database 11g Release 2 (11.2.0.4) JDBC Drivers

? Oracle Database 12c Release 1 (12.1.0.1) JDBC Drivers

Once downloaded, you need to copy the file in the required folder on the server. 

Note: Refer Appendix O section for identifying the correct 
ojdbc<version>.jar version to be copied.

9. Click Next. The Summary window is displayed.

Summary

http://www.oracle.com/technetwork/apps-tech/jdbc-112010-090769.html
http://www.oracle.com/technetwork/database/features/jdbc/jdbc-drivers-12c-download-1958347.html
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10. Verify the details and click Finish to create the JDBC Provider.

11. The options to Save and Review are displayed. Click Save.

Creating a Data Source
The steps given below are applicable for both config and atomic data source creation.

1. Open this URL in the browser window: http://<ipaddress>:<administrative 
console port>/ibm/console. (https if SSL is enabled). The Login window is displayed. 

2. Log in with the user id that has admin rights.

3. Expand the Resources option in the LHS menu and click JDBC > Data sources option. 
The Data sources window is displayed.

Figure B–1 Data Sources

4. Select the Scope from the drop-down list. Scope specifies the level at which the resource 
definition is visible.
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5. Click New. The Create a Data Source window is displayed.

Figure B–2 Create Data Source

6. Specify the Data Source name and JNDI name for the new "Data Source".

The JNDI and Data Source name are case sensitive and ensure that JNDI name is same as 
the "Information Domain" name. 

7. Click Next. The Select JDBC provider window is displayed.

Figure B–3 Select JDBC provider

8. Select the option Select an Existing JDBC Provider and select the required JDBC 
provider from the drop-down list. Click Next.
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Figure B–4 Enter database specific properties

9. Specify the database connection URL.

For example: jdbc:oracle:thin:@<DB_SEREVER_IP>:<DB_SERVER_PORT>:<SID>

10. Select Data Store Helper Class Name from the drop-down list and ensure that the 
checkbox Use this data source in container managed persistence (CMP) is selected. 

Note: For RAC configuration, provide the RAC url specified during 
installation.

Example: jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS_
LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=10.11.12.13)(port=1521))(ADDRESS=(PRO
TOCOL=TCP)(HOST=10.11.12.14)(PORT=1521))(LOAD_
BALANCE=no)(FAILOVER=yes))(CONNECT_DATA=(SERVICE_NAME=pqadb)))

11. Click Next.

Figure B–5 Enter Database specific properties

12. Map the J2C authentication alias, if already created. If not, you can create a new J2C 
authentication alias by accessing the link given (Global J2C authentication alias) or you 
can continue with the data source creation by clicking Next and then Finish.
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Figure B–6 Summary

You can also create and map J2C authentication alias after creating the data source.

13. You must create another Data source by following the aforementioned procedure with 
jdbc/FICMASTER as JNDI name pointing to the "configuration schema" of Infrastructure.

Creating J2C Authentication Details
The steps given below are applicable for creating both config and atomic J2C Authentication.

To create J2C Authentication details, follow these steps:

1. Select the newly created Data Source and click JAAS - J2C authentication data link 
under Related Items. 

Figure B–7 JAAS- J2C authentication data
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2. Click New under the Preferences section.

Figure 6–5 JAAS- J2C authentication data- New

3. Enter the Alias, User ID, Password, and Description. Ensure the following:

? User ID is the Oracle user ID created for the respective Config and Atomic Schema 
for the "Information Domain".

? Specify the Config database user ID and password information for the 
jdbc/FICMASTER data source, and specify the Atomic database user ID and 
password information for the Atomic schema data source that you created earlier.

4. Click Apply and save the details.

Defining JDBC Connection Pooling
To define the JDBC connection pooling ensure that you have created JDBC Provider and Data 
source to access the data from the database.

1. Expand the Resources option in the LHS menu and click JDBC > Data sources option. 
The Data sources window is displayed.

2. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Data 
sources>$DATA_SOURCE$>Connection pools.
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Figure B–8 Connection pools

3. Set the values for Connection timeout to 0 seconds, Maximum connections to 100 
connections, and Minimum connections to 10 connections as shown in the aforementioned 
figure. You can also define Reap Time, Unused Timeout, and Aged Timeout as required.

Configuring Resource Reference in Weblogic Application 
Server

This section is applicable only when the Web Application Server type is WebLogic.This section 
includes the following topics:

• Creating Data Source

• Creating GridLink Data Source

• Configuring Multi Data Sources

• Configuring Advanced Settings for Data Source

• Defining JDBC Connection Pooling

In WebLogic, you can create "Data Source" in the following ways:

• "For a Non RAC Database instance, Generic Data Source has to be created. See Create 
Data Source.

• "For a RAC Database instance, Gridlink Data Source has to be created. See Create 
GridLink Data Source.

• "When Load Balancing/Fail over is required, Multi Data Source has to be created. See 
Configure Multi Data Sources.

Creating Data Source
The steps given below are applicable for both config and atomic data source creation.
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1. Open the following URL in the browser window: 
http://<ipaddress>:<administrative console port>/console. (https if SSL is 
enabled). The Welcome window is displayed. 

2. Log in with the Administrator User name and Password. 

Figure B–9 Welcome

3. From the LHS menu (Domain Structure), click Services > Data Sources. The Summary of 
JDBC Data Sources window is displayed.

Figure B–10 Summary of JDBC Data Sources

4. Click New and select Generic Data Source option. The Create a New JDBC Data Source 
window is displayed.

You can also select GridLink Data Source or Multi Data Source while creating a Data 
Source. For more information, see Creating Data Sourceor Configuring Multi Data 
Sources.
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Figure 6–6 Create a New JDBC Data Source

5. Enter JDBC data source Name, JNDI Name, and select the Database Type from the 
drop-down list. Click Next.

Ensure the following:

• The JNDI Name field should be in the format "jdbc/informationdomain"

• Same steps needs to be followed to create a mandatory data source pointing to the 
"configuration schema" of infrastructure with jdbc/FICMASTER as JNDI name. 

• JNDI Name is the same as mentioned in web.xml file of OFSAAI Application.

• Required "Database Type" and "Database Driver" should be selected.

Figure B–11 JDBC Data Source Properties

6. Select the Database Driver from the drop-down list. You need to select the Database 
Driver depending on database setup, that is, with or without RAC. Click Next.
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Figure B–12 Transaction Options

7. Select the Supports Global Transactions checkbox and the One-Phase Commit option.

8. Click Next. The Connection Properties window is displayed.

Figure B–13 Connection Properties

9. Enter the required details such as the Database Name, Host Name, Port, Oracle User 
Name, and Password. 

10. Click Next. The Test Database Connection window is displayed.
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Figure B–14 Test Database Connection

11. Verify the details and click Test Configuration and test the configuration settings.

A confirmation message is displayed stating "Connection test succeeded."

12. Click Finish. The created "Data Source" is displayed in the list of Data Sources.

Note: 

• "User ID" is the Oracle user ID that is created for the respective 
"Information Domain".

• "User ID" to be specified for data source with "FICMASTER" as "JNDI" 
name should be the Oracle user ID created for the "configuration 
schema".

13. Select the new Data Source and click the Targets tab. 
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Figure B–15 Select Targets

14. Select the AdminServer option and click Finish.

Creating GridLink Data Source
If you have selected the option, New > GridLink Data Source while creating the "Data 
Source", you can directly specify the JDBC URL as indicated.

Figure 6–7 Create a New JDBC GridLinkData Source

1. Enter Data Source Name, and JNDI Name.

Ensure that the "JNDI Name" field is specified in the format "jdbc/infodomname" and the XA 
Driver checkbox is not selected. Click Next.
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Figure 6–8 JDBC GridLinkData Source- Connection Properties

2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish. The 
created "Data Source" is displayed in the list of Data Sources.

Configuring Multi Data Sources
A JDBC multi data source is an abstraction around a group of data sources that provides load 
balancing and failover between data sources. As with data sources, multi data sources are also 
bound to the JNDI tree. Applications can look up a multi data source on the JNDI tree and then 
reserve a database connection from a data source. The multi data source determines from which 
data source to provide the connection.

When the database used is Oracle RAC (Real Application Clusters) which allows Oracle 
Database to run across a set of clustered servers, then group of data sources can be created for 
instances running on a set of clustered servers and a JDBC multi data source can be created so 
that applications can look up a multi data source on the JNDI tree to reserve database 
connection. If a clustered server fails, Oracle continues running on the remaining servers.

1. Open WebLogic Admin Console in the browser window: 
http://<ipaddress>:<administrative console port>/console. (https if SSL is 
enabled). The Login window is displayed. 

2. Log in with the "User ID" that has admin rights.

3. In the LHS menu (Domain Structure), select Services > JDBC > Multi Data Sources. The 
Summary of JDBC Multi Data Sources window is displayed. 
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Figure 6–9 Summary of JDBC Multi Data Sources

4. Click New. The New JDBC Multi Data Source window is displayed.

Note: Ensure that the Data Sources which needs to be added to new JDBC 
Multi Data Source has been created.

Figure 6–10 Configure the Multi Data Source

5.  Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from the 
drop-down list. Click Next.

Note: 

• The JNDI Name has to be specified in the format jdbc/infodomname. 

• JNDI Name of the Data Sources that will be added to new JDBC Multi 
data source should be different from the JNDI name specified during 
Multi Data Source. 

• Same steps needs to be followed to create a mandatory data source 
pointing to the "configuration schema" of infrastructure with 
jdbc/FICMASTER as JNDI name for Data Source. 

• JNDI Name provided in multi data source should be the same name that 
will be mentioned in the web.xml file of OFSAAI Application.

• You can select the Algorithm Type as Load-Balancing.
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Figure 6–11 Select Targets

6. Select the AdminServer checkbox and click Next.

Figure 6–12 Select Data Source Type

7.  Select the type of data source which will be added to new JDBC Multi Data Source. Click 
Next.

Figure 6–13 Add Data Sources

8.  Map the required Data Source from the Available Data Sources. Click Finish.

 The New JDBC Multi Data Source is created with added data sources.

Configuring Advanced Settings for Data Source
Perform the following steps for advanced settings for Data Source: 

1. Click the new Data Source from the Summary of JDBC Data Sources window. The 
Settings for <Data Source Name> window is displayed.

2. Select the Connection Pooling tab given under Configuration.

3. Go to the Advanced option at the bottom of the window, and check the Test Connection 
of Reserve checkbox (Enables Weblogic Server to test a connection before giving it to a 
client).
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To verify if the data source is valid, select "Data Source name". For example, 
FICMASTER.

Figure 6–14 Settings for <Data Source Name>

4. Select the server and click Test Data Source.

A message is displayed indicating that the test was successful.

5.  Once the "Data Source" is created successfully, the following messages are displayed:

? All changes have been activated. No restart is necessary.

? Settings updated successfully. 

If not, follow the aforementioned steps to recreate the data source. 

Defining JDBC Connection Pooling
To define the JDBC connection pooling, ensure that you have created JDBC Provider and Data 
source to access the data from the database.

1. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Home 
>Summary of Services: JDBC >Summary of JDBC Data Sources >JDBC Data 
Source-<INFODDOM_NAME>

2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity 
Increment by 1, Statement Cache Type to LRU, and Statement Cache Size to 10.

3.  Click Save.

Configuring Resource Reference in Tomcat Application 
Server

This section is applicable only when the Web Application Server type is Tomcat.

This section covers the following topics:

• Creating Data Source

• Defining JDBC Connection Pooling

• Configuring Class Loader for Apache Tomcat

Copy the Oracle JDBC driver file, "ojdbc<version>.jar" from <Oracle Home>/jdbc/lib and 
place it in <Tomcat Home>/lib.



Note: Refer Appendix O for identifying the correct ojdbc<version>.jar 
version to be copied.
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Creating Data Source
To create "data source" for Infrastructure application, navigate to <Tomcat Home>/conf and 
edit the following block of text by replacing the actual values in server.xml.

Note: The User-IDs for configuration/ atomic schemas have the prefix of 
setupinfo depending on the value set for PREFIX_SCHEMA_NAME in 
<<APP Pack>>_SCHEMA_IN.XML file of Schema Creator Utility. 

For example: if the value set for PREFIX_SCHEMA_NAME is DEV and the 
schema name was mentioned as ofsaaconf, then the actual schema created in 
the database would be DEV_ofsaaconf.

In the event, Oracle Wallet is configured in OFSAA server to store the database passwords, edit 
the server.xml present under the path $TOMCAT_DIRECTORY/conf/ with the following 
changes, which is required for connection pooling.

<Context path="/ $CONTEXTNAME$" docBase=" $APP_DEPLOYED_PATH$ " 
debug="0" reloadable="true" crossContext="true">

<Resource auth="Container" 
name="jdbc/ $INFODOM_NAME$" 
type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver" 
url="$JDBC_CONNECTION_URL"
maxTotal="100" 
maxIdle="30" 
maxWaitMillis="10000"

removeAbandoned="true" 
removeAbandonedTimeout="60" 
logAbandoned="true"/>
</Context>



Note: 

• $APP_DEPLOYED_PATH$ should be replaced by OFSAAI application 
deployed path.

• $INFODOM_NAME$ should be replaced by Infodom Name.

• $ATOMICSCHEMA_USERNAME$ should be replaced by Atomic schema 
database user name.

• $ATOMICSCHEMA_PASSWORD$ should be replaced by Atomic schema 
database password.

• $JDBC_CONNECTION_URL should be replaced by JDBC connection string 
jdbc:Oracle:thin:/@<TNS STRING>. For example, 
jdbc:oracle:thin:/@CONFIG

Note: If you use Oracle Wallet for database password configuration, see Creation 
of Oracle Wallet on OFSAA Server.

• The User-IDs for configuration/ atomic schemas have the prefix of setupinfo 
depending on the value set for PREFIX_SCHEMA_NAME in <<APP Pack>>_
SCHEMA_IN.XML file of Schema Creator Utility.

For example: if the value set for PREFIX_SCHEMA_NAME is DEV and the 
schema name was mentioned as ofsaaconf, then the actual schema created in the 
database would be DEV_ofsaaconf.
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Defining JDBC Connection Pooling
To define the JDBC connection pooling, do the following:

1. Copy $ORACLE_HOME/jdbc/lib/ojdbc<version>.jar to the path $TOMCAT_
DIRECTORY/lib/.

Note: Refer Appendix O section for identifying the correct 
ojdbc<version>.jar version to be copied.

2. Edit the server.xml present under the path $TOMCAT_DIRECTORY/conf/ with the below 
changes, which is required for connection pooling.

<Context path="/ $CONTEXTNAME$" docBase=" $APP_DEPLOYED_PATH$ " debug="0" 
reloadable="true" crossContext="true">

<Resource auth="Container"

name="jdbc/ $INFODOM_NAME$"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username=" $ATOMICSCHEMA_USERNAME$"

password="$ATOMICSCHEMA_PASSWORD$"

url="$JDBC_CONNECTION_URL"

maxActive="100"

maxIdle="30"

maxWait="10000"

removeAbandoned="true" removeAbandonedTimeout="60"
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logAbandoned="true"/>

</Context>

Note the following:

Note: 

• $APP_DEPLOYED_PATH$ should be replaced by OFSAAI application 
deployed path.

• $INFODOM_NAME$ should be replaced by Infodom Name.

• $ATOMICSCHEMA_USERNAME$ should be replaced by Atomic schema 
database user name.

• $ATOMICSCHEMA_PASSWORD$ should be replaced by Atomic schema 
database password.

• $JDBC_CONNECTION_URL should be replaced by JDBC connection string 
jdbc:Oracle:thin:<IP>:<PORT>:<SID>. For example, 
jdbc:oracle:thin 10.80.50.53:1521:soluint

• The User-IDs for configuration/ atomic schemas have the prefix of setupinfo 
depending on the value set for PREFIX_SCHEMA_NAME in <<APP Pack>>_
SCHEMA_IN.XML file of Schema Creator Utility. 
For example: if the value set for PREFIX_SCHEMA_NAME is DEV and the 
schema name was mentioned as ofsaaconf, then the actual schema created in the 
database would be DEV_ofsaaconf.

Configuring Class Loader for Apache Tomcat
1. Edit the server.xml available in $TOMCAT_HOME/conf/ folder.

2. Add tag <Loader delegate="true" /> within the <Context> tag, above the 
<Resource> tag. This is applicable only when the web application server is Apache Tomcat 
8.

Note: This configuration is required if Apache Tomcat version is 8.
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CCreating and Deploying EAR/ WAR File

This section covers the following topics:

• Creating EAR/WAR File

• Deploying EAR/WAR File

Creating EAR/WAR File
To create EAR/WAR File, follow these steps:

1. Navigate to the $FIC_WEB_HOME directory on the OFSAA Installed server.

2. Execute ./ant.sh to trigger the creation of EAR/ WAR file. 

3. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time taken" 
message is displayed and you will be returned to the prompt.

Figure C–1 Creating EAR/ WAR File

4. The EAR/ WAR file - <contextname>.ear/ .war - is created. 



Note: The <contextname> is the name given during installation. This 
process overwrites any existing version of EAR file that exists in the path.

In case of OFSAA configured on Tomcat installation, <contextname>.war is 
created.

ANT warning for tools.jar can be ignored while executing ./ant.sh
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Deploying EAR/WAR File
This section covers the following topics:

• Deploying EAR/WAR Files on WebSphere

• Deploying EAR/WAR files for WebLogic

• Deploying Tomcat WAR Files on Tomcat

Note: Ensure to clear the application cache prior to the deployment of 
Applications Pack Web Archive. This is applicable to all Web Servers 
(WebSphere, WebLogic, and Tomcat). For more information, refer to 
Clearing Application Cache section.

Deploying EAR/WAR Files on WebSphere
To deploy Infrastructure application in WebSphere:

1. Start WebSphere Profile by navigating to the path "/<Websphere_Installation_
Directory>/IBM/WebSphere/AppServer/profiles/<Profile_Name>/bin/" and 
execute the command:

 ./startServer.sh server1

2. Open the following URL in the browser: http://<ipaddress>:<Administrative 
Console Port>/ibm/console. (https if SSL is enabled). The login window is displayed. 
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Figure C–2 Login Window

3. Enter the user credentials which has administrator rights and click Log In.

4. From the LHS menu, select Applications and click New Application. The New 
Application window is displayed.

Figure C–3 New Application

5. Click New Enterprise Application. The Preparing for the application installation window 
is displayed. 
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Figure C–4 Preparing for the application installation

6. Select Remote File System and click Browse. Select the EAR file generated for OFSAAI 
to upload and install. Click Next. 

Figure C–5 Installation Options

7. Select the Fast Path option and click Next. The Install New Application window is 
displayed.
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Figure C–6 Install New Application

8. Enter the required information and click Next. The Map Modules to Servers window is 
displayed.

Figure C–7 Map Modules to Servers
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9.  Select the Web Application and click Next. The Map Resource References to Resources 
window is displayed.

Figure C–8 Map Resource References to Resources

10. Map each resource defined in the application to a resource JNDI name defined earlier.

11. Click Modify Resource Authentication Method and specify the authentication method 
created earlier.

You can specify "config" for FICMASTER resource or "atomic" for atomic resource as the 
authentication method.

12. Select the OFSAAI Web Application check box and click Next. The Map Virtual hosts 
for Web Modules window is displayed.

Figure C–9 Map Virtual host for Web Modules

13. Select the Web Application check box and click Next. The Summary window is 
displayed.
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Figure C–10 Summary

14. Click Finish and deploy the Infrastructure Application on WebSphere.

On successful installation, a message is displayed. 

15. Click Save and save the master file configuration. The details are displayed in the Master 
File Configuration window.

Starting the Application
To start the application, follow these steps:

1. Expand Applications > Application Type > WebSphere enterprise applications. The 
Enterprise Applications window is displayed.

Figure C–11 Enterprise Application
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2. Select the installed application and click Start.

Note: 

• <profile name> is the profile name given while creating the WebSphere 
profile. 

• <cell name > is the cell name given during profile creation.

•  <contextname> is the context name given during installation.

Exploding EAR File
To explode EAR, follow these steps:

1. Create the "applications" folder under domain name. For example, "/Bea/user_
projects/domains/ <Domain _name>/applications".

2. Create <context_name>.ear folder under "applications" folder. 

3. Copy the <$FIC_WEB_HOME/<context_name>.ear file to <WEBLOGIC_INSTALL_
DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_
name>.ear.

4. Explode the <context_name>.ear file by executing the command:

jar -xvf <context_name>.ear

5. Delete the <context>.ear and < context >.war files (recently created) <WEBLOGIC_
INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_
NAME>/applications/<context_name>.ear.

6. Create a directory <context_name>.war under <WEBLOGIC_INSTALL_DIR>/Bea/user_
projects/domains/<DOMAIN_NAME>/applications/<context_name>.ear.

7. Copy <$FIC_WEB_HOME/<context_name>.war file to <WEBLOGIC_INSTALL_
DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_
name>.ear/<context_name>.war.

8. Explode the <context_name>.war file by executing the following command to get the 
directory structure:

jar -xvf <context_name>.war

Deploying EAR/WAR files for WebLogic
Following are the steps for deploying Infrastructure application that would be created during 
installation:

1. Navigate to the path "<WebLogic Installation directory>/user_projects/domains/<domain 
name>/bin" in the machine in which WebLogic is installed.

2. Start WebLogic by executing the command: 

./startWebLogic.sh -d64 file

3. Open the URL in the browser window: http://<ipaddress>:<admin server port>/console. 
(https if SSL is enabled). The Sign in window of the WebLogic Server Administration 
Console is displayed.



Note: Ensure that you have started Infrastructure Server by executing 
"./startofsaai.sh" as mentioned in Starting Infrastructure Services section.
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4. Log on to the WebLogic Server by entering the user credentials having privileges to deploy 
the EAR file.

5. From the Domain Structure LHS menu, click Deployments. The Summary of 
Deployments window is displayed.

Figure C–12 Summary of Deployments

6. Click Install. The Install Application Assistant window is displayed.

7. Select the Exploded EAR directory after browsing to the directory where it is saved and 
click Next.

Installing Application
To install Application, follow these steps: 

1. Open the Install Application Assistant. 

Figure C–13 Install Application Assistant

2. Click Next. 
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Figure C–14 Install Application Assistant

3. From the Choose targeting style section, select the Install this deployment as an 
application option and click Next. 

The Optional Settings window is displayed.

Figure C–15 Optional Settings

4. Enter a Name for the deployment if required.

5. Under the Security section, select the DD only option to specify that only roles and 
policies that are defined in the deployment descriptors should be used.

6. Select the I will make the deployment available from the following location option 
under the Source accessibility section. 

7. Click Next to continue. 

The Deployment Summary window is displayed.
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Figure C–16 Deployment Summary

8. Select the Yes, take me to the deployment's configuration screen option and click 
Finish. 

The Settings for <Deployment Name> window is displayed.

Figure C–17 Settings for <Deployment Name>

9. Review the general configuration details of the deployment. You can also update the 
configuration of the deployment in this window. In the Overview tab, you can view the 
complete deployment configuration.
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10. Click Save to update the changes, if any.

11. From the LHS menu, click Deployments. 

The Summary of Deployments window is displayed.

Figure C–18 Summary of Deployments

12. Select the newly deployed Infrastructure application and click Start > Servicing all 
requests. Ensure that the Infrastructure server is up and running.

Figure C–19 Summary of Deployments

 

13. The State of the deployed application will be displayed as Active if started successfully.

Deploying Tomcat WAR Files on Tomcat
Before deploying the WAR files, ensure that the previously deployed applications of 
Infrastructure are uninstalled. See Uninstalling Previously Deployed WAR Files in Tomcat for 
the procedure to uninstall the previously deployed Infrastructure war files.

On the machine that hosts Tomcat, follow these steps to deploy Infrastructure application:

1. Copy the <context-name>.war from $FIC_WEB_HOME/<context-name.war> to 
<Tomcat Installation Directory>/webapps/ directory. 

2. Click Manager App. The Connect to dialog box is displayed.
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3. Enter the User Id and Password that has admin rights and click OK. (For user creation in 
tomcat, see Tomcat User Administration. The Tomcat Web Application Manager window 
is displayed with the list of all the applications deployed.

4. In the Deploy section, enter the Context Path provided during the installation as 
"/<context-name>".

5. Enter the path where the <context-name>.war file resides (by default "$FIC_WEB_
HOME/<context-name.war>") in the WAR or Directory URL field and click Deploy.

6. On successful application deployment, a confirmation message is displayed.

Start the Tomcat server. Refer Starting Infrastructure Services for more details.
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DStarting/ Stopping Infrastructure Services

This section details about how to start and stop Infrastructure services. This appendix covers 
the following topics:

• Starting Infrastructure Services

• Stopping Infrastructure Services

Starting Infrastructure Services
Once the installation of Infrastructure is completed successfully and the post-installation steps 
are completed, the servers must be started. Log on to each machine and run the .profile file. 
All servers mentioned must be started from the same shell encoding. The servers mentioned 
below are dependent on each other. It is mandatory to maintain the order in which the servers 
are started. Allow each of the servers to initialize completely before starting the next server.

1. On the machine in which Infrastructure Application components have been installed, 
navigate to $FIC_APP_HOME/common/FICServer/bin and execute the following 
command to start the Infrastructure Server.

./startofsaai.sh

Note: You can also start the Infrastructure Server by executing the 
command "nohup ./ startofsaai.sh &". Starting the process using "nohup" and 
"&" will return the command prompt without having to wait till the process 
completes. However, this command cannot be used when you are starting the 
server for the first time or starting after changing user password in the 
configuration database schema.You can also start the Infrastructure Server by 
executing the command "nohup ./ startofsaai.sh &". Starting the process using 
"nohup" and "&" will return the command prompt without having to wait till 
the process completes. However, this command cannot be used when you are 
starting the server for the first time or starting after changing user password 
in the configuration database schema.

2. Start ICC server:

? On the machine in which Infrastructure default Application components have been 
installed, navigate to $FIC_HOME/ficapp/icc/bin 

? Execute the command: 

./iccserver.sh



Note: Only Infrastructure Default Application Server would hold ICC 
component.
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3. Start Back-end Services:

? On the machine on which Infrastructure Database components have been installed, 
navigate to $FIC_DB_HOME/bin and execute the command to start "Agent server":

./agentstartup.sh 

Or

? Start Back-end services using the command:

nohup ./agentstartup.sh &

Note: NOTE: This agent internally starts the Router, Message Server, 
OLAP data server and AM services.

Starting Web Application Servers
Start the Web Application Server depending on the type from the following table.

Table D–1  Webserver start up options

Start up Option Description

Starting WebSphere profile On the machine in which Web sphere is installed, navigate to 
[Webshpere_Install_Directory] 
/AppServer/<profiles>/<profile name>/bin and execute the 
command: ./startServer.sh server1

Starting WebLogic Domain On the machine in which WebLogic is installed, navigate to 
<WebLogic Installation directory>/user_
projects/domains/<domain name>/bin and execute the command: 
startWebLogic.sh -d64

Note: If WebLogic is already running, access the WebLogic Admin 
Console. Stop and start the application <context name>.ear

Starting Tomcat Application On the machine in which Tomcat is installed, navigate to <Tomcat_
Install_ Directory>/bin and execute the command: 
./catalina.sh run

Stopping Infrastructure Services
To stop Infrastructure services, follow these steps:

1. On the machine in which Infrastructure Application components have been installed, 
navigate to $FIC_APP_HOME/common/FICServer/bin and execute the command:.

./stopofsaai.sh

2. To stop ICC server, on the machine in which Infrastructure default Application 
components have been installed, navigate to $FIC_HOME/ficapp/icc/bin and execute 
the command:

./iccservershutdown.sh



Note: Only Infrastructure Default Application Server would hold ICC 
component.
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3. To stop Back-end server, on the machine in which Infrastructure database components 
have been installed, navigate to $FIC_DB_HOME/bin and execute the command:

./agentshutdown.sh
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EAccessing OFSAA Application

This section gives details the steps to be performed to access OFSAA Application.

Access the OFSAA Application
1. From your desktop, open the browser and enter the URL in below format: 

<scheme>://<IP address/ hostname>:<port>/<context-name>/login.jsp

For example, https://111.222.333.444:5555/ofsaa/login.jsp

The OFSAA login window is displayed.

Figure E–1 OFSAA Login Window

2. With installation of every OFSAA Application Pack, there are two seeded user profiles 
configured in the system: 

"SYSADMN - System Administrator

"SYSAUTH - System Authorizer



Note: For SYSADMN and SYSAUTH, the default password is 
"password0".
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3.  Login to the application using the "SYSADMN" User ID. (Note that, there is no "I" in the 
SYSADMN login USER ID). Enter the default password "password0". On the first login, 
you will be prompted to change the password.
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FPost Deployment Configurations

This section provides detailed information about the Post Deployment Configurations.

Post Deployment Configurations
This section lists the various configurations to be completed before you use the OFSAA 
Applications.

• Logging as System Administrator

• Creating Application Users

• Mapping Application User(s) to User Group

Logging as System Administrator
Post installation, the first login into Infrastructure is possible only for a System Administrator 
through user ID "sysadmn". This ID is created at the time of installation with the password 
provided during installation. Enter login id "sysadmn" and password that was provided during 
installation. Click Login. 

Creating Application Users
Create the application users in the OFSAA setup prior to use. 

Note: This step may not be required if you have already setup users in the 
OFSAA setup.

For more information, see user creation section from the Oracle Financial 
Services Analytical Applications Infrastructure User Guide.

Mapping Application User(s) to User Group
Starting the OFSAA 8.0 release, with installation of every OFSAA Application Pack, 
pre-configured application user groups are seeded. These user groups are unique to every 
OFSAA Application Pack and have application roles pre-configured.

User Groups seeded with the OFS IFRS Application Pack are listed in Table F–1, "Seeded User 
Groups".

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm


Table F–1 Seeded User Groups

Name Description

Modeler Group User mapped to this group has access to all the menu items for 
Enterprise modeling but does not have authorization rights for sandbox 
population, model deployment and modeling technique authorization.

Modeling Administrator 
Group

User mapped to this group has access to all the menu items for 
Enterprise modeling and has authorization rights for sandbox 
population, model deployment and modeling technique authorization.

Inline Processing Admin 
Group

User mapped to this group has access to all the menu items and actions 
for Inline Processing module.

Business Administrator User mapped to this group has access to all the menu items and actions 
for advanced operations of metadata objects.

Business Authorizer User mapped to this group has access to all the menu items and actions 
for authorization of changes to metadata objects.

Business Owner User mapped to this group has access to all the menu items and actions 
for read and write of metadata objects

Business User User mapped to this group has access to all the menu items and actions 
for access and read of metadata objects.

Identity Administrator User mapped to this group has access to all the menu items for 
managing User entitlements, User Group Entitlements and Access 
Management configurations.

Identity Authorizer User mapped to this group has access to all the menu items for 
authorizing User entitlements, User Group Entitlements and Access 
Management configurations.

System Administrator User mapped to this group has access to all menu items for managing 
the setup configurations.

Object Administrator User mapped to this group has access to all menu items for managing 
object migration and metadata traceability using metadata browser.

Guest Group User mapped to this group has access to certain menu items with only 
access privileges.

LLFP Admin User mapped to this group has access to all the modules in OFS LLFP 
application.

HM Admin User mapped to this group has access to all the modules in OFS HM 
application.

LLFP Analyst User mapped to this group has limited access in OFS LLFP 
application. This user cannot perform user creation and authorization.

HM Analyst User mapped to this group has limited access in OFS HM application. 
This user cannot perform user creation and authorization.

HM Auditor User mapped to this group has only View access to OFS HM modules.
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Map the application user(s) to the respective Application User Group(s) and subsequently 
authorize the entitlements by logging in as SYSAUTH (System Authorizer) user.

For more information, see Mapping/Unmapping Users section from the Oracle Financial 
Services Analytical Applications Infrastructure User Guide.

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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GCloning OFSAA Instance

There is a consistent need for a faster and effective approach of replicating an existing OFSAA 
instance for further project developments, that is, setting up OFSAA instances that are exact 
copies of the current OFSAA instance. For more information on cloning, see OFSAA Cloning 
Reference Guide.

http://docs.oracle.com/cd/E61555_01/books/OFSAA_Cloning_Reference_Guide_8.0.pdf
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HOFSAA Landing Window

This section includes the following topics:

• Installation Checklist

• OFSAA Landing Window

• Enabling a Product within an Application Pack

Installation Checklist
Before starting on the OFSAAI Installation Kit, ensure that the following pre-installation 
activities checklist is completed successfully. It is recommended to take a print out of the 
checklist and follow the checklist step by step.

Table H–1 

Step No. Task Done

General

1 Check the OFS IFRS Release 
Notes and Read Me document 
for any additional steps to be 
performed on OFS IFRS or 
OFSAAI.

Note: For more details, contact 
Oracle support.

International Financial Reporting Standards Application Pack Pre Installation + During 
Installation

1 Prior to installation, ensure that 
sufficient free temp space 
(minimum 1 GB free) is 
available in /tmp directory of 
unix server hosting OFSAAI.

International Financial Reporting Standards Application Pack Post Installation

1 Perform post-installation steps. 
For more information, refer to 
Post Installation

OFSAA Landing Window
On successful authentication, the OFSAA Landing window is displayed. This is a common 
landing window for all users until a preferred application landing window is set by the user in 
his preferences.
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The landing window includes multiple tabs and each tab has specific links to OFSAA 
Infrastructure and/or Application modules. The tabs and links are displayed based on the 
OFSAA Application accessed and the access roles mapped to the logged in user.

Each tab contains LHS Menu and RHS Menu. The LHS Menu holds link(s) to modules in a 
tree structure. The RHS Menu holds link(s) to modules in a navigational panel format.

The following tabs are available in the Landing window:

• Applications Tab

• Sandbox Tab

• Object Administration Tab

• System Configuration and Identity Management Tab

Applications Tab
This tab lists the various OFSAA Applications that are installed in the setup.

The "<Select Application>" drop down lists the OFSAA Applications based on the user logged 
in and User Group(s) mapped to OFSAA Application. Selecting an Application from the drop 
down refreshes the menus/ links.

Sandbox Tab
This tab lists the various OFSAA Sandboxes created in the setup.

The "<Select Sandbox>" drop down lists the OFSAA Sandboxes based on the user logged in 
and User Group(s) mapped to OFSAA Application.

Selecting a Sandbox from the drop down would refresh the menus/ links.

Object Administration Tab
This tab lists the various OFSAA Information Domains created in the setup. 

The "<Select Information Domain>" drop down lists the OFSAA Information Domains based 
on the user logged in and User Group(s) mapped to OFSAA Application.

Selecting an Information Domain from the drop down refreshes the menus/ links.

System Configuration and Identity Management Tab
This tab lists the OFSAA Infrastructure System Configuration and Identity Management 
modules. These modules work across Applications/ Information Domains and hence there are 
no Application/ Information Domain drop down list in this tab.

Note: Refer the User Manual for more details on how to operate on each 
tab.

Enabling a Product within an Application Pack
You can also enable a product/ application within an application pack post installation at any 
point of time. 

To enable a product through the application UI, follow these steps:

1. Login to the application as SYSADMN user or any user with System Administrator 
privileges.
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2. Navigate to System Configurations & Identity Management tab, expand Administration 
and Configuration, and select System Configuration.

3. Click Manage OFSAA Product License(s). The Manage OFSAA Product License(s) 
window is displayed.

Figure H–1 Manage OFSAA Product License(s) window

4. Select an Application Pack to view the products in it. The products are displayed in the 
Products in the Application Pack grid.

5. Select the check box to enable a product within the application pack which is not enabled 
during installation.

6. Click VIEW LICENSE AGREEMENT to view the license information. The License 
Agreement section is displayed.

7. Select the option I ACCEPT THE LICENSE AGREEMENT and click ENABLE.

A pop-up message confirmation is displayed showing that the product is enabled for the 
pack.

Note: To use the newly enabled product, you need to map your application 
users to the appropriate product specific User_Group(s) and subsequently, 
authorize the actions by logging in as System Authorizer.

For more information, see Mapping/Unmapping Users section in the Oracle 
Financial Services Analytical Applications Infrastructure User Guide. 

To identify the newly enabled product specific UserGroups/ Application Pack 
specific User_Groups, refer to the respective Application Pack specific 
Installation and Configuration Guide/ User Manual.

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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IAdditional Configuration

This section gives detailed information about the Additional Configuration regarding OFSAA 
Installation.

Additional Configuration Topics
This section covers the following topics:

• Configuring FTP/SFTP

• Configure Infrastructure Server Memory

• Configuring Internet Explorer Settings

• Setting OLAP Data Server Configuration

• Changing IP/ Hostname, Ports, and Deployed Paths of OFSAA Instance

• Executing OFSAAI Setup Information Fetching Tool

• Executing Encryption Changer

• Setting Infrastructure LDAP Configuration

• Configuring Message Details in Forms Designer

• Clearing Application Cache

• Configuring Password Changes

• Configure Internal Service (Document Upload/Download)

• Configurations to Deploy the LLFPBI Application

Configuring FTP/SFTP
This section details about the configurations required for FTP/SFTP.

Adding FTP/SFTP Configuration for File Transfer
In OFSAA, certain modules require transfer of files from the web application server to the 
OFSAA server over SSH.   

Follow these steps to ensure the OFSAA server recognizes the web application server during 
file transfers.

1. Log in to the web application server.

2. Type sftp <user>@<OFSAA Server>.

3. Specify Yes when prompted for permission. 
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Are you sure you want to continue connecting (Yes/No)? 

 This will add an entry into the "known_hosts" file.

4. A confirmation message is displayed: 

Permanently added <OFSAA Server> RSA) to the list of known hosts.

Setting Up SFTP Private Key
Log in to OFSAA Unix user using Putty tool, where you plan for installation and generate a 
pair of authentication keys using the ssh-keygen command. If required, set passphrase. 
Otherwise OFSAAI_SFTP_PASSPHRASE tag in the OFSAAI_InstallConfig.xml file 
should be set to NA.

To generate private key, enter the commands as shown:

ofsaapp@OFSASERVER:~> ssh-keygen -t rsa
Generating public/private rsa key pair.
Enter file in which to save the key (/home/ofsaapp/.ssh/id_rsa): 
Created directory '/home/ofsaapp/.ssh'.
Enter passphrase (empty for no passphrase): 
Enter same passphrase again: 
Your identification has been saved in /home/ofsaapp/.ssh/id_rsa.
Your public key has been saved in /home/ofsaapp/.ssh/id_rsa.pub.
The key fingerprint is:
3e:4f:05:79:3a:9f:96:7c:3b:ad:e9:58:37:bc:37:e4 

ofsaapp@OFSASERVER:~> cat /home/ofsaapp/.ssh/id_rsa.pub >> /home/ofsaapp/.ssh/authorized_keys

In case, you are generating SFTP Private key for Hive server, append the content of  
/home/ofsaapp/.ssh/id_rsa.pub  to Hiveserver authorized_keys file located at  $HOME_
DIR_HIVE/.ssh folder.

Ensure the following permissions exist for the given folders:

• Permission of .ssh should be 700

• Permission of .ssh/authorized_keys should be 640

• Permission  of .ssh/id_rsa should be 400

• Permission  of Unix user created should be 755

Configure Infrastructure Server Memory
The memory settings for Infrastructure Application Server, Tomcat, WebSphere, and WebLogic 
can be edited for customizing memory settings and garbage collector settings depending on the 
available hardware configuration as explained below. These settings are base minimum and has 
to be incremented considering the deployment metrics into account. The increments are usually 
handled in multiples of 128 MB for heap and 64 MB for stack.

Configuring Infrastructure Application Server Memory Settings
You can configure the Infrastructure Application Memory settings as follows:

1. Locate .profile file.

2. Edit X_ARGS field in this file for customizing memory settings and garbage collector 
settings depends on the hardware configuration.

This has a default value X_ARGS="-Xms200m"

X_ARGS=" "$X_ARGS" $DELIM -Xmx2048m"



Note: Modify X_ARGS_APP variable in the .profile file to customize 
Java Memory Settings for Model Upload based on the Data Model size.

For Run and Rule executions, the following value is recommended: 

X_ARGS_RNEXE="-Xms1g -Xmx1g -XX:+UseAdaptiveSizePolicy 
-XX:MaxPermSize=512M -XX:+UseParallelOldGC 
-XX:+DisableExplicitGC" 

X_ARGS_RLEXE="-Xms1g -Xmx1g -XX:+UseAdaptiveSizePolicy 
-XX:MaxPermSize=512M -XX:+UseParallelOldGC 
-XX:+DisableExplicitGC"
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Configuring Internet Explorer Settings

Note: OFSAAI supports only default zoom setting in Internet Explorer, that 
is, 100%.
Cookies should be enabled.

The following browser settings must have specified at every client machine prior to accessing 
the Infrastructure application.

1. Open Internet Explorer. Select Tools > Internet Options. The Internet Options window 
is displayed.

2. Click Settings. The Settings window is displayed.

3. Select Everytime I Visit the webpage option and click OK.
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Figure I–1 Internet Options - Website Data Settings

4. In the Internet Options window, select the Security tab and select the Internet option 
under Select a zone to view or change the security settings.

5. Click Default Level under Security level for this zone.
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Figure I–2 internet Options - Security

6. Click OK to save.

7. Click Internet Explorer >> Tools >> Compatibility View Settings.

8. Enter the OFSAA setup URL in the Add this website field.

9. Click Add.

10. Ensure the URL is listed under Websites you've added to Compatibility View.

11. In the Internet Options window, select the Privacy tab and select the Turn on Pop-up 
Blocker option under Pop-up Blocker settings.
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12. Click Settings. The Pop-up Blocker Settings window is displayed.

13. Enter the URL of the OFSAA Application in the Address of Website to Allow: field.

14. Click Add. The OFSAA URL is displayed in the Allowed Sites section.

15. Click Close.

16. Click OK in the Internet Options window.

Retrieve Patch Information
To identify the list of patches installed on your OFSAA setup, follow these steps:

1. Login to the OFSAA application as a user with Object AdminAdvanced Role.

2. Navigate to Object Administration tab.

3. Click System Utilities.

4. Click Patch Information.

5. The window displays the list of patches installed on the OFSAA setup across 
Applications/Platform.

Setting OLAP Data Server Configuration
This section is applicable if you are using the OLAP feature of OFSAAI.

The following parameters must be set to ensure that the system limitations are not exceeded at 
any stage. The values for these OS parameters should be specified based on the expected load 
at each implementation site.

For example:

Process Memory Limit

Max Thread Stack Size
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Max Number of Threads per Process

• Sort Buffer settings: This must be set at the Essbase application level appropriate to the 
anticipated load.

• Shutdown and Restart: During shutdown of OFSAAI Server that has an instance of Data 
Services that is communicating with an OLAP Data Server, it is imperative to ensure that 
the cleanup of the old instance is completed on the OLAP Data Server before restarting the 
OFSAAI Server. Pause for a period of time based on the load the system was subjected to, 
before restarting the Data Services subsystem.

Changing IP/ Hostname, Ports, and Deployed Paths of OFSAA Instance
For information on this section, see OFS Analytical Applications Infrastructure Administration 
User Guide in OHC Documentation Library.

Executing OFSAAI Setup Information Fetching Tool
Executing the SetupInfo.jar file available in the FIC_HOME path will help you retrieve the 
related information about the OFSAAI Set up such as Operating System Name and Version, 
Database Type and Version, OFSAAI architecture, Log file locations and so on.

To execute "SetupInfo.jar" in console, follow these steps:

1. Navigate to the path $FIC_HOME.

2. Enter the command:

java -jar SetupInfo.jar

After execution, the output file location is displayed in the console.

Executing Encryption Changer
For more information on Encryption Changer, see Key Management section in OFSAAI 
Administration Guide.

Setting Infrastructure LDAP Configuration
For more information on LDAP configuration, see OFSAAI Administration Guide.

Enabling Parallel Execution of DML statements
A configuration file, OracleDB.conf has been introduced to accommodate any configurable 
parameter related to operations on oracle database. If you do not want to set a parameter to a 
specific value, then the respective parameter entry can be removed/commented off form the 
OracleDB.conf file which resides in the path $FIC_DB_HOME/conf.

As of now, the OracleDB.conf file has only one parameter namely CNF_DEGREE_OF_
PARALLELISM. This parameter indicates the degree of parallelism to be used for a DML 
operation if parallel DML is explicitly enabled in the session with the ENABLE PARALLEL 
DML clause of the ALTER SESSION statement. The default mode of a session is DISABLE 
PARALLEL DML. If CNF_DEGREE_OF_PARALLELISM is not set, then the default degree, 
as decided by Oracle will be used.

Configuring Message Details in Forms Designer
You can configure the Message Details in Forms Designer under Data Entry Forms and Queries 
module by updating the details of mail server in the "NotificationConfig.cfg" file which 
resides in the path $FIC_APP_HOME/common/FICServer/conf.


http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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Ensure that the "authorized User details" for whom you need to configure the Message details 
are included in Administration > Security Management > User Administrator > User 
Maintenance window.

Update the following parameters in the "NotificationConfig.cfg" file:

Table I–1  NotificationConfig.cfg File

Parameter Description

SMTP_SERVER_IP Specify the hostname or IP address of SMTP Server.

SMTP_DEBUG_MODE To run SMTP service in Debug mode, set value to 'true', 
otherwise set value to 'false'.

SMTP_AUTHORIZATION Set to 'true' if SMTP server requires the client to be 
authenticated, otherwise set to 'false'.

SMTP_USERNAME Username required for logging into SMTP server, if 
authentication is not required use a dummy value.

SMTP_PASSWORD Password required for logging into SMTP server, if 
authentication is not required use a dummy value.

SMTP_MAILID If the Messages has to go from a Particular ID that ID 
need to be added. Exchange server forces you set a valid 
ID that is there in the exchange server. (Based on 
Security settings)

Ensure that the authorized User details are included in Administration > Security Management 
> User Administrator > User Maintenance window.

Clearing Application Cache
This is applicable to all Web Servers (that is, WebSphere, WebLogic, and Tomcat). 

Prior to the deployment of Infrastructure or Application Service Packs / One-off patches, clear 
the cache. Navigate to the following path depending on the WebServer configured and delete 
the files:

• WebLogic: <Weblogic installation location>/domains/<Domain 
name>/servers/<Server name>/tmp/_WL_user/<Application name>/qaelce/jsp_
servlet

• Tomcat: <Tomcat installation 
folder>/work/Catalina/localhost/<Application name>/org/apache/jsp

• WebSphere: <Websphere installation 
directory>/AppServer/profiles/<Profile name>/temp/<Node 
name>/server1/<Application name>/<.war file name>

Configuring Password Changes
This section explains about how to modify the OFSAA Infrastructure Config Schema and 
Atomic Schema passwords.

Modifying OFSAA Infrastructure Config Schema Password
To change the Config Schema password, perform the following steps:

1. Change the Config schema User Password in the database.

2. .

3. Shutdown the OFSAAI App service:
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cd $FIC_APP_HOME/common/FICServer/bin

./stopofsaai.sh

4. Start the Infrastructure Server in foreground directly on the server or through X-Windows 
software using the command:

./startofsaai.sh

5. At the prompt, enter System Password. Enter the "new Config schema" password. The 
service will start and initialize itself if it is able to successfully connect to the DB.

6. Post successful startup of the service, if required, the Infrastructure server may be shut 
down and restarted in the background using nohup mode.

Modifying OFSAA Infrastructure Atomic Schema Password
To change the Atomic Schema password, perform the following steps:

1. Change the Atomic schema User Password in the database.

2. Login to the application from the browser using SYSADMN account or any user id, which 
has System Administrator role mapped.

3. Navigate to System Configuration > Database Details window. Modify the password as 
explained in the following steps:

a. From the Database Master window, select the connection whose password you want 
to modify and click  button from the toolbar.

b. Click  button corresponding to the Alias Name. The Alias Details window is 
displayed. 

c. Modify the password in the Auth String field.

4. If you are using Apache Tomcat as Web server, update the <Context> -> Resource tag 
details in Server.xml file from the $CATALINA_HOME/conf folder. (In case of Tomcat 
only Atomic <Resource> will exist).

If you are using WebSphere as Web server:

a. Login to the WebSphere Administration Console, from the left side menu.

b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated 
on the right side. 

c. Select the appropriate Data Source and edit the connection details. (In this case, both 
Config and Atomic data sources will need to be modified).

If you are using WebLogic as Web server:

a. Login to the WebLogic Administration Console, from the left side menu

b. Under Domain Structure list box, expand the appropriate Domain and navigate to 
Services > JDBC >Data Sources. A list of data sources will be populated on the right 
side. 

c. Select the appropriate Data Source and edit the connection details. (In this case, both 
Config and Atomic data sources need to be modified).

5. Restart the OFSAAI services.

Configuring Java Virtual Machine
While running several database intensive tasks in parallel, fetching the database connection 
from connection pool may face an error. To ensure no such error is 
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encountered, add the line securerandom.source=file:/dev/./urandom in the java.security 
configuration file available in $JAVA_HOME/jre/lib/security/ path.

This needs to be configured on all the machines or virtual machines where the 

OFSAAI database components (ficdb layer) are installed.

Configure Internal Service (Document Upload/Download)
This step can be ignored if it has already been configured as part of any previous IR /ML 
installation.

The Document Upload /Download feature has undergone a change and can now be configured 
to use Internal service for document upload / download instead of the earlier ExeWebService.

To facilitate Internal service for document upload/ download, perform the following 
configurations:

1. Create the folders download, upload, TempDocument and Temp in the local path of Web 
application server and provide Read/Write permission.

• To find the exact location, execute the following query in CONFIG schema:

select localpath from web_server_info

• To create folders with Read/Write permission, execute the command:

mkdir -m 777 download upload TempDocument Temp

2. Create DocStorage folder in the FTPSHARE location of APP tier and provide Read/Write 
permission.

• To find the exact location, execute the query in CONFIG schema:

select ftpdrive from app_server_info

• To create folder with Read/Write permission, execute the command:

mkdir -m 777 DocStorage

By default, the parameter DOCUMENT_SERVICE_TYPE_EXTERNAL value is set to FALSE 
in the Configuration table in CONFIG schema and hence the application “ExeWebService” will 
not be used. It is recommended that the value to be set to FALSE and use the Internal service 
for document upload/ downloads. If you intend to continue using the External ExeWebService, 
set the value to TRUE.

Navigate to $FIC_HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier 
and type ./ant.sh. This triggers the creation of EAR/WAR file EXEWebService.ear/.war. The 
EAR/WAR file EXEWebService.ear/.war will be created in $FIC_
HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier. Redeploy the 
generated EAR/WAR file onto your configured web application server.

Configurations to Deploy the LLFPBI Application
The following are the steps to configure the LLFPBI Analytics: 

Before you begin this process, ensure that Oracle Business Intelligence (versions 11.1.1.9.5 and 
12.2.1.2.0) installation is completed and is available.

Steps to Start the LLFPBI Analytics for OBIEE v11.1.1.9.5
1. Set the <Oracle BI Instance Home> directory.

For example: /u01/OBIEE11G/instances/instance1
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2. Start WebLogic AdminServer. 

1. Set the <BI Domain Home> directory

For Example: /u01/OBIEE11G/user_projects/domains/bifoundation_domain

2. Navigate to <BI Domain Home >/bin and execute the following command:

nohup ./startWebLogic.sh &

Note: Bringing up this service may take a few minutes depending on your 
environment. Check the logs using the command:

tail -f nohup.out

3. Start Node Manager. 

1. Set the < WebLogic Server Home> directory. 

For example: /u01/OBIEE11G/wlserver_10.3

2. Navigate to <WebLogic Server Home>/server/bin and execute the following 
command:

nohup ./startNodeManager.sh &

4. Start WebLogic Managed Server (bi_server1). 

1. Login onto http://localhost:7001/console using your Administrator credentials created 
during platform install (Replace the hostname based on your setup). 

2. Under Environment tab, click Servers link.

 

The bi_server1 displays the shutdown state at this point.

3. Click Control tab.

4. Select the bi_server1 line by clicking on the left tick box. 
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5. Click Start button at the top of the list and confirm starting this service.

6. State will update to "RUNNING" mode after a few minutes.

5. Start OBIEE services and login.

1. Starting services From EM screen:

6. Deploy RPD and webcatalog file(s). 

7. Configure tnsnames.ora file. 

1. Open tnsnames.ora file under the folder - <Oracle Home>/network/admin. 

2. Make sure that an entry is made in the tnsnames.ora to connect to atomic schema of 
OFSAA application.

3. Save the tnsnames.ora file. 

8. Configure ODBC data source to connect to Oracle BI Server. 

1. Navigate to Control Panel>Administrative Tools>Data Sources (ODBC). 

2. Select the System DSN tab and click Add button. 

3. Select a driver specific to (Oracle BI Server 11g) and click Finish button. 

4. Enter Name and Server details (specify the Host Name or IP Address of the BI Server) 
and click Next. 

5. Enter Oracle BI Server login id and password (Enter User Name and Password created 
at the time of OBIEE installation). Click Next. 

6. Click Finish. 

9. Modify connection pool and set the properties. 

1. Open the OBI Administration tool. 

2. Select Start > Programs > Oracle Business Intelligence > BI Administration.

3. Select File > Open > Online and select LLFP.rpd file.

4. In the Open dialog box, select and open LLFP.rpd file.

5. Enter Repository password as 'Admin123'. 

6. In the Physical layer, double-click the Connect Pool. The properties of Connection 
Pool LLFP is displayed.

7. In the General tab, edit / check the following entries: 

Call Interface: (OCI 10g/11g). 

Data source name: <tnsnames.ora entry created in the step 8.b connecting to OFSAA 
atomic schema>. 

User name: <enter atomic db user name>. 



Additional Configuration Topics

                      Additional Configuration I-89

Password: <enter atomic db user password>. 

Confirm password and Click OK to close the window. 

Similarly, configure the connection pools for 'LLFPBI'.

Note: Repeat similar steps from (g) above for connection pool 'Connection 
Pool MR' under Database 'Market Risk'.

Click Save to save the RPD file. 

Click No for the Global Consistency Message. 

Close the RPD file (File / Exit). 

10. Login into LLFPBI Application using the URL: http://localhost:<port 
number>/analytics.(Replace the port number based on your setup).

Steps to Start the LLFPBI Analytics for OBIEE v12.2.1.2.0
1. Set the <BI Domain Home> directory

For Example: /u01/OBIEE11G/user_projects/domains/bifoundation_domain

2. Navigate to <BI Domain Home>/bitools/bin and execute the following command:

./Start.sh

3. Navigate to <BI Domain Home>/bitools/bin and execute the following command to check 
the status of the services:

./status.sh

Starting Services from EM Screen (For OBIEE v11.1.1.9.5 or 
v12.2.1.2.0)
1. Login to the EM administration screen using the URL: http://localhost:7001/em

(Replace the hostname and port number based on your setup).

Use the login you created in OBIEE installation to log in. 

2. Expand 'Business Intelligence' node on the left and choose Coreapplication. 

 

3. Click Overview Tab.

4. Click Restart (or Start) under the Manage System section. 
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5. Click Yes on dialog box to confirm the action. Wait for message that confirms successful 
restart.

 

6. If the start process using EM is not successful and returning an error about OPMNCTL not 
up, follow starting process with OPMNCTL. 

1. Open a command prompt, navigate to <Oracle BI Instance Home>/bin. 

2. Execute the command ./opmnctl status. This displays the status of all the OBIEE core 
services.

3. Execute the command ./opmnctl startall or ./opmnctl stopall depending on your 
requirement.

Deploy RPD File (For OBIEE v11.1.1.9.5)
1. Navigate to folder $FIC_HOME/LLFP_DASHBOARDS/ which contains LLFP.rpd file 

and $FIC_HOME/LLFP_DASHBOARDS/ which contains LLFP.catalog file.

2. Login to OBIEE - Enterprise Manager URL (http://<ip address>:<port>/em). 

3. Click on coreapplication from Business Intelligence tab on left hand side. 

4. Under coreapplication, select the Deployment tab and click Lock and Edit Configuration 
button. The following screen is displayed:

5. Select Browse button available under Upload BI Server Repository section and select 
LLFP.rpd file from the local folder. Enter the Repository password Admin123.
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Deploy RPD File (for OBIEE v12.2.1.2.0)
1. Navigate to folder $FIC_HOME/LLFP_DASHBOARDS/ which contains IFRS_

12.2.1.2.0.rpd file and save the file to a local folder.

2. Copy the IFRS_12.2.1.2.0.rpd file from the local folder to the folder <BI Domain 
Home>/bitools/bin folder.

3. Execute the following command in the same directory as in the preceding step:

./datamodel.sh uploadrpd -I   <RPD_FILE_NAME.rpd> -SI ssi -U <WEBLOGIC_
USERNAME> 

-P < WEBLOGIC_PASSWORD>

For example: 

./datamodel.sh uploadrpd -I   IFRS_12.2.1.2.0.rpd -SI ssi -U weblogic -P weblogic123

4. Login to OBIEE - Enterprise Manager URL - (http://<ip address>:<port>/em).

5. Expand Business Intelligence node on the left and choose Coreapplication.

6. Select Deployment tab and click Lock and Edit configuration button. The following 
screen is displayed:

7. Select Browse button available under Upload BI Server Repository section and select 
IFRS_12.2.1.2.0.rpd file from the local folder.

Web Catalog Deployment (for v11.1.1.9.5)
1. Create a new web catalog folder for LLFPBI application through Enterprise Manager of 

OBIEE.

2. Set the Catalog Location available under BI Presentation Catalog as follows:

$ORACLE_
INSTANCE/bifoundation/OracleBIPresentationServicesComponent/$COMPONENT_
NAME/catalog/LLFPBI

3. Click Apply and then click Activate changes. A pop up is displayed after successful 
activation.

4. Click Close button and switch to Capacity management tab.

5. Restart the Presentation services. Under the System Components Availability, select 
Presentation Services and click on Restart Selected option.

Once the Presentation Service is restarted, it displays the pop up notifying the successful 
restart.
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6. Click Close button.

7. Verify that new folder structure is created in the system.

It can be found under the following folder:

<Oracle BI Instance 
Home>\bifoundation\OracleBIPresentationServicesComponent\coreapplication_
obips1\catalog\LLFPBI

Catalog File Deployment (for OBIEE v11.1.1.9.5 and 12.2.1.2.0)
1. Open the Catalog Manager from OBIEE client. Navigate to File menu and open the 

catalog online (File->Open catalog) by giving the necessary credentials based on the setup 
(Type - (online), URL - (http://<ipaddress>:<port>/analytics/saw.dll).

2. Once the catalog is opened, it displays a folder structure on left hand side. Select the shared 
folder in the LHS tree structure.

3. Go to File menu and select Unarchive. It asks for the path for a file.

4. Browse the path of the archived catalog file saved in the local folder using the Browse 
button in the pop up.

5. Click OK.

6. The catalog is unarchived in specified location. A pop up confirming the successful 
operation is displayed.

7. Restart the presentation services again.

8. Open the analytics OBIEE URL- (http://<ipaddress>:<port>/analytics) and login with 
credentials based on the setup. Verify the availability of the catalog.

Configure tnsnames.ora file (for OBIEE v11.1.1.9.5 and 12.2.1.2.0)
1. Open tnsnames.ora file present under the folder  <Oracle Home>/network/admin.

2. An entry should be made in the tnsnames.ora to connect to atomic schema of OFSAA 
application.

3. Save the tnsnames.ora file.

Configure ODBC Data Source to Connect to Oracle BI Server (for 
OBIEE v11.1.1.9.5 and 12.2.1.2.0)
1. From your local machine, navigate to Control Panel>Administrative Tools>Data Sources 

(ODBC).

2. Select the System DSN tab and click Add button.

3. Select a driver specific to (Oracle BI Server 11g) and click Finish button.

4. Enter Name and Server details (specify the Host Name or IP Address of the BI Server) and 
click Next.

5. Enter Oracle BI Server login ID and password (enter the User Name and Password created 
at the time of OBIEE installation).

6. Click Next.

7. Click Finish.
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Modify Connection Pool and Set the Properties (for OBIEE v11.1.1.9.5 
and 12.2.1.2.0)
1. Open the OBI Administration tool.

2. Navigate to Start > Programs > Oracle Business Intelligence > BI Administration.

3. Select File > Open > Online and select LLFP.rpd/ IFRS_12.2.1.2.0.rpd file.

4. In the Open dialog box, select and open LLFP.rpd/IFRS_12.2.1.2.0.rpd file.

5. Enter the Repository password as Admin123.

6. In the Physical layer, double-click the Connect Pool.

The properties of Connection Pool LLFP is displayed.

7. In the General tab, edit and check the following entries:

• Call Interface: (OCI 10g/11g)

• Data source name: <tnsnames.ora entry created in the step 8.b connecting to OFSAA 
atomic schema>

• User name: <enter atomic db user name>

• Password: <enter atomic db user password>

8. Confirm password and Click OK to close the window.

Note: Similarly, configure the connection pools for LLFPBI.

9. Click Save to save the RPD file.

10. Close the RPD file (File/Exit).

11. Login into LLFPBI Application using the following URL: 
http://localhost:<portnumber>/analytics.

Replace the port number based on the setup.

12. Navigate to Administration link and click Reload Files and Metadata in order to load 
the metadata in the reports and clear the cache.

13. Navigate to Manage Sessions and click Close All Cursors to clear cursor cache.
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JPatching OFSAA Infrastructure Installation

Patching Your OFSAA Infrastructure Installation
Oracle strongly recommends installing the latest available patch set so as to be up to date with 
the various releases of the OFSAA product.

Refer http://support.oracle.com for more information on latest release.

http://support.oracle.com/
http://support.oracle.com/
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KGrants for Atomic/ Config Schema

This section mentions about the various grants required for the CONFIG and ATOMIC 
schemas.

This section discusses the following sections:

• Configuring Grants for Atomic Schema

• Configuring Grants for Config Schema

• Configuring Grants for Config Schema Entities for Atomic Users

Configuring Grants for Atomic Schema
Atomic Schema creation requires certain grants for object creation. This can be located in 
$FIC_HOME/privileges_atomic_user.sql file. 

The following are the Grants for Atomic Schema:

grant create SESSION to &database_username

/

grant create PROCEDURE to &database_username

/

grant create SEQUENCE to &database_username

/

grant create TABLE to &database_username

/

grant create TRIGGER to &database_username

/

grant create VIEW to &database_username

/

grant create MATERIALIZED VIEW to &database_username

/

grant select on SYS.V_$PARAMETER to &database_username

/

grant create SYNONYM to &database_username

/



Note: If you intend to use Oracle OLAP feature, execute the below grant 
on all ATOMIC schema(s) grant olap_user to &database_username

Configuring Grants for Config Schema
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Configuring Grants for Config Schema
Config Schema creation requires certain grants for object creation. This can be located in 
$FIC_HOME/privileges_config_user.sql file.

The following are the Grants for Config Schema:

grant create SESSION to &database_username

/

grant create PROCEDURE to &database_username

/

grant create SEQUENCE to &database_username

/

grant create TABLE to &database_username

/

grant create TRIGGER to &database_username

/

grant create VIEW to &database_username

/

grant create MATERIALIZED VIEW to &database_username

/

grant select on SYS.V_$PARAMETER to &database_username

/

grant create SYNONYM to &database_username

/

Configuring Grants for Config Schema Entities for Atomic 
Users

Atomic Schema creation requires certain grants for config schema object access. This can be 
located in $FIC_HOME/config_table_privileges_for_atomic_user.sql file. 
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LConfiguring Application Pack XML Files

This section explains configuration of OFS_IFRS_PACK.xml and OFS_ IFRS_SCHEMA_
IN.xml files. 

This section includes the following topics:

• Configuring OFS_IFRS_PACK.xml File

• Configuring OFS_IFRS_SCHEMA_IN.XML File

Configuring OFS_IFRS_PACK.xml File
The OFS_IFRS_PACK.xml file holds details on the various OFSAA products that are packaged 
in a particular Application Pack. 

The following table gives details about the various tags/parameters available in the file and the 
values that need to be updated. Prior to installing the OFSAA Application Pack in SILENT 
mode, it is mandatory to update this file. 

Note: If you are installing in the GUI mode, then this file need not be 
updated.

Table L–1 OFS_IFRS_PACK.xml Parameters

Tag Name/ Attribute 
Name Description Mandatory (Y/N)

Default Value/ 
Permissible Value Comments

APP_PACK_ID Unique 
Application Pack 
Identifier

Y Unique Seeded Value DO NOT modify this 
value.

APP_PACK_NAME Unique 
Application Pack 
Name

Y Unique Seeded Value DO NOT modify this 
value.

APP_PACK_
DESCRIPTION

Unique 
Application Pack 
Description

Y Unique Seeded Value DO NOT modify this 
value.

VERSION Unique release 
version

Y Unique Seeded Value DO NOT modify this 
value.

APP Unique 
Application 
Entries

Y Unique Seeded Value DO NOT remove 
these tags.

APP_ID Unique 
Application 
Identifier

Y Unique Seeded Value DO NOT modify this 
value.
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Configuring OFS_IFRS_SCHEMA_IN.XML File
Creating database schemas, objects within schemas and assigning appropriate grants are the 
primary steps in the installation process of OFSAA Applications. The OFS_IFRS_SCHEMA_
IN.xml file contains details on the various application schemas that should be created prior to 
the Application Pack installation. 

The following table gives details about the various tags/ parameters available in the file and the 
values that need to be updated. Prior to executing the schema creator utility, it is mandatory to 
update this file.

APP_ID/ PREREQ Prerequisite 
Application/ 
Product

Y Unique Seeded Value For most applications 
Infrastructure would 
be the prerequisite set. 
For certain other 
applications, an 
appropriate 
Application ID would 
be set.

DO NOT modify this 
value.

DO NOT modify this 
value.

APP_ID/ DEF_SEL_FLAG Default Selected 
Flag

Y Default - YES In all Application 
Packs, Infrastructure 
would have this value 
set to "YES". DO 
NOT modify this 
value.

APP_ID/ ENABLE Enable 
Application/ 
Product

YES if installing in 
SILENT mode.

Default - 

YES for Infrastructure

NO for Others

Permissible - YES or 
NO

Set this attribute-value 
to YES against every 
APP_ID which is 
licensed and should be 
enabled for use.

Note: Application/ 
Product once enabled 
cannot be disabled. 
However, 
Application/ Product 
not enabled during 
installation can be 
enabled later through 
the Administration UI.

APP_NAME Unique 
Application/ 
Product Name

Y Unique Seeded Value DO NOT modify this 
value.

APP_DESCRIPTION Unique 
Application/ 
Product Name

Y Unique Seeded Value DO NOT modify this 
value.

VERSION Unique release 
version

Y Unique Seeded Value DO NOT modify this 
value.

Table L–1 OFS_IFRS_PACK.xml Parameters

Tag Name/ Attribute 
Name Description Mandatory (Y/N)

Default Value/ 
Permissible Value Comments
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Table L–2 OFS_IFRS_SCHEMA_IN.xml Parameters

Tag Name/ Attribute 
Name Description Mandatory (Y/N)

Default Value/ 
Permissible Value Comments

<APP_PACK_ID> Unique 
Application Pack 
Identifier

Y Unique Seeded Value DO NOT modify this 
value.

<JDBC_URL> Enter the JDBC 
URL.

Note: You can 
enter RAC and 
NON-RAC 
enabled database 
connectivity URL.

Y 
jdbc:oracle:thi
n:@< DBSERVER 
IP/HOST>:<PORT>
:<SID>

or

jdbc:oracle:thi
n:@<HOST/IP>:<P
ORT>:<SID>

or

jdbc:oracle:thi
n:@//[HOST][:PO
RT]/SERVICE

or

jdbc:oracle:thi
n:@(DESCRIPTION
=(ADDRESS_
LIST=(ADDRESS=(
PROTOCOL=TCP)(H
OST=[HOST])(por
t=[PORT]))(ADDR
ESS=(PROTOCOL=T
CP)(HOST=[HOST]
)(PORT=[PORT]))
(LOAD_
BALANCE=yes)(FA
ILOVER=yes))(CO
NNECT_
DATA=(SERVICE_
NAME=[SERVICE])
)) 

Ensure to add an entry 
(with SID/SERVICE 
NAME) in the 
tnsnames.ora file on 
the OFSAA server. 
The entry should 
match with the SID/ 
SERVICE NAME 
used in the JDBC 
URL.

<JDBC_DRIVER> By default this 
driver name is 
seeded. 

Note: Do not edit 
this attribute 
value.

Y Example:

oracle.jdbc.driver.Ora
cleDriver

Only JDBC Thin 
Driver is supported.

DO NOT modify this 
value.

<HOST> Enter the 
Hostname/ IP 
Address of the 
system on which 
you are installing 
the OFSAA 
components.

Y Host Name/ IP 
Address
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<SETUPINFO>/ NAME Enter the acronym 
for the type of 
implementation. 
This information 
will be displayed 
in the OFSAA 
Home window.

Note: On 
executing the 
schema creator 
utility, this value 
will be prefixed 
with each schema 
name. For 
example: dev_
ofsaaconf, uat_
ofsaaatm.

Y Accepts strings with a 
minimum length of 
two and maximum of 
four.

Example, 

DEV, SIT, PROD

This name would 
appear in the OFSAA 
Landing window as 
"Connected To: 
xxxx".

The schemas being 
created would get this 
prefix. For example, 
dev_ofsaaconf, uat_
ofsaaconf, and so on.

<SETUPINFO>/ PREFIX_
SCHEMA_NAME

Identifies if the 
value specified in 
<SETUPINFO>/ 
NAME attribute 
should be prefixed 
to the schema 
name.

N Y or N Default value is N.

<PASSWORD DEFAULT>/ 
APPLYSAMEFORALL

Enter as Y if you 
want to apply the 
password 
specified in 
DEFAULT 
attribute for all the 
schemas. 

If you enter as N, 
you need to 
provide individual 
passwords for all 
schemas.

Note: In case you 
have entered Y in 
APPLYSAMEFO
RALL attribute 
and also have 
specified 
individual 
passwords for all 
the schemas, then 
the specified 
individual 
passwords will 
take precedence.

Y Default - N

Permissible - Y or N

Note: Setting this 
attribute value is 
mandatory, If 
DEFAULT attribute is 
set.

Table L–2 OFS_IFRS_SCHEMA_IN.xml Parameters

Tag Name/ Attribute 
Name Description Mandatory (Y/N)

Default Value/ 
Permissible Value Comments
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<SCHEMA>/ TYPE The different 
types of schemas 
that are supported 
in this release are 
ATOMIC and 
CONFIG.

By default, the 
schemas types are 
seeded based on 
the Application 
Pack. 

Note: Do not edit 
this attribute 
value.

Y ATOMIC/CONFIG/S
ANDBOX/ADDON

Note: SANDBOX 
AND ADDON 
schemas are not 
applicable for OFS 
IFRS Application 
Pack.

Only One CONFIG 
schema can exist in 
the file.

This schema identifies 
as the 
CONFIGURATION 
schema that holds the 
OFSAA setup details 
and other metadata 
information.

Multiple ATOMIC/ 
SANDBOX/ ADDON 
schemas can exist in 
the file.

ATOMIC schema 
refers to the 
Information Domain 
schema. SANDBOX 
schema refers to the 
SANDBOX schema. 
ADDON schema 
refers to other 
miscellaneous schema 
(not applicable for this 
Application Pack).

<SCHEMA>/ NAME By default, the 
schemas names 
are seeded based 
on the Application 
Pack.

You can edit the 
schema names if 
required. 

Note: The Schema 
Name will have a 
prefix of the 
SETUPINFO/ 
NAME attribute.

SCHEMA NAME 
must be same for 
all the ATOMIC 
Schemas of 
applications 
within an 
Application Pack.

Important: For 
both OFS HM and 
OFS LLFP, it is 
mandatory to pass 
the atomic schema 
user names 
separately. 

Y The permissible 
length is 15 characters 
and only 
alphanumeric 
characters allowed. 
No special characters 
allowed except 
underscore '_'.

SETUPINFO/ NAME 
attribute value would 
be prefixed to the 
schema name being 
created.

For E.g. if name is set 
as 'ofsaaatm' and 
setupinfo as 'uat' then 
schema being created 
would be 'uat_
ofsaaatm'. 

NAME should be 
same where APP_
GRP=1 for all 
SCHEMA tags (Not 
applicable for this 
Application Pack).

Table L–2 OFS_IFRS_SCHEMA_IN.xml Parameters

Tag Name/ Attribute 
Name Description Mandatory (Y/N)

Default Value/ 
Permissible Value Comments
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<SCHEMA>/ PASSWORD* Enter the 
password of the 
schema to be 
created. 

Note: If this 
attribute is left 
blank, then the 
password 
specified in the 
<PASSWORD>/D
EFAULT attribute 
is applied as the 
Schema Password.

N The maximum length 
allowed is 30 
characters. Special 
characters are not 
allowed.

Note: You need to 
mandatorily enter the 
password if you have 
set the 
<PASSWORD>/ 
APPLYSAMEFORAL
L attribute as N.

<SCHEMA>/ APP_ID By default, the 
Application ID is 
seeded based on 
the Application 
Pack. 

Note: Do not edit 
this attribute 
value.

Y Unique Seeded Value Identifies the 
Application/ Product 
for which the schema 
is being created.

DO NOT modify this 
value.

<SCHEMA>/ 
DEFAULTTABLESPACE

Enter the available 
default tablespace 
for DB User.

Note: If this 
attribute is left 
blank, then 
USERS is set as 
the default 
tablespace.

N Default - USERS

Permissible - Any 
existing valid 
tablespace name.

Modify this value to 
associate any valid 
tablespace with the 
schema.

<SCHEMA>/ 
TEMPTABLESPACE

Enter the available 
temporary 
tablespace for the 
DB User. 

Note: If this 
attribute is left 
blank, then TEMP 
is set as the 
default tablespace.

N Default - TEMP

Permissible - Any 
existing valid 
temporary tablespace 
name.

Modify this value to 
associate any valid 
tablespace with the 
schema.

<SCHEMA>/ QUOTA Enter the quota to 
be set on 
DEFAULTTABL
ESPACE attribute 
for the schema/ 
user. By default, 
the quota size is 
set to 
500M.Minimum: 
500M or 
Unlimited on 
default Tablespace

N Example: 

600M/m

20G/g

UNLIMITED/unlimit
ed

Modify this value to 
grant the specified 
quota on the 
mentioned tablespace 
to the user. 

Table L–2 OFS_IFRS_SCHEMA_IN.xml Parameters

Tag Name/ Attribute 
Name Description Mandatory (Y/N)

Default Value/ 
Permissible Value Comments
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<SCHEMA>/ INFODOM Enter the name of 
the Information 
Domain to 
associate this 
schema.

The schema 
creator utility 
automatically 
derives an 
Information 
Domain Name 
based on the 
Application Pack 
if no value is 
specified for this 
attribute.

Optional for Atomic 
and mandatory for 
sandbox 

Permissible length is 
16 characters and only 
alphanumeric 
characters allowed. 
No special characters 
allowed.

<ADV_SEC_OPTIONS> Parent tag to hold 
Advance Security 
Options. 

 

N Uncomment the tag 
and edit if you want to 
add security options. 
For example, TDE 
and Data Redact.

For details, see the 
example following the 
table.

<ADV_SEC_
OPTIONS>/TDE

Tag to 
enable/disable 
TDE.

N Default is FALSE. To 
enable TDE, set this 
to TRUE.

Ensure this tag is not 
commented if you 
have uncommented 
<ADV_SEC_
OPTIONS>

<ADV_SEC_OPTIONS>/ 
DATA_REDACT

Tag to 
enable/disable 
Data Redaction 
feature.

N Default is FALSE. To 
enable DATA_
REDACT, set this to 
TRUE

Ensure this tag is not 
commented if you 
have uncommented 
<ADV_SEC_
OPTIONS>/

<TABLESPACES> Parent tag to hold 
<TABLESPACE> 
elements

N NA Uncomment the tag 
and edit. ONLY if 
tablespaces are to be 
created as part of the 
installation.

For details, see the 
example following the 
table.

Note: When TDE is 
TRUE in ADV_SEC_
OPTIONS, then it is 
mandatory for the 
<TABLESPACES> 
tag to be present in the 
xml file.

Table L–2 OFS_IFRS_SCHEMA_IN.xml Parameters

Tag Name/ Attribute 
Name Description Mandatory (Y/N)

Default Value/ 
Permissible Value Comments
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Example: (The following snippet shows that TDE is enabled and hence the tablespace has been 
shown with encryption ON.)

<ADV_SEC_OPTIONS>

<OPTION NAME="TDE" VALUE="FALSE"/>

<OPTION NAME="DATA_REDACT" VALUE="FALSE" />

</ADV_SEC_OPTIONS>

<TABLESPACES>

<TABLESPACE NAME="OFS_AAI_TBSP_1" VALUE="TS_USERS1" 
DATAFILE="/scratch/ora12c/app/oracle/oradata/OFSPQA12CDB/ts_
users1.dbf" SIZE="500M" AUTOEXTEND="ON" ENCRYPT="ON" />

<TABLESPACE NAME="OFS_AAI_TBSP_2" VALUE="TS_USERS2" 
DATAFILE="/scratch/ora12c/app/oracle/oradata/OFSPQA12CDB/ts_
users2.dbf" SIZE="500M" AUTOEXTEND="ON" ENCRYPT="ON" />

</TABLESPACES>

<SCHEMAS>

<SCHEMA TYPE="CONFIG" NAME="ofsaaconf" PASSWORD="" APP_ID="OFS_
AAI" DEFAULTTABLESPACE="##OFS_AAI_TBSP_1##" 
TEMPTABLESPACE="TEMP" QUOTA="unlimited"/>

<TABLESPACE>/ NAME Logical Name of 
tablespace to be 
created.

Y Name if specified 
should be referred in 
the <SCHEMA 
DEFAULTTABLESP
ACE= 
"##NAME##"> 
attribute.

Note the ## syntax.

<TABLESPACE>/ VALUE Physical Name of 
the tablespace to 
be created

Y NA Value if specified will 
be the actual name of 
the TABLESPACE.

<TABLESPACE>/ 
DATAFILE

Specifies the 
location of the 
data file on the 
server

Y NA Enter the absolute 
path of the file to be 
created.

<TABLESPACE>/ 
AUTOEXTEND

Specifies if the 
tablespace should 
be extensible or 
have a hard limit

Y ON or OFF Set to ON to ensure 
that the tablespace 
does not run out of 
space when full.

<TABLESPACE>/ 
ENCRYPT

Specifies if the 
tablespace(s) 
should be 
encrypted using 
TDE.

Y ON or OFF Set to ON to ensure 
that the tablespaces 
when created are 
encrypted using TDE.

Note: Encryption of tablespaces requires to enabling Transparent Data 
Encryption (TDE) on the Database Server.

Table L–2 OFS_IFRS_SCHEMA_IN.xml Parameters

Tag Name/ Attribute 
Name Description Mandatory (Y/N)

Default Value/ 
Permissible Value Comments
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<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" APP_ID="OFS_
AAAI" DEFAULTTABLESPACE="##OFS_AAI_TBSP_2##" 
TEMPTABLESPACE="TEMP" QUOTA="unlimited" INFODOM="OFSAAAIINFO"/>

</SCHEMAS>



Configuring OFS_IFRS_SCHEMA_IN.XML File

L-108 OFS IFRS Installation and Configuration Guide                  



M

                Configuring OFSAAI_InstallConfig.xml File M-109

MConfiguring OFSAAI_InstallConfig.xml File

This section gives details about the OFSAAI_InstallConfig.xml file.

Configuring OFSAAI_InstallConfig.xml file
To configure the OFSAAI_InstallConfig.xml file, follow these steps.

1. Navigate to OFS_IFRS_PACK/OFS_AAI/conf/ directory.

2. Open the file OFSAAI_InstallConfig.xml in text editor.

3. Configure the OFSAAI_InstallConfig.xml as mentioned in the Table M–1, " OFSAA 
Infrastructure Installation Tasks and Descriptions".

4. You must manually set the InteractionVariable parameter values as mentioned in the table. 
If a value is not applicable, enter NA and ensure that the value is not entered as NULL.

Table M–1  OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable 
Name Significance and Expected Value Mandatory

InteractionGroup name="WebServerType"

WEBAPPSERVERTYPE Identifies the web application server on which the 
OFSAA Infrastructure web components would be 
deployed.

The below numeric value should be set depending on 
the type:

• Apache Tomcat = 1

• IBM WebSphere Application Server = 2

• Oracle WebLogic Server = 3

For example, <InteractionVariable 
name="WEBAPPSERVERTYPE">3</InteractionVari
able>

Yes

InteractionGroup name="OFSAA Infrastructure Server Details" 
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DBSERVER_IP Identifies the hostname or IP address of the system on 
which the Database Engine is hosted.

Note: For RAC Database, the value should be NA.

For example, <InteractionVariable 
name="DBSERVER_
IP">14.15.16.17</InteractionVariable> or 
<InteractionVariable name="DBSERVER_
IP">dbhost.server.com</InteractionVariable
>

Yes

InteractionGroup name="Database Details"

ORACLE_SID/SERVICE_ 
NAME

Identifies the Oracle DB Instance SID or SERVICE_
NAME

Note: The Oracle_SID value should be exactly the 
same as it is mentioned in JDBC_URL.

For example, <InteractionVariable 
name="ORACLE_SID/SERVICE_
NAME">ofsaser</InteractionVariable>

Yes

ABS_DRIVER_PATH Identifies the directory where the JDBC driver 
(ojdbc<version>.jar) exists. This would typically 
be the $ORACLE_HOME/jdbc/lib

For example, <InteractionVariable name="ABS_
DRIVER_PATH">">/oradata6/revwb7/oracle 
</InteractionVariable>

Note: Refer to Appendix O section for identifying the 
correct "ojdbc<version>.jar" version to be copied.

Yes

InteractionGroup name="OLAP Detail"

OLAP_SERVER_ 
IMPLEMENTATION

Identifies if the OFSAA Infrastructure OLAP 
component needs to be configured depending on 
whether you intend to use the OLAP feature. The 
below numeric value should be set depending on the 
choice:

• YES - 1

• NO - 0

No

Note: If value for OLAP_SERVER_IMPLEMENTATION is set to 1, it checks for following environment 
variables are set in.profile: 

ARBORPATH, HYPERION_HOME and ESSBASEPATH.

InteractionGroup name="SFTP Details" 

SFTP_ENABLE Identifies if the SFTP (Secure File Transfer Protocol) 
feature is to be enabled. The below numeric value 
should be set depending on the choice:

• For SFTP, set this field to 1 or -1. 

• For FTP, set this field to  - 0

Yes

Note: The default value for SFTP_ENABLE is 1, which signifies that SFTP will be used. Oracle 
recommends using SFTP instead of FTP because SFTP is considered more secure. However, a client 
may choose to ignore this recommendation and to use FTP by setting SFTP_ENABLE to 0. You can 
change this selection later by using the OFSAAI administration interface. 

Set SFTP_ENABLE to -1 to configure ftpshare and weblocal path as local path mounted for OFSAAI 
server.

Table M–1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable 
Name Significance and Expected Value Mandatory
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FILE_TRANSFER_PORT Identifies the port used for the file transfer service. 
The default value specified is 22 (SFTP). Specify 
default value as 21 (FTP) if SFTP_ENABLE is 0. 
Alternatively, this value can be any Port configured by 
System Administrators to support SFTP/FTP.

For example, <InteractionVariable 
name="FILE_TRANSFER_
PORT">21</InteractionVariable>

Yes

InteractionGroup name="Locale Detail"

LOCALE Identifies the locale information to be used during the 
installation. This release of the OFSAA Infrastructure 
supports only US English. 

For example, <InteractionVariable 
name="LOCALE">en_US</InteractionVariable>

Yes

InteractionGroup name="OFSAA Infrastructure Communicating ports"

Note: The below ports are used internally by the various OFSAA Infrastructure services. The default 
values mentioned below are set in the installation. If you intend to specify a different value, update the 
parameter value accordingly and ensure this port value is in the range of 1025 to 65535 and the 
respective port is enabled.

JAVAPORT 9999 Yes

NATIVEPORT 6666 Yes

AGENTPORT 6510 Yes

ICCPORT 6507 Yes

ICCNATIVEPORT 6509 Yes

OLAPPORT 10101 Yes

MSGPORT 6501 Yes

ROUTERPORT 6500 Yes

AMPORT 6505 Yes

InteractionGroup name="Web Details"

Note: If value for HTTPS_ENABLE is set to 1, ensure you have a valid certificate available from a trusted 
CA and the same is configured on your web application server.

HTTPS_ENABLE Identifies if the UI should be accessed using HTTP or 
HTTPS scheme. The default value set is 0. The below 
numeric value should be set depending on the choice:

• YES - 1

• NO - 0

For example, <InteractionVariable 
name="HTTPS_
ENABLE">0</InteractionVariable>

Yes

Table M–1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable 
Name Significance and Expected Value Mandatory
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WEB_SERVER_IP Identifies the HTTP Server IP/ Hostname or Web 
Application Server IP/ Hostname, to be used for 
accessing the UI. This IP would typically be the 
HTTP Server IP. 

If no separate HTTP Server is available, the value 
should be Web Application Server IP/Hostname.

For example, <InteractionVariable name="WEB_
SERVER_
IP">10.11.12.13</InteractionVariable> 

or 

<InteractionVariable name="WEB_SERVER_
IP">myweb.server.com</InteractionVariable>

No

WEB_SERVER_PORT Identifies the Web Server Port. This would typically 
be 80 for non SSL and 443 for SSL. If no separate 
HTTP Server exists, the value should be the port 
configured for Web Server.

Note: The port value will not be accepted as 80 if 
HTTPS_ENABLE is 1 and as 443, if HTTPS_ENABLE is 0.

For example, <InteractionVariable name="WEB_
SERVER_PORT">80</InteractionVariable>

No

CONTEXT_NAME Identifies the web application context name which 
will be used to built the URL to access the OFSAA 
applications. The context name can be identified from 
a URL as below:

<scheme>://<host>:<port>/<context-name>/lo
gin.jsp

Sample URL: 
https://myweb:443/ofsaadev/login.jsp

For example, <InteractionVariable 
name="CONTEXT_
NAME">ofsaadev</InteractionVariable>

Yes

WEBAPP_CONTEXT_
PATH

Identifies the absolute path of the exploded .ear file on 
the web application server.

For Tomcat, specify the Tomcat directory path till 
/webapps, such as 
/oradata6/revwb7/tomcat/webapps/. 

For WebSphere, enter the WebSphere path as 
<WebSphere profile directory>/installedApps/ 
<NodeCellName>. For example, 
/data2/test//WebSphere/AppServer/profiles/
<Profile_
Name>/installedApps/aix-imfNode01Cell. 
Where aix-imf is Host name. 

For WebLogic, provide the WebLogic home directory 
path as /<WebLogic home directory 
path>/bea/wlserver_10.3

Yes

WEB_LOCAL_PATH Identifies the absolute path to any directory on the 
web application server that can hold temporary files 
being uploaded as part of the applications usage.

Note: In case of a clustered deployment, ensure this 
path and directory is same on all the nodes.

Yes

InteractionGroup name="Weblogic Setup Details"

Table M–1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable 
Name Significance and Expected Value Mandatory
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WEBLOGIC_DOMAIN_
HOME

Identifies the WebLogic Domain Home.

For example, <InteractionVariable 
name="WEBLOGIC_DOMAIN_

HOME">/home/weblogic/bea/user_ 
projects/domains/mydomain

</InteractionVariable>

Yes Specify the 
value only if 
WEBSERVERT
YPE is set as 3 
(WebLogic)

InteractionGroup name="OFSAAI FTP Details"

OFSAAI_FTPSHARE_
PATH

Identifies the absolute path to the directory identified 
as file system stage area.

Note: 

• The directory should exist on the same system on 
which the OFSAA Infrastructure is being 
installed (can be on a separate mount).

• The user mentioned in APP_SFTP_USER_ID 
parameter below should have RWX permission 
on the directory.

For example, <InteractionVariable name="APP_
FTPSHARE_
PATH">">/oradata6/revwb7/ftpshare</Interactio
nVariable>

Yes

OFSAAI_SFTP_USER_ID Identifies the user who has RWX permissions on the 
directory identified under the aforementioned 
parameter APP_FTPSHARE_PATH.

Yes

OFSAAI_SFTP_
PRIVATE_KEY

Identifies the SFTP private key for OFSAAI.

For example, 

<InteractionVariable name="OFSAAI_SFTP_
PRIVATE_KEY">/home/ofsaapp/.ssh/id_
rsa</InteractionVariable>

By default, the value is NA, which indicates password 
will be prompted for the  user <OFSAAI_SFTP_
USER_ ID> for authentication.

For more information on generating SFTP Private key, 
see the Setting Up SFTP Private Key section.

No

OFSAAI_SFTP_
PASSPHRASE

Identifies the passphrase for the SFTP private key for 
OFSAAI.

For example, 

InteractionVariable name="OFSAAI_SFTP_
PASSPHRASE">enter a pass phrase 
here</InteractionVariable>

By default, the value is NA. 

No

InteractionGroup name="Hive Details" 

The default value set for the interaction variables under this group is set as NA. These are required only 
for Hive Configuration.

Table M–1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable 
Name Significance and Expected Value Mandatory
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HIVE_SERVER_PORT Identifies the port used for the file transfer service. The 
default value set is 22 (SFTP). Set this value as 21 for 
FTP.

For example, 

InteractionVariable name="HIVE_SERVER_
PORT">22</InteractionVariable>

Yes, only for 
HIVE 
Configuration

HIVE_SERVER_
FTPDRIVE

Identifies the absolute path to the directory identified 
as file system stage area of HIVE server.

For example, 

InteractionVariable name="HIVE_SERVER_
FTPDRIVE">/scratch/ofsaa/ftpshare</InteractionVari
able>

Yes, only for 
HIVE 
Configuration

HIVE_SERVER_FTP_
USERID

Identifies the user who has RWX permissions on the 
directory identified under the preceding parameter 
HIVE_SERVER_FTPDRIVE.

For example, 

InteractionVariable name="HIVE_SERVER_FTP_
USERID">ofsaa</InteractionVariable>

Yes, only for 
HIVE 
Configuration

HIVE_SERVER_FTP_
PROTOCOL

If the HIVE_SERVER_PORT is 21, then set value as 
FTP, else set it as SFTP.

For example, 

InteractionVariable name="HIVE_SERVER_FTP_
PROTOCOL">SFTP</InteractionVariable>

Yes, only for 
HIVE 
Configuration

HIVE_SFTP_PRIVATE_
KEY

Identifies the SFTP private key for the HIVE server.

For example, 

<InteractionVariable name="HIVE_SFTP_PRIVATE_
KEY">/scratch/testuser/.ssh/id_
rsa</InteractionVariable>

By default, the value is NA, which indicates password 
will be prompted for the  user <HIVE_SERVER_
FTP_USERID> for authentication.

For more information on generating SFTP Private key, 
see the Setting Up SFTP Private Key section.

Yes, only for 
HIVE 
Configuration

HIVE_SFTP_
PASSPHRASE

Identifies the passphrase for the SFTP private key for 
HIVE.

For example, 

<InteractionVariable name="HIVE_SFTP_
PASSPHRASE">NA</InteractionVariable>

By default, the value is NA.

If HIVE_SFTP_PRIVATE_KEY value is given and 
this is kept as NA, then it is assumed as empty 
passphrase.

Yes, only for 
HIVE 
Configuration

Table M–1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable 
Name Significance and Expected Value Mandatory
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NMigrating Excel Upload Functionality

This section provides detailed instructions to migrate excel upload functionality.

Prerequisites
The following are the prerequisites for migration.

• Data model in ATOMIC schemas should be same on the source and target setups.

• OFS AAI (platform) patch level version should be same on the source and target setups.

• PL/SQL Developer to connect and query the database.

• WinSCP to connect and access server file system.

Migrating Excel Upload
To migrate, follow these steps:

1. Open PL/SQL Developer and logon to the source setup's configuration (CONFIG) schema 
by entering the appropriate username and password.

2. In a new SQL window query the data of table EXCEL_MAPPING_MASTER. 

3. Open a new session in PL/SQL developer and logon to the target setup's configuration 
(CONFIG) schema by entering the appropriate username and password. 

4. Insert the records from aforementioned Step 1 in to this table.

5. In V_INFODOM column of EXCEL_MAPPING_MASTER table update the infodom name with 
the target infodom name.

Note: If all the mappings can work out of the single target Infodom, update 
same Infodom value across all rows. If only few mappings will work out of 
the target infodom, update the infodom value for selective records. Kindly 
note, excel upload mappings will work only if the target infodom has same 
data model entities as used in the mappings defined on source setup.

6. Update V_CREATED_BY column with the name of any user present in the target setup that 
has appropriate roles to perform Excel Upload tasks.

Note: It is mandatory to update values for V_INFODOM and V_CREATED_
BY columns.
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7. Open WinSCP and login a new session by entering the host name, port number, user name 
and password to access the source setup. 

8. Navigate to the folder referred as FTPSHARE.

9. Copy the excel-entity mapping xml file(s) which are located in this folder according to 
their folder structure on to your desktop. For example: /ftpshare 
/STAGE/ExcelUpload/$SOURCE_INFODOM_NAME/$EXCEL_FILE_NAME.xml

Note: Actual file name of Excel Sheet is mentioned in the V_EXCEL_NAME 
column of EXCEL_MAPPING_MASTER table.

10. Copy the excel templates (.xls/ .xlsx) file(s) which are located in this folder according to 
their folder structure on to your desktop. For example: 
/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx

Note: Ignore this step if files are not present at the location.

11. Login a new session in WinSCP by entering the host name, port number, user name and 
password to access the target setup. 

12. Copy the xml file(s) from Step3 to the below location in the target setup. For example: 
/ftpshare/STAGE/ExcelUpload/$TARGET_INFODOM_NAME/$EXCEL_FILE_NAME.xml

Note: $TARGET_INFODOM_NAME should be target setup infodom in which 
you have uploaded the appropriate data model and the name should be same 
as the V_INFODOM column value updated in EXCEL_MAPPING_MASTER table.

13. Copy the xls/ xlsx file(s) from Step 3 to the below location in target setup. For example: 
/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx

Note: Ignore this step if files are not present at the location.
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OJDBC Jar Files

The ojdbc<version>.jar file should be copied based on the Database version and the 
supported Java (JDK/JRE) version. See to the following table for details. 

Table O–1 JDBC Jar files version details

Oracle Database 
Version

JDK/JRE Version 
Supported

JDBC Jar files specific to the 
release

12.1 or 12cR1 JDK 7 and JDK 8 ojdbc7.jar for JDK 7/JDK 8

11.2 or 11gR2 JDK 7 is supported in 11.2.0.3 
and 11.2.0.4 

ojdbc6.jar for JDK 7
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PUpgrading an Existing OFSAA 8.0.x Java 7 
Instance to Java 8

This section explains the configurations required to upgrade an existing OFSAA 8.0.x Java 7 
instance to Java 8. It consists of the following topics:

• Prerequisites

• Upgrading OFSAA 8.0.x Java 7 instance to Java 8

• Configuring Web Application Server Configurations

• OFSAA Generic Configurations

• Configuring OFSAA for New Web Application Server Installation

Prerequisites
The following are the prerequisites for upgrading OFSAA 8.0.x Java 7 instance to Java 8:

• Java 8 should be installed on the OFSAA server and Web Application Server.

Upgrading OFSAA 8.0.x Java 7 instance to Java 8
To upgrade OFSAA 8.0.x Java 7 instance to Java 8, follow these steps:

1. Configure Web Application Server to Java 8. For more information, refer Configuring Web 
Application Server Configurations.

2. Configure the OFSAA instance to Java 8. For more information, refer OFSAA Generic 
Configurations. For a newly installed Web Application Server, refer Configuring OFSAA 
for New Web Application Server Installation

3. Restart the OFSAA services. For more information, refer the Start/Stop Infrastructure 
Services section in Appendix D

4. Generate the application EAR/WAR file and redeploy the application onto your configured 
web application server. For more information on generating and deploying EAR / WAR 
file, refer Appendix C.

Configuring Web Application Server Configurations
This section describes the changes to be made in the Web Application Server. Following are the 
two options to perform Web Application Server Configurations which are listed as follows:

• Upgrade the existing Web Application Server installation to Java 8

• Install a new instance of the Web Application Server with Java 8
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This section consists of the following topics:

• Upgrading Oracle WebLogic Server Updates

• Upgrading Apache Tomcat Server Updates

Upgrading Oracle WebLogic Server Updates
Perform the following configurations to upgrade the existing WebLogic server instance to Java 
8:

1. Navigate to <WLS_HOME>/Middleware/Oracle_Home/wlserver.

2. Edit the product.properties file. Set JAVA_HOME, WLS_JAVA_HOME, 
JAVAHOME properties to the new Java path and java.vm.version to the new Java 
version. For example,

JAVA_HOME=/usr/java/jre1.8.0_45

WLS_JAVA_HOME=/usr/java/jre1.8.0_45

JAVAHOME=/usr/java/jre1.8.0_45

java.vm.version=1.8.0_45

3. Navigate to <WLS_HOME>/Middleware/Oracle_Home/user_
projects/domains/<domain>/bin. Update SUN_JAVA_HOME, DEFAULT_
JAVA_HOME, JAVA_HOME in the setDomainEnv.sh file to point to the new Java 
path. For example, 

SUN_JAVA_HOME="/usr/java/jre1.8.0_45"

DEFAULT_SUN_JAVA_HOME="/usr/java/jre1.8.0_45"

JAVA_HOME="/usr/java/jre1.8.0_45"

4. Clear the Application cache. Navigate to the following path and delete the files:

<Weblogic installation location>/domains/<Domain name>/servers/<Server 
name>/tmp/_WL_user/<Application name>/qaelce/jsp_servlet

If you wish to install a new instance of the Oracle WebLogic Server, follow these steps:

1. Install Oracle WebLogic Server 12.2.x on Java 8.

2. Perform the configurations for the newly installed WebLogic server. For more information 
refer Configuring Resource Reference in Weblogic Application Server.

Note: While creating WebLogic Domain, the Listen Port should be set 
same as that of the existing Domain.

Note down the new Domain path to perform OFSAA Configurations.

Upgrading Apache Tomcat Server Updates
Perform the following configurations to upgrade the existing Apache Tomcat Server from Java 
7 to Java 8:

1. Login to the Apache Tomcat Server as a non-root user.

2. Edit the user .profile. Update the value for JAVA_HOME from JRE 1.7 to JRE 1.8. For 
Example, 
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JAVA_HOME=/usr/java/jre1.8.0_45

3. Clear the Application cache. Navigate to the following path and delete the files:

<Tomcat installation folder>/work/Catalina/localhost/<Application 
name>/org/apache/jsp

If you wish to install a new instance of the Apache Tomcat Server, follow these steps:

1. Install Apache Tomcat Server 8 with Java 8.

2. Perform the configurations for the newly installed Tomcat server. For more information 
refer Configuring Resource Reference in Tomcat Application Server.

Note: Update the Connector Port in 
/apache-tomcat-8.0.21/conf/server.xml file to that of the 
existing Tomcat instance.

Note down the new deployment path to perform OFSAA Configurations.

OFSAA Generic Configurations
This section consists of the following topics:

• Configuring User .profile Settings

• Configuring Java 8

Configuring User .profile Settings
Perform the following configurations:

1. Login to the OFSAA Server as a non-root user.

2. Edit the user .profile. Update the value for PATH variable from JRE 1.7 to JRE 1.8. 
For Example,

PATH=/usr/java/jre1.8.0_45/jre

JAVA_BIN=/usr/java/jre1.8.0_45/jre/bin

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/java/jre1.8.0_
45/jre/lib/amd64/server

Configuring Java 8
This section is applicable only if you upgrade OFSAA instance from 8.x to 8.0.7.0.0. Refer to 
the following instructions to extract and apply the patch.

1. If the Oracle Database version is 12c, copy ojdbc7.jar from $ORACLE_HOME/jdbc/lib to 
the following locations:

• $FIC_HOME/utility/OFSAAGenerateRepository/lib/

• $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/

• $FIC_HOME/ficdb/lib/

• $FIC_HOME/ficapp/icc/lib/

• $FIC_HOME/ficapp/common/FICServer/lib/
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• $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/

• $FIC_HOME/ficweb/webroot/WEB-INF/lib/

• $FIC_HOME/ficdb/etl/classes/

Note: If ojdbc6.jar is already present in any of the aforementioned folders, 
you need to remove it.

2. If the Oracle Database version is 11g, copy ojdbc6.jar from $ORACLE_HOME/jdbc/lib to 
the following locations:

• $FIC_HOME/utility/OFSAAGenerateRepository/lib/

• $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/

• $FIC_HOME/ficdb/lib/

• $FIC_HOME/ficapp/icc/lib/

• $FIC_HOME/ficapp/common/FICServer/lib/

• $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/

• $FIC_HOME/ficweb/webroot/WEB-INF/lib/

• $FIC_HOME/ficdb/etl/classes/

Configuring OFSAA for New Web Application Server 
Installation

This configuration is required only if you have freshly installed Oracle WebLogic 12.2.x or 
Apache Tomcat Server 8.0. Follow these steps:

1. Modify the following parameters in the Configuration table present in the Config Schema 
with the new Domain Path in case of WebLogic or with the new deployment path in case 
of Tomcat:

• DeFiHome

• REV_IMG_PATH

• EMBEDDED_JSP_JS_PATH

2. Login to the OFSAA Server as a non-root user.

3. Navigate to $FIC_HOME/ficweb/webroot/WEB_INF and update the following 
parameters in the web.xml file with the new Domain path in case of WebLogic or with 
the new deployment path in case of Tomcat:

• FIC_PHYSICAL_HOME_LOC

• FIC_HOME

• ICC_SERVLET_LOG_FILE

4. Navigate to $FIC_HOME/ficweb/webroot/conf and update the Domain path in 
case of WebLogic or with the new deployment path in case of Tomcat:

• OFSAALogger.xml 

• MDBLogger.xml 

• RevLog4jConfig.xml 
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• RFDLogger.xml 

• ExportLog4jConfig.xml 

• RFDLogger.xml

• PR2Logger.xml
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QRemoving OFSAA

This chapter includes the following sections:

• Uninstalling OFSAA Infrastructure

• Uninstalling EAR Files in WebSphere

• Uninstalling EAR Files in WebLogic

• Uninstalling WAR Files in Tomcat

Uninstalling OFSAA Infrastructure
This section will guide you through the necessary steps to uninstall the OFSAA Infrastructure 
product.

Before you start the uninstallation process, ensure that no open connections exist to the OFSAA 
Infrastructure Config and Atomic Schemas and Infrastructure services are brought down.

To uninstall OFSAA Infrastructure:

1. Log in to the system as non-root user.

2. Navigate to the $FIC_HOME directory and execute the command:

./Uninstall.sh

3. Enter the password for OFSAAI Configuration Schema when prompted as shown in the 
following figure. 

Figure 6–15 Uninstalling OFSAA Infrastructure

 



Note: 

• Uninstallation does not remove the Infrastructure application from the 
Web Application Server. This has to be done manually.

• The entries in the .profile file will have to be removed manually.

• The files/ folders under the file system staging area (ftpshare) have to be 
deleted manually.

• All the Database objects from Atomic Schemas have to be dropped 
manually. 
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Uninstalling EAR Files in WebSphere
Following are the steps to uninstall any previously deployed application:

1. Open the URL in the browser window: http://<ipaddress>:<Administrative 
Console Port>/ibm/console (https if SSL is enabled). The Login window is displayed.

2. Login with the user id that has admin rights. 

3. Expand Applications > Application Types > WebSphere enterprise applications from the 
LHS. The Enterprise Applications window is displayed with all the deployed applications.

Figure 6–16 Enterprise Applications

 

4. Select the check box adjacent to the application to be uninstalled and click Stop.

5. Click Uninstall. The Uninstall Application window is displayed.
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Figure 6–17 Uninstall Application

 

6. Click OK to confirm.

7. Click Save to save the master file configuration.

Uninstalling EAR Files in WebLogic
On the machine that hosts WebLogic, perform the following steps to uninstall any previously 
deployed application:

1. Open the URL in the browser window: http://<ipaddress>:<admin server 
port>/console (https if SSL is enabled). The Login window of the WebLogic Server 
Administration Console is displayed.

2. Login with the WebLogic user credentials having administrator privileges. 

3. From the Domain Structure LHS menu, click Deployments. The Summary of 
Deployments window is displayed.

Figure 6–18 Summary of Deployments

 

4. Select the check box adjacent to the application to be uninstalled and click Stop> Force 
Stop Now.

5. Click Yes in the confirmation dialog to stop the selected deployment. 
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Figure 6–19 Summary of Deployments- Messages

 

6. Select the check box adjacent to the application and click Delete to delete the selected 
deployment.

7. Click Yes in the confirmation dialog to remove the selected deployment from the domain 
configuration.

Uninstalling WAR Files in Tomcat
On the machine that hosts Tomcat, perform the following steps to uninstall any previously 
deployed application:

1. Comment out Context path section from server.xml file in $CATALINA_HOME/conf 
directory to avoid conflict during undeploy and re-deploy of the WAR file.

Place comment <!-- --> in between the context path section. For example:

<!-- 

<Context path ="/pr2test" 
docBase="/home/perfuser/tomcat-7.0.19/webapps/pr2test" debug="0" 
reloadable="true" crossContext="true">

<Resource auth="Container" 

name="jdbc/PR2ATM"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username="pr2atm" 

password="pr2atm" 

url="jdbc:oracle:thin:@10.184.74.99:1521:PERFTEST"

maxActive="100" 

maxIdle="30"

maxWait="10000"/>
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</Context> 

-->

Restart the Tomcat service by doing the following:

d. Login to the "Unix server" through a terminal emulator.

e. Navigate to $catalina_home/bin directory.

f. Stop the tomcat services using the command ./shutdown.sh

g. Start the tomcat services using the command ./startup.sh

2. Open the URL in a browser window: http://<IP address>:<Tomcat server port>. 
(https if SSL is enabled). The Tomcat home window is displayed. 

3. Click the Manager App. The Connect to window is displayed.

4. Login with the user credentials having admin rights. The Tomcat Web Application Manager 
window is displayed with the list of all applications deployed in Tomcat.

Figure 6–20 Tomcat Web Application Manager

 

5. Click the Undeploy link against the deployed Infrastructure application. A confirmation 
message is displayed on the application /Infrastructure being uninstalled.



Uninstalling WAR Files in Tomcat

Q-130 OFS IFRS Installation and Configuration Guide                  



R

                Configuring Transparent Data Encryption (TDE) and Data Redaction in OFSAA R-131

RConfiguring Transparent Data Encryption 
(TDE) and Data Redaction in OFSAA

Two features comprise Oracle Advanced Security: Transparent Data Encryption and Oracle 
Data Redaction.

This section details about the configurations required in case you want to enable TDE or Data 
Redaction in OFSAA applications.

Transparent Data Encryption (TDE)
Transparent Data Encryption (TDE) enables you to encrypt sensitive data, such as Personally 
Identifiable Information (PII), that you store in tables and tablespaces. After the data is 
encrypted, this data is transparently decrypted for authorized users or applications when they 
access this data. To prevent unauthorized decryption, TDE stores the encryption keys in a 
security module external to the database, called a Keystore. For more details on TDE, see the 
Database Advanced Security Guide.

TDE tablespace encryption enables you to encrypt all of the data stored in a tablespace. To 
control the encryption, you use a Keystore and TDE master encryption key. Oracle Database 
supports both software keystores and hardware, or HSM-based, keystores. A software keystore 
is a container for the TDE master encryption key, and it resides in the software file system.   

Configuring TDE During OFS IFRS Installation Using Full Installer
This section provides information on how to enable TDE (Transparent Data Encryption) in the 
database. This section consists of the following sub sections:

• Configuring Software Keystore and Encrypted Tablespace Creation

• Running the Schema Creator Utility

• Testing the Encryption

Configuring a Software Keystore and Encrypted Tablespace Creation
A software keystore is a container for the TDE master encryption key, and it resides in the 
software file system. You must define a location for the key in the sqlnet.ora file so that the 
database locates the keystore (one per database) by checking the keystore location in the 
sqlnet.ora file. After defining the location, create the keystore and open it. Set the TDE master 
key after opening it and then encrypt the data.

To find whether a wallet is already existing, check the following entries:

1. The location specified by the ENCRYPTION_WALLET_LOCATION parameter in the 
sqlnet.ora file.

https://docs.oracle.com/cloud/latest/db121/ASOAG/toc.htm
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2. The location specified by the WALLET_LOCATION parameter in the sqlnet.ora file.

Encrypted tablespaces can share the default database wallet. However, Oracle recommends that 
you use a separate wallet for transparent data encryption functionality by specifying the 
ENCRYPTION_WALLET_LOCATION parameter in the sqlnet.ora file.

Note: You should have proper privileges to perform the following actions.

For details to configure the software keystore, perform the following steps:

1. Set the Software keystore location in the sqlnet.ora file.

The first step is to designate a location for software keystore in the sqlnet.ora file. The 
Oracle Database will check the sqlnet.ora file for the directory location of the keystore to 
determine whether it is a software keystore or a hardware module security (HSM) keystore.

Note: Ensure that the directory location which you want to set for software 
keystore exists beforehand. Preferably, this directory should be empty.

In a multitenant environment, the keystore location is set for the entire 
multitenant container database (CDB), not for individual pluggable databases 
(PDBs).

By default, the sqlnet.ora file is located in the ORACLE_
HOME/network/admin directory or in the location set by the TNS_ADMIN 
environment variable. Ensure that you have properly set the TNS_ADMIN 
environment variable to point to the correct sqlnet.ora file.

To create a software keystore on a regular file system, use the following format when you 
edit the sqlnet.ora file:

ENCRYPTION_WALLET_LOCATION=

  (SOURCE=

    (METHOD=FILE)

    (METHOD_DATA=

    (DIRECTORY=<<path to keystore>>)))

Examples:

For regular file system in which the database name is orclb:

ENCRYPTION_WALLET_LOCATION=

  (SOURCE=

   (METHOD=FILE)

    (METHOD_DATA=

     (DIRECTORY=/etc/ORACLE/WALLETS/orcl)))

When multiple databases share the sqlnet.ora file:

ENCRYPTION_WALLET_LOCATION=

  (SOURCE=

   (METHOD=FILE)

    (METHOD_DATA=
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     (DIRECTORY=/etc/ORACLE/WALLETS/orcl)))

When Oracle Automatic Storage Management (ASM) is configured:

ENCRYPTION_WALLET_LOCATION=

 (SOURCE=

  (METHOD=FILE)

   (METHOD_DATA=

    (DIRECTORY=+disk1/mydb/wallet)))

For ASM Diskgroup:

ENCRYPTION_WALLET_LOCATION=

 (SOURCE=

  (METHOD=FILE)

   (METHOD_DATA=

    (DIRECTORY=+ASM_file_path_of_the_diskgroup)))

2. Create the Software Keystore.

There are three different types of Software Keystores:

• Password-based Software Keystores

• Auto-login Software Keystores

• Local Auto-login Software Keystores

Perform the following steps to create a software keystore:

1. Login as sysdba or user with ADMINISTER KEY  MANAGEMENT or SYSKM 
privilege.

2. Use the following command to create password-based software keystore:

CONN sys/password@serviceid AS SYSDBA

ADMINISTER KEY MANAGEMENT CREATE KEYSTORE 'keystore_
location' IDENTIFIED BY software_keystore_password;

keystore_location is the path of the keystore directory you want to create.

software_keystore_password is the password of the keystore that you want to create.

For example, to create the keystore in the /etc/ORACLE/WALLETS/orcl directory:

ADMINISTER KEY MANAGEMENT CREATE KEYSTORE 
'/etc/ORACLE/WALLETS/orcl' IDENTIFIED BY password;

After you run this statement, the ewallet.p12 file, which is the keystore, appears in the 
keystore location.

• Alternatively, you can create an Auto-Login or Local-Login Keystore to avoid opening 
the Keystore manually every time. Use the following command:

ADMINISTER KEY MANAGEMENT CREATE [LOCAL] AUTO_LOGIN 
KEYSTORE FROM KEYSTORE 'keystore_location' IDENTIFIED BY keystore_
password;

LOCAL enables you to create a local auto-login software keystore. Otherwise, omit 
this clause if you want the keystore to be accessible by other computers.

After you run this statement, the cwallet.sso file appears in the keystore location.



Note: It is important to remember the master key password (<keystore_
password>) used during creation of the keystore. There are no ways to 
retrieve the password if forgotten.
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3. Open the Software Keystore

Depending on the type of keystore you create, you must manually open the keystore before 
you can use it.

You do not need to manually open auto-login or local auto-login software keystores. These 
keystore are automatically opened when it is required, that is, when an encryption 
operation must access the key. If necessary, you can explicitly close any of these types of 
keystores. You can check the status of whether a keystore is open, closed, open but with no 
master key, or open but with an unknown master key by querying the STATUS column of 
the V$ENCRYPTION_WALLET view.

Note: After you open a keystore, it remains open until you manually close 
it. Each time you restart a database instance, you must manually open the 
password keystore to re-enable encryption and decryption operations.

Perform the following steps to open the software wallet:

1. Login as sysdba or user with ADMINISTER KEY  MANAGEMENT or SYSKM 
privilege.

2. Use the following command to open password-based software keystore:

CONN sys/password@serviceid AS SYSDBA

ADMINISTER KEY MANAGEMENT SET KEYSTORE OPEN IDENTIFIED BY 
software_keystore_password [CONTAINER = ALL | CURRENT];

software_keystore_password is the same password that you used to create the 
keystore in "Step 2: Create the Software Keystore".

CONTAINER is for use in a multitenant environment. Enter ALL to set the keystore 
in all of the PDBs in this CDB, or CURRENT for the current PDB.

Note: In a CDB, open the Keystore in the ROOT (CDB$ROOT) container 
and in all the associated PDBs, where TDE is enabled.

You do not need to manually open auto-login or local auto-login software 
Keystores.

4. Set the Software TDE Master Encryption Key

Once the keystore is open, you can set a TDE master encryption key for it. The TDE 
master encryption key is stored in the keystore. This key protects the TDE table keys and 
tablespace encryption keys. By default, the TDE master encryption key is a key that 
Transparent Data Encryption (TDE) generates.

In a multitenant environment, you can create and manage the TDE master encryption key 
from either the root or the PDB.

Ensure that the database OPEN_MODE is set as READ WRITE. To find the status for a 
non-multitenant environment, query the OPEN_MODE column of the V$DATABASE 
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dynamic view. If you are using a multitenant environment, then query the V$PDBS view. 
(If you cannot access these views, then connect as SYSDBA and try the query again. In 
order to connect as SYSKM for this type of query, you must create a password file for it. 
See Oracle Database Administrator's Guide for more information.)

Perform the following steps to set the encryption key:

1. Login as sysdba or user with ADMINISTER KEY MANAGEMENT or SYSKM 
privilege.

2. Use the following command to set the encryption key:

CONN sys/password@serviceid AS SYSDBA

ADMINISTER KEY MANAGEMENT SET KEY [USING TAG 'tag'] 
IDENTIFIED BY password [WITH BACKUP [USING 'backup_
identifier']] [CONTAINER = ALL | CURRENT];

tag is the associated attributes and information that you define. Enclose this setting in 
single quotation marks (' ').

password is the mandatory keystore password that you created when you created the 
keystore in "Step 2: Create the Software Keystore".

WITH BACKUP creates a backup of the keystore. You must use this option for 
password-based keystores. Optionally, you can use the USING clause to add a brief 
description of the backup. Enclose this description in single quotation marks (' '). This 
identifier is appended to the named keystore file (for example, ewallet_time_stamp_
emp_key_backup.p12, with emp_key_backup being the backup identifier). Follow the 
file naming conventions that your operating system uses.

CONTAINER is for use in a multitenant environment. Enter ALL to set the key in all 
of the PDBs in this CDB, or CURRENT for the current PDB.

For example,

ADMINISTER KEY MANAGEMENT SET KEY IDENTIFIED BY password 
WITH BACKUP USING 'emp_key_backup';

5. Encrypting your Data

After completing the keystore configuration, encrypt the data. You can encrypt individual 
columns in a table or entire tablespaces. OFSAA recommends encrypting entire 
tablespaces and the description in this section covers encrypting entire tablespaces.

Note the following restrictions on using Transparent Data Encryption when you encrypt a 
tablespace:

• Transparent Data Encryption (TDE) tablespace encryption encrypts or decrypts data 
during read and write operations, as compared to TDE column encryption, which 
encrypts and decrypts data at the SQL layer. This means that most restrictions that 
apply to TDE column encryption, such as data type restrictions and index type 
restrictions, do not apply to TDE tablespace encryption.

• To perform import and export operations, use Oracle Data Pump.

Encrypting data involves the following steps:

Step 1: Setting the COMPATIBLE initialization parameter for tablespace encryption.

Step 2: Setting the tablespace TDE master encryption key.

Step 3: Creating the Encrypted Tablespace.

• Step 1: Setting the COMPATIBLE initialization parameter for tablespace encryption
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Prerequisite- You must set the COMPATIBLE initialization parameter for the database 
to 11.2.0.0 or later. Once you set this parameter to 11.2.0.0, the change is irreversible.

Perform the following steps to set the COMPATIBLE initialization parameter:

1. Log into the database instance. In a multitenant environment, log into the PDB.

2. Check the current setting of the COMPATIBLE parameter.

For example:

Table R–1 SHOW PARAMETER COMPATIBLE

Name Type Value

compatible string 12.0.0.0

noncdbcompatible BOOLEAN FALSE

3. If you want to change the COMPATIBLE parameter, perform the following steps:

a. Locate the initialization parameter file for the database instance.

UNIX systems: This file is in the ORACLE_HOME/dbs directory and is named 
initORACLE_SID.ora (for example, initmydb.ora).

b. In SQL*Plus, connect as a user who has the SYSDBA administrative privilege, and 
then shut down the database.

For example:

CONNECT /AS SYSDBA

SHUTDOWN

c. Edit the initialization parameter file to use the correct COMPATIBLE setting.

For example:

COMPATIBLE = 12.2.0.0

d. In SQL*Plus, ensure that you are connected as a user who has the SYSDBA 
administrative privilege, and then start the database.

For example:

CONNECT /AS SYSDBA

STARTUP

e. If tablespace encryption is in use, then open the keystore at the database mount. The 
keystore must be open before you can access data in an encrypted tablespace.

STARTUP MOUNT;

ADMINISTER KEY MANAGEMENT SET KEYSTORE OPEN IDENTIFIED BY 
password;

ALTER DATABASE OPEN;

• Step 2: Setting the tablespace TDE master encryption key

Make sure that you have configured the TDE master encryption key as shown in Step 
4: Setting the software TDE master encryption key.

• Step 3: Creating the Encrypted Tablespace

After you have set the COMPATIBLE initialization parameter, you are ready to create 
the encrypted tablespace.
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Follow the instruction given in Running the Schema Creator Utility with Encryption 
section for configuring the schema creator file to create tablespaces. 

If you are enabling TDE in case of upgrade or you did not enable it during installation 
and want to enable at a later point of time, see the following reference link for details 
on manually creating encrypted tablespaces:

https://docs.oracle.com/cloud/latest/db121/ASOAG/asotrans_
config.htm#ASOAG9555

Running the Schema Creator Utility with Encryption
This section is applicable only if you want to enable TDE during installation.

Run the schema creator utility by including the encrypt=on option in the Tablespace tag in the 
<<APP PACK>>_SCHEMA_IN.xml file. You have to perform this procedure manually as it is 
not a part of the <<APP PACK>>_SCHEMA_IN.xml.TEMPLATE originally.

Following is an example for OFS _AAAI_PACK_ SCHEMA_IN.xml 

<APPPACKSCHEMA>

<APP_PACK_ID>OFS_AAAI_PACK</APP_PACK_ID>

<JDBC_URL>jdbc:oracle:thin:@<DB_Server_IP>:1521:<DB_NAME></JDBC_
URL>

<JDBC_DRIVER>oracle.jdbc.driver.OracleDriver</JDBC_DRIVER>

<HOST><OFSAA_Server_IP/HOST Name></HOST>

<SETUPINFO NAME="<PREFIX_NAME>" PREFIX_SCHEMA_NAME="Y"/>

<PASSWORD APPLYSAMEFORALL="Y" DEFAULT="<PASSWORD>"/>

<TABLESPACES>

<TABLESPACE NAME="OFS_AAI_TBSP" VALUE="TS_USERS1" 
DATAFILE="<ABSOLUTE PATH to TABLESPACE>/<TABLESPACE_DATA_FILE_
NAME>.dbf" SIZE="500M" AUTOEXTEND="OFF" ENCRYPT="ON" />

</TABLESPACES>

<SCHEMAS>

<SCHEMA TYPE="CONFIG" NAME="ofsaaconf" PASSWORD="" APP_ID="OFS_
AAI" DEFAULTTABLESPACE="##OFS_AAI_TBSP##" TEMPTABLESPACE="TEMP" 
QUOTA="unlimited"/>

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" APP_ID="OFS_
AAAI" DEFAULTTABLESPACE="##OFS_AAI_TBSP##" TEMPTABLESPACE="TEMP" 
QUOTA="unlimited" INFODOM="OFSAAAIINFO"/>

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" APP_ID="OFS_
IPE" DEFAULTTABLESPACE="##OFS_AAI_TBSP##" TEMPTABLESPACE="TEMP" 
QUOTA="unlimited" INFODOM="OFSAAAIINFO"/>

</SCHEMAS>

</APPPACKSCHEMA>

Testing the Encryption
Test the encryption by checking if a tablespace is encrypted or not. Execute the following query 
to check:

https://docs.oracle.com/cloud/latest/db121/ASOAG/asotrans_config.htm#ASOAG9555
https://docs.oracle.com/cloud/latest/db121/ASOAG/asotrans_config.htm#ASOAG9555
https://docs.oracle.com/cloud/latest/db121/ASOAG/asotrans_config.htm#ASOAG9555
https://docs.oracle.com/cloud/latest/db121/ASOAG/asotrans_config.htm#ASOAG9555
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SELECT tablespace_name, encrypted FROM dba_tablespaces;

The following result is displayed, which indicates whether the TABLESPACE is encrypted or 
not   in the ENCRYPTED 

Table R–2 

TABLESPACE_NAME ENCRYPTED

SYSTEM                        No

SYSAUX                        No

UNDOTBS1                    No

TEMP                        No

USERS                        No

ENCRYPTED_TS                   No

6 rows selected.

column:

The above example indicates TABLESPACE  ENCRYPTED_TS is created with Encryption 
ON.

Configuring TDE in case of Upgrade
This section details about the configurations required in case you want to enable TDE in 
OFSAA applications after upgrade to OFSAA 8.0.7.0.0 version from a previous version. 
Additionally, these configurations are required in case you did not enable TDE during 8.0.7.0.0 
installation and want to enable at a later point of time.

1. Create a new PDB (12c)/ instance (11g) on same or different Database Server for TDE. For 
more information, see Configuring a Software Keystore and Encrypted Tablespace 
Creation.

2. Shutdown the OFSAAI Services

3. Export all Configuration, Atomic and Sandbox Schemas as per the applications installed in 
your OFSAA instance.

For example:

expdp SYSTEM/oracle@OFSA12C2DB  DIRECTORY=data_pump_dir 
DUMPFILE=ofsaaconf_ofsaaatm_%U.dmp filesize=2G 
SCHEMAS=ofsaaconf,ofsaaatm LOGFILE=ofsaaconf_ofsaaatm_exp.log

Note: The above command will create data dumps as files of 2GB size each 
(multiples). Any other commands/ tools as appropriate may be used to 
archive the schemas.

4. Import all schemas that are exported using the above command, into the new DB instance.

For example:

impdp SYSTEM/oracle@OFSA12nDB  DIRECTORY=data_pump_dir 
DUMPFILE=ofsaaconf_ofsaaatm_%U.dmp  
SCHEMAS=ofsaaconf,ofsaaatm LOGFILE=ofsaaconf_ofsaaatm_imp.log



Note: Restoring the exported dumps creates Configuration and Atomic 
Schema(s) with the same user credentials as that of the source, along with the 
existing grants. 

If schemas are restored using a tool/ mechanism other than as mentioned in 
the Step 1 and 2, retain the user credentials of Configuration and Atomic 
Schemas same as in the Source environment, along with the Schema grants.
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5. Provide select grants on sys.V_$parameter to view Configuration and Atomic 
Schemas of Target Environment database.

For example:

Login as sys user:

SQL> GRANT SELECT ON SYS.V_$PARAMETER TO ofsaaconf;

Grant succeeded

SQL> GRANT SELECT ON SYS.V_$PARAMETER TO ofsaaatm;

Grant succeeded

6. Update .profile for ORACLE_SID environment variable with new ORACLE_SID.

7. Update JDBC URL by executing Port Changer utility. For details on how to execute Port 
Changer utility, see Changing IP/ Hostname, Ports, and Deployed Paths of OFSAA 
Instance section.

8. Navigate to the $FIC_WEB_HOME directory and execute the following command to 
trigger the creation of EAR/WAR file:

./ant.sh

9. The EAR/WAR file - <contextname>.ear/.war - is created in $FIC_WEB_HOME 
directory.

10. On completion of EAR/WAR file creation, the message "BUILD SUCCESSFUL" will be 
displayed.

11. Edit the existing Connection Pool settings to point to new JDBC URL and verify 
connections.

12. Clear the webserver cache and redeploy the application onto your configured web 
application server.

13. Restart the OFSAA Services. For more information, refer to the Starting OFSAA 
Infrastructure Services section.

Data Redaction
OFSAA is enhanced to enable masking of sensitive data and Personal Identification 
Information (PII) to adhere to Regulations and Privacy Policies. Oracle Data Redaction 
provides selective, on-the-fly redaction of sensitive data in database query results prior to 
display by applications so that unauthorized users cannot view the sensitive data. The stored 
data remains unaltered, while displayed data is transformed to a pattern that does not contain 
any identifiable information.
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Enabling Data Redaction in case of Upgrade
This section details about the configurations required in case you want to enable Data 
Redaction in OFSAA applications after upgrade to OFSAA 8.0.7.0.0 version from a previous 
version. Additionally, these configurations are required in case you did not enable TDE during 
OFS AAAI 8.0.7.0.0 installation and want to enable at a later point of time.

Perform the following steps:

1. Login as SYSDBA into the database.

2. Execute the file $FIC_HOME/utility/data_security/scripts/create_data_sec_roles.sql only 
once per database (PDB in case of 12c).

3. Execute the following sql statement to find out the list of atomic users from the table:

select v_schema_name from aai_db_detail where V_DB_NAME <> 
'CONFIG' AND V_DB_TYPE = 'ORACLE'

4. Execute the file $FIC_HOME/utility/data_security/scripts/grant_
data_sec_roles.sql for all atomic users found in the previous step.

5. From the Configuration window in the System Configuration module, select the Allow 
Data Redaction check box.

6. Run the Data Redaction utility. For more details on how to run the utility, see Data 
Redaction section under Data Security and Data Privacy chapter in OFS Analytical 
Applications Infrastructure Administration Guide.

https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAAI_Administration_Guide_8.0.6.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAAI_Administration_Guide_8.0.6.0.0.pdf
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SFAQs and Error Dictionary

This section of the document consists of resolution to the frequently asked questions and error 
codes noticed during OFSAAI installation.

• Frequently Asked Questions

• Application Pack FAQs

• Error Dictionary

OFSAAI installer performs all the prerequisite validation check during installation. Any errors 
encountered in the process is displayed with an appropriate Error Code. You can refer to the 
Error Dictionary to find the exact cause and resolution to rectify the error.

Frequently Asked Questions
You can refer to the Frequently Asked Questions which has been developed with the interest to 
help you resolve some of the OFSAAI Installation and configuration issues. This intends to 
share the knowledge of problem resolution to a few of the known issues. This is not an official 
support document and just attempts to share the knowledge of problem resolution to a few of 
the known issues. 

This section includes the following topics: 

• OFSAAI FAQs

• Application Pack FAQs

• Forms Framework FAQs

OFSAAI FAQs
What are the different components that get installed during OFSAAI?

The different components of OFSAAI are illustrated in Figure 1–2, "Components of 
OFSAAI".

What are the different modes of OFSAAI installation?

OFSAAI can be installed in two modes, Silent Mode, and GUI mode.

Can the OFSAA Infrastructure components be installed on multi-tier?

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on 
multi-tier. By default, they will be installed on single-tier. However, OFSAA Infrastructure 
can be deployed within the n-Tier architecture where the Database, Web Server and Web 
Application Server is installed on separate tiers.
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Is JDK (Java Development Kit) required during installation of OFSAA? Can it be 
uninstalled after OFSAA installation?

JDK is not required during  installation of OFSAA and only a run time is needed for 
details. Refer Hardware and Software Requirements, Java Runtime Environment section.

Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI 
installation?

Only JRE (Java Runtime Environment) is required during installation of OFSAA and 
cannot be uninstalled as the JRE is used by the OFSAA system to work.

How do I know what is the  Operating system, webservers and other software versions that 
OFSAA supports?

Refer to OFSAA Technology Stack Matrices.

What are the different files required to install OFSAAI?

The following files are required:

• setup.sh.

• envCheck.sh

• preinstallcheck.sh

• VerInfo.txt

• OFSAAInfrastructure.bin

• validatedXMLinputs.jar

• MyResources_en_US.properties

• log4j.xml

• OFSAAI_PostInstallConfig.xml

• OFSAAI_InstallConfig.xml

• privileges_config_user.sql

• privileges_atomic_user.sql

What should I do if I get the following error message during installation, "Execute 
Permission denied"?

Please check whether all the files provided for OFSAAI installation has execute  
permissions. 

To give execute permissions,

• Navigate to the path OFSAAI_80200 and execute the command

chmod 755

"Graphical installers are not.."

If error resembles "Graphical installers are not supported by the VM. The console mode 
will be used instead..." then check whether any of the X-windows software has been 
installed.

Example: Hummingbird Exceed is started and configured to Graphical mode installation.

Note: Type 'xclock' from prompt and this should display clock in 
graphical mode.

http://docs.oracle.com/cd/E55339_01/homepage.htm
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"No Java virtual machine could be…"

If the error message reads "No Java virtual machine could be found from your PATH 
environment variable. You must install a VM prior to running this program", then 

• Check whether "java path" is set in PATH variable. See the  Table 3–1, " Prerequisite 
Information"section in this document.

• Check whether sufficient temporary space is available.

• Ensure that the movement of OFSAAI Installer text files to the target system is done 
in the Text mode so that setup.sh file does not contain control line feed characters 
(^M).

What should I do if I get the following error message during installation, "OracleDriver 
Files Not Found, Please Choose the Right Path To Continue"?

Check whether the provided path for Oracle Driver files is correct and whether the user has 
permissions to access the files.

What should I do if I get the following error message during installation, "User must have 
CREATE TABLE, CREATE VIEW, CREATE TRIGGER, CREATE INDEX, CREATE 
SEQUENCE, CREATE PROCEDURE" even though the oracle schema user created has the 
mentioned privileges?

OFSAAI installer validates the database details provided during installation, so ensure:

• Whether the oracle schema user has the required set of privileges for successful 
installation.

• Whether the oracle schema user has been created with quota privileges on tablespace 
to create database objects.

See the  Table 3–1, " Prerequisite Information"section in this document.

Installation of OFSAAI was completed successfully! What next?

Post the successful completion of OFSAAI installation, one has to perform the Post 
Installation steps. See Chapter 6, "Post Installation Configuration". 

What is to be done when OFSAAI Installation is unsuccessful?

OFSAAI installer generates log file OFSAAInfrastructure_Install.log in the 
Infrastructure Installation Directory. There is also another log file created in the path 
configured in Log4j.xml. The logs of any of these reported, Warnings/Non Fatal 
Errors/Fatal Errors/Exceptions should be brought to the notice of the OFSAAI Customer 
Support. It is recommended not to proceed, until the reported problems are adequately 
addressed.

How do I completely uninstall OFSAAI?

OFSAAI can be completely uninstalled by performing the steps provided in Uninstalling 
OFSAA Infrastructure in the OFS AAAI Installation and Configuration Guide.

Can OFSAAI config and atomic schemas be on different databases?

OFSAAI requires both config and atomic schemas to be present on the same database 
instance. 

How to grant privileges if a new information domain is created?

If you are creating a new information domain, provide a set of privileges (database 
permissions) to the new Atomic schema.

• Log into the database as sys and connect as sysdba user.
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• Execute the file privileges_config_user.sql available under $FIC_HOME 
directory

• Enter the database schema for which you want to grant privileges.

When should I run the MLS utility?

See the Multiple Language Support (MLS) Utility section in OFS AAI Administration 
Guide available on OHC Documentation Library.

Does OFSAAI support Oracle Linux versions other than 5.5?

OFSAAI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0 and 
above.

What should I do if I get the following error message on the UNIX System terminal while 
executing ./setup.sh, "Insert New Media. Please insert Disk1 or type its location"?

1. Login as root user on the Unix machine where OFSAAI is getting installed.

2. Navigate to the path /etc/security/. 

3. Edit the file limits.conf to add/edit a row for the unix user installing OFSAA:

<Unix User> soft nofile 9216

4. After saving the changes, log in as unix user with which OFSAAI is getting installed 
and execute the command:

ulimit -n

The command should return the value 9216.

How do I verify if the system environment is ready for OFSAAI installation?

To verify the system environment meets the minimum requirements for the installation, a 
Pre-Install Check utility is available within the Install Kit archive file. This utility can also 
be obtained separately by contacting Oracle Support.

See Verifying System Environment section for additional information. 

How do I know if  the installation is completed successfully? 

The OFSAA Infrastructure installation performs a post install health check automatically 
on successful installation of the product. To rerun the post install verification at a later 
time, perform the following steps:

1. Navigate to the path $FIC_HOME (Product Installation Directory).

2. Execute the command:

./piverify.sh

What should I do if the installation in GUI mode is not invoked?

There are set of configuration steps required to be performed during  the installation in 
GUI mode. Verify whether the steps mentioned under Configuration for GUI Mode 
Installation section are done correctly. 

What should I do if there are any exceptions or errors in installation and how to proceed?

1. Please backup the installation logs.

2. Share the backup logs with Oracle support.

What should I do if I get the following error message during OFSAAI installation on Solaris 
11 system?:

"Error: OFSAAI-1108

http://docs.oracle.com/cd/E60058_01/homepage.htm
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ORA-00604: error occurred at recursive SQL level 1

ORA-01882: timezone region not found"

Or

"Time zone cannot be set as null or 'localtime' "

This happens if the time zone is not set, that is NULL or it is set as ’localtime’. Set the 
environment variable TZ to a valid time zone region in the .profile file. For example, 

TZ=Asia/Calcutta

export TZ

What should I do if the installation process is abruptly terminated or aborted?

If the installation is abruptly terminated, then the installation process will be incomplete. 
To recover from this, follow these steps:

1. Drop the DB objects in the config schema created by OFSAAI installation.

2. Open the .profile and remove the entries made by the OFSAAI installation which 
are made between the comment statements, #Beginning of entries by OFSAA 
Infrastructure installation and #End of entries by OFSAA Infrastructure installation.

3. Delete the OFSAA install directory created by the OFSAAI installer.

4. Perform the OFSAAI installation again. 

Does OFSAA support any other web server types, other than the ones stated in tech matrix 
and installation guide?

No, all the supported softwares and versions are stated in the  OFSAA Technology Stack 
Matrices. 

What should I do if the database connection from connection pool displays the following 
error message, "java.sql.SQLRecoverableException: IO Error: Connection reset"?

This happens while running several database intensive tasks in parallel. To correct this 
error, add the line securerandom.source=file:/dev/./urandom in the 
java.security configuration file available in $JAVA_HOME/jre/lib/security/ path.

Note: This needs to be configured on all the machines or VMs where the 
OFSAAI components are installed.

If the issue is not resolved even with the preceding settings, check the MTU(Maximum 
Transmission Unit) settings on the linux box. For details on MTU settings and updating 
them, contact your system Administrator.

What should I do when I get syntax errors/file not found error messages while invoking 
setup.sh file from my install archive?

This could mostly  happen:

• When installer was not unzipped rightly or corrupted during unzip.

• setup.sh file which resides within the install archive was  not transferred in ASCII or 
text mode, which could have corrupted the file.

To correct this, follow the steps:

1. Copy the installer (in BINARY mode) to the system on which the OFSAA 
Infrastructure components will be installed.

http://docs.oracle.com/cd/E55339_01/homepage.htm
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2. Unzip the installer using the command:

unzip <OFSAAI_Installer>.zip

3. The corrupted setup.sh file would have introduced certain ^M characters into the 
file. You can remove ^M characters from setup.sh file by following these steps:

Note: To enter ^M, hold the CTRL key then press V and M in succession.

a. Login to the server where the installer is copied.

b. Navigate to the directory OFSAAI_80200.

c. Open the setup.sh file in the vi editor using the command: vi setup.sh.

d. Inside vi editor in Esc mode, type: %s/^M//g 

e. Save the setup.sh file by typing: wq!

Does OFSAA support Oracle DB 11g Standard edition?

The OCI client and the jdbc driver does not change depending on whether it is a standard 
or enterprise edition. So, OFSAAI will work with standard edition as well.

We do not recommend standard edition because it will not scale and  does not support 
partition pack, database security vault, or advanced analytics.

What should I do if I get the following error message while executing ./startofsaai.sh file on 
the UNIX System terminal "./startofsaai.sh: /java: Execute permission denied"?

• Ensure JAVA_BIN environment variable path is set on the "unix user" terminal from where 
the startofsaai.sh file is invoked.

• Ensure the .profile where the environment/ path settings are made has been 
executed successfully.

What happens when the OFSAAI Application Server does not proceed even after providing 
the system password?

Ensure that, the System Password provided when prompted should match with the "Oracle 
Configuration password" provided during installation. Also check whether the connection 
to the "configuration schema" can be established through sqlplus.

Although the OFSAAI installation has completed successfully, when OFSAAI servers are 
started, and the application URL is accessed, it gives an error message "the page cannot be 
found or displayed" or "Could not retrieve list of languages from Server. Please contact the 
system administrator". What should one do?

Ensure OFSAAI servers have been started and are running successfully. On the server start 
up parameters options, refer Starting Infrastructure Services section.

For more details on the issue, refer on to the Revappserver log in $FIC_APP_ 
HOME/common/FICServer/logs directory or the Web Server log files.

Is it necessary to provide the specified grants to the Oracle schema user before 
installation? If yes, can it be revoked after completing the installation?

The "Oracle schema" user requires the necessary grants specified before, during, and after 
the installation process. Grants provided should never be revoked as the application makes 
use of these grants all the time.

Can we have distributed OFSAAI Application Server for load balancing?
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OFSAAI Application server can be scaled out/distributed across different JVM's 
(machines) based on the various services and Information Domains, in other words, Load 
balancing could be achieved with distribution of services.

Why do we need Ftpshare on all the layers? Can we have ftpshare on another machine other 
than the machines where OFSAAI is installed?

Ftpshare is a Metadata Repository directory. All the metadata related files used in 
Infrastructure are stored in the ftpshare directory. The ftpshare contains folders for each 
Information Domain, with each Information Domain folders holding Erwin, log, and 
scripts folder. The transfer of data among the Web, Application, and Database servers in 
Infrastructure takes place through FTP/SFTP.

You need to configure FTP/SFTP and enable communication between the servers by 
providing App server's FTP/SFTP credentials to the Web server and DB server users.

Yes, we can have ftpshare on another machine other than the machines where OFSAAI is 
installed.

Is it mandatory to provide the ftp/sftp password? 

Yes, OFSAAI needs credentials of the user which has complete permissions on ftpshare 
directory, and should be able to independently login to the unix server.

What are the permissions required for ftpshare and when should I give them?

It is recommended to provide  permissions on ftpshare in case of  installations done across 
different machines or VMs (multitier installation).

In case of single tier installation, 770 permissions can be provided if the unix users of 
OFSAAI and web server belong to the same unix group.

And on any new file that is created in the 'ftpshare' folder of any installation layer should 
be granted specific/explicit permission.

Port Change utility could be used to have the Port number modified, which are currently 
being used by the Infrastructure application. For more information, refer  Changing IP/ 
Hostname, Ports, and Deployed Paths of OFSAA Instance section.

Are there any in-built system administration users within OFSAAI Application?

The three in-built system administration users are provided to configure and setup 
OFSAAI.

• SYSADMN 

• SYSAUTH

• GUEST 

Does OFSAAI Application support both FTP and SFTP?

OFSAAI supports both FTP and SFTP configuration.

Is it necessary to enable the FTP/SFTP services to use the OFSAAI?

Yes, enabling of FTP/SFTP services and its ports is a pre-requisite step towards using the 
OFSAAI.

OFSAAI Configuration: Unable to save the server details?

• Ensure the input User ID, Password, and Share Name are correct.

• Ensure FTP/SFTP services are enabled.

• Have a test FTP/SFTP connection made and confirm if they are successful.
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What should I do if I get the following message while creating Information Domain, "Please 
create a database and then create the information domain"?

Information Domain is mapped to only one Database; and thus before the creation of 
Information Domain, at least one database details would need to exist.

What should I do if I get the following message during the startup of backend engine 
message server, "ConnectToDatabase: FatalError, could not connect to the DB server"?

• Verify whether connection to the "configuration schema" can be established through 
sqlplus.

• Verify "configuration schema" password is modified post installation.

• Ensure oracle database alias name created for oracle instance and oracle service name 
are same.

• On a multi tier Installation mode, ensure TNSNAME and SID are the same in both the 
Application and Database Layers.

What should I do if I get the following message during the startup of backend engine 
message server, "Fatal Error, failed to get user ID from LibSmsConnect"?

Ensure Reveleus.sec file exist under the $FIC_HOME/conf directory where the Database 
components are installed.

Does OFSAAI Application support LDAP authentication?

OFSAAI supports LDAP configuration and authentication.

Does OFSAAI support multiple languages?

Yes, OFSAAI supports multiple languages.

Does OFSAAI provide any data back-up features?

OFSAAI does not have built-in back up facility. External Storage Infrastructure is 
recommended for back-up.

What kind of security features does the OFSAAI provide?

OFSAAI provides security at:

• Segment Level - Users can access only the segment they are mapped to.

• Application Level - Users can perform an operation only if mapped to appropriate role 
and functions.

Does OFSAAI have the ability to enforce periodic password change?

OFSAAI provides configurable parameters to define number of days after which the user 
password would expire and then the user is forced to change the password after expiration 
period.

What is the password policy followed in OFSAAI?

OFSAAI enforces a minimum password length with a combination of Upper and Lower 
case characters and alpha-numeric strings.

Which version of Erwin Data Modeller does OFSAAI support?

OFSAAI now supports ERwin version 9.6 generated xmls.

Does OFSAAI provide the mechanism to upload Business Data model?

OFSAAI provides two mechanisms for business data model upload:

• Easy to use GUI based Model upload mechanism to upload the Business Data Model 
through Unified Metadata Manager --> Import Model.
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• OFSAAI also provides a model upload utility "upload.sh" for uploading the business 
data model through the command line parameter by executing this shell script file 
under the path <FIC_HOME>/ficapp/common/FICServer/bin.

Refer the section Run Model Upload Utility of the OFS Analytical Applications Infrastructure 
User Guide available on  OHC Documentation Library for details.

How do I apply incremental change to the existing model when the Business Data model 
undergoes a change?

Modified data model can be uploaded into the system and OFSAAI has the ability to 
compare the changes within the data model with respect to the one already present in the 
system and enables propagation of incremental changes in a consistent manner.

What are the different types of uploading a business data Model? 

OFSAAI supports uploading of business data model from client desktop and also by 
picking up the data model from the server location.

Can the OFSAAI "Configuration Schema" password be modified post installation?

The OFSAAI "configuration schema" password can be modified post installation. OFSAAI 
application stores the password in the database and few configuration files, thus any 
changes to the "configuration schema" password would necessitate updating in these. 
Contact OFSAAI support for more details.

Can the OFSAAI "Atomic  Schema" password be modified?

The OFSAAI "Atomic Schema" password can be modified. OFSAAI application stores the 
atomic schema password in the database and few configuration files, thus any change to 
the atomic schema password would necessitate updating the password.

To change the Atomic Schema password, follow the steps:

1. Login to OFSAA.

2. Navigate to System Configuration > Database Details window. Select the appropriate 
connection, provide the modified password and save.

3. Navigate to Unified Metadata Manager > Technical Metadata> Data Integrator > 
Define Sources window. Update the appropriate Source details.

a. If you are using Apache Tomcat as Web server:

• Update the <Context> -> Resource tag details in server.xml file from the 
$CATALINA_HOME/conf folder. (In case of Tomcat only Atomic <Resource> will 
exist).

b. If you are using WebSphere as Web server:

• Login to the WebSphere Administration Console from the left side menu.

• Navigate to Resources >JDBC >Data Sources. A list of data sources will be 
populated on the right side.

• Select the appropriate Data Source and edit the connection details. (In this case, 
both Config and Atomic data sources need to be modified).

c. If you are using WebLogic as Web server:

• Login to the WebLogic Administration Console from the left side menu.

• Under Domain Structure list box, expand the appropriate Domain and navigate to 
Services > JDBC >Data Sources. A list of data sources will be populated on the 
right side.

http://docs.oracle.com/cd/E60058_01/homepage.htm
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• Select the appropriate Data Source and edit the connection details. (In this case, 
both Config and Atomic data sources need to be modified).

4. Restart the OFSAAI services

Note: If the modified passwords are not updated, OFSAAI logs displays 
the message ORA-28000: the account is locked.

 Does the upload of Business Data model depend on Java Memory?

Business data model upload through OFSAAI depends on the Java memory settings on the 
client and server machines. Java memory setting varies with the data model size and the 
available RAM. Contact OFSAAI support for more details.

Why do the Business Metadata Management screens (Business Processors screen) in User 
Interface, take more time to load than other screens?

The Log file in DynamicServices.xml which resides in $FIC_HOME/conf is 
continuously being updated/refreshed to cache metadata. This can be observed when you 
are starting startofsaai.sh and if any of the log file (Ex: SMSService.log) in 
DynamicServices.xml is being continuously refreshed for longer time.

By default, the Metadata Log file cache size is set to 1000. If in case the log is being 
updated beyond this limit, retrospectively the preceding entries are overwritten. For 
example, the 1001th entry is overwritten by deleting the first entry. This results in the 
application window taking a longer time to load.

Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf, 
depending on the currently logged count for the specific metadata.

1. Generate the Log report by executing the following query in config schema.

select count(1), t.metadata_name, m.dsn_id

from metadata_master m, metadata_type_master t 

where m.metadata_type = t.metadata_type

group by t.metadata_name, m.dsn_id

2. The preceding query returns a list of codes with their respective metadata count. You 
can refer to "metadata_type_master" table to identify the metadata name.

3. View the log report to identify the metadata which is being updated/refreshed beyond 
the specified cache size limit. Accordingly increase the cache size limit in 
Dynamicservices.xml depending on the currently logged count for the specific 
metadata.

For example, if the "MEASURE_CACHE_SIZE" is set to 1000 and total measure 
reported in log is 1022, increase the limit to 2000 (approximately).

4. Restart Reveleus/OFSAAI servers (Web and APP) and check the issue.

What should I do if I get OutOfMemoryError while deploying EAR file in WebSphere 
application server?

The Java memory needs to be increased in ejbdeploy.sh file which is present under 
<WebSphere Install directory>/AppServer/deploytool/itp. For example, 

$JAVA_CMD \

-Xbootclasspath/a:$ejbd_bootpath \ 

Xms256m -Xmx1024m \
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What configurations should I ensure if my data model size is greater than 2GB?

In order to upload data model of size greater than 2GB in OFSAAI Unified Metadata 
Manager- Import Model, you need to configure the required model size in struts.xml 
file available in the path $FIC_WEB_HOME/webroot/WEB-INF/classes.

Note: The size requirements have to be always specified in bytes.

For example, if you need to configure for model size of 2.5GB, then you can 
approximately set the max size to 3GB (3221225472 bytes) as follows, in order to avoid 
size constraints during model upload.

<constant name="struts.multipart.maxSize" value="3221225472"/>

After configuring struts.xml file, generate the application EAR/WAR file and redeploy 
the application onto your configured web application server. For more information on 
generating and deploying EAR / WAR file, refer Appendix C.

What should I do if my Hierarchy filter is not reflecting correctly after I make changes to the 
underlying Hierarchy?

In some cases, the Hierarchy Filters do not save the edits correctly if the underlying 
Hierarchy has been changed. This can occur in hierarchy maintenance, where you have 
moved a member to another hierarchy branch, and that member was explicitly selected in 
the Filter and is now a child of a node which is already selected in the Filter.

Please refer Support Note for the workaround.

Can I install an Application Pack on an existing Atomic schema/ Information Domain 
created manually?

No, you cannot install an Application Pack on existing Atomic schema/Information 
Domain created manually. Application Packs can be installed only on Atomic 
Schemas/Information Domain created using schema creator utility and/ or the Application 
Pack installer.

What should I do if I get the following exception while trying to view the model outputs in 
Model Outputs screen, "Exception ->Local Path/STAGE/Output file name (No such file or 
directory)"?

Ensure you have created a folder "STAGE" under the path mentioned as "Local Path" in 
the web server details window. This folder needs to be created under the local path on 
every node, in case of web application server clustering.

What should I do if I get the following exception during OFSAA services startup, "Exception 
in thread "main" java.lang.UnsatisfiedLinkError: net (Not a directory)"?

Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to 
point to a physical JRE installed.

What is the optimized memory settings required for "New" model upload?

The following table lists the optimized memory settings required for "New" model upload.

https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=536494621882321&id=1586342.1


Table S–1 Optimized Memory Settings for New Model Upload

Model Upload Options
Size of Data Model 
XML File

X_ARGS_APP ENV 
Variable in OFSAAI 
APP Layer

Pick from Server 106 MB "-Xms1024m 
-Xmx1024m

36 MB "-Xms2048m 
-Xmx2048m

815 MB "-Xms4096m 
-Xmx4096m

1243 MB "-Xms6144m 
-Xmx6144m

Model Upload Utility 106 MB "-Xms1024m 
-Xmx1024m"-Xms2048m 
-Xmx2048m

336 MB "-Xms4096m 
-Xmx4096m

815 MB "-Xms4096m 
-Xmx4096m

1243 MB "-Xms6144m 
-Xmx6144m

Save New Erwin File In 
Server

106 MB "-Xms1024m 
-Xmx1024m

336 MB "-Xms2048m 
-Xmx2048m

"-Xms4096m 
-Xmx4096m

"-Xms6144m 
-Xmx6144m
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I did not enable OFS Inline Processing Engine Application license during the installation. 
However, I have enabled it post installation, using the Manage OFSAA Product License(s) in the 
Admin UI. Are there any other additional configurations that I need to do?

Yes. Follow the instructions explained in the OFS Inline Processing Engine Configuration 
Guide available on  OHC Documentation Library.

I get an error when I try to build an Oracle OLAP cube. What should I do? 

Execute the following grant on the appropriate ATOMIC schema 
grant olap_user to &database_username

How do you turn off unused Information Domains (Infodoms) from caching?

Follow these steps to turn off unused infodoms from caching:

1. Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation.

2.  In the DynamicServices.xml file, identify the section for <Service code="20">. 

3. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1). 

4. Repeat the same in the WEB layer too. Generate the application EAR/WAR file and 
redeploy the application onto your configured web application server. For more 
information on generating and deploying EAR / WAR file, refer to the Appendix C section.

http://docs.oracle.com/cd/E60058_01/homepage.htm
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5. Restart the OFSAAI Services (APP and WEB). For more information, refer to the Starting 
Infrastructure Services section.

Note: This setting help cache the Infodom metadata only for the infodoms 
that get accessed after user login. Infodoms which are not accessed, are not 
cached. 

Sample code is as follows: 

<SERVICE CODE="20" 

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD" 

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10"> 

<PARAMETERS> 

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" /> 

<PARAMETER NAME="BACKUP_XML" VALUE="1" /> 

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" /> 

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" /> 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" /> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" /> 

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" /> 

</PARAMETERS> 

</SERVICE>

While creating an Excel Mapping, after specifying the excel worksheet, the target table, and 
mapping each column in the worksheet to a target table, I click SAVE and nothing happens. 
But when I click CANCEL, a message pops up informing me that all changes will be 
discarded", what is to be done.

Check if the version of Internet Explorer and JRE Plugin are as mentioned in the 
Desktop Requirements section of this manual. If not, use the qualified versions as 
mentioned.

Can Multiple OFSAA Infrastructure instances share the same config schema?

No, only one OFSAA environment can be installed using one config schema.
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Can Atomic schema be shared?

Yes, it can be shared between two OFSAA instances.

While setting a firewall, which ports should be opened for communication between the Web 
Server (Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP Server) and the Web 
Application Server (WebSphere/ WebLogic/ Tomcat) for OFSAAI to operate properly?

The OFSAA Servlet port which is same as Web server port should be open. Also the 
web application port should be open.

Can I modify the NLS_LENGTH_SEMANTICS to BYTE from CHAR for the Database 
where older versions of OFSAA is Installed?

Yes, NLS_LENGTH_SEMANTICS can be modified to BYTE from CHAR if you are 
not intending to use multi language support.

Can I install already installed application in a different infodom?

No, it is not possible to install the same application in two different infodoms.

How can I configure the OFSAA application for High Availability?

OFSAA can have active-passive high availability.  For more details, refer Configuration for 
High Availability- Best Practices Guide.

During OFSAA installation should I provide web application server's IP /Hostname and port 
or web server's IP/Hostname and port, if the Apache HTTP Server/ Oracle HTTP Server/ 
IBM HTTP Server are configured?

In case the web server is configured, you should enter the Web Server IP Address/Hostname 
and Port details during OFSAA installation. Here the Servlet port should be same as the Web 
Server port. 

If Web Server is not configured, the Web Application Server's IP Address/ Hostname

and Port is required during the installation process. Here the Servlet port should

be same as the Web application Server port.

Is "ReveleusAdminConsoleAgent" applicable for OFSAAI 8.0.0.0.0 and higher versions?

No, ReveleusAdminConsoleAgent is not applicable starting OFSAAI 7.3.3.0.0. There is 
a change in the way agentservers are managed through AGENTSTARTUP.SH & 
AGENTSHUTDOWN.SH.

What should I do when the message server process does not open and I get the following error 
message, "CI18NProvider::CI18NProvider, Error, unable to connect to the config database"?

This error is displayed due to the following reasons:

• The Config Schema password is already expired.

• If the config schema password is going to expire soon and the message like  "ORA-28002: 
the password will expire within 6 days" displays while connecting to config schema 
through sqlplus.

• The Config schema password is Modified.

  To resolve the error, re-set the config schema password to the old password. Else, if the config 
schema password is modified to something else then follow these steps:

1. Delete the $FIC_HOME/conf/Reveleus.SEC file.

2. Shutdown the OFSAAI App service: cd $FIC_APP_
HOME/common/FICServer/bin ./stopofsaai.sh

http://docs.oracle.com/cd/E61555_01/books/Configuration%20for%20High%20Availability%20%28HA%29%20Best%20Practices%20Guide.pdf
http://docs.oracle.com/cd/E61555_01/books/Configuration%20for%20High%20Availability%20%28HA%29%20Best%20Practices%20Guide.pdf
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3. Shutdown the OFSAAI App service: cd $FIC_APP_
HOME/common/FICServer/bin ./stopofsaai.sh

4. Start the Infrastructure Server in foreground directly on the server or through XWindows 
software using the command: ./startofsaai.sh

5. Enter System Password.

6. Enter the new Config schema password. The service starts and initializes if it is able to 
successfully connect to the DB and generates the Reveleus.SEC file.

7. Post successful startup of the service, if required, the Infrastructure server may be shut 
down and restarted in the background using nohup mode.

What is the mechanism of Log File sizing and backup?

OFSAAI Log files created under $FIC_APP_HOME/common/FICServer/logs & 
<OFSAAI_DEPLOYED_AREA>/<CONTEXT.war>/logs is configurable in 
RevLog4jConfig.xml.

The default size of the log files (MaxFileSize) is set to max 5000kb & number of max backup 
log files (MaxBackupIndex) retained is set to 5, both of which are configurable. Increasing 
these parameters to a higher value should depend on the server HW configurations and may 
reduce the performance.

To configure the Logs file size on OFSAA Application server, follow these steps:

1. Navigate to $FIC_HOME/conf where OFSAA is installed.

2. Edit the following parameters in the file RevLog4jConfig.xml

• <param name="file" : Enter the path where the Logs are to be generated.

• <param name="MaxFileSize" : Provide the required file size.

• <param name="MaxBackupIndex" : Provide the required number of backup files to be 
created.

Example: 

<appender name="REVSERVERAPPENDER" 
class="org.apache.log4j.RollingFileAppender">

<param name="file" value="$FIC_
HOME/ficapp/common/FICServer/logs/RevAppserver.log"/>

<param name="Append" value="true" />

<param name="MaxFileSize" value="5000kb" />

<param name="MaxBackupIndex" value="5" />

<layout class="org.apache.log4j.PatternLayout">

<param name="ConversionPattern" value="[REVELEUSLOG] %m%n"/>

</layout>

</appender> 

To configure the Deployed area logs file, follow these steps:

1. Navigate to <EAR/WAR Deploy area>/conf folder.

2. Repeat step 2 from the preceding section.

Can we modify the Log file path?

 Yes, Log file path is configurable, it can be configured in RevLog4jConfig.xml.default 
log file path (file) is set by the installer. This can be configured to another path. 
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Can I point the environment with HTTP enabled to HTTPS after installation and vice versa?

For more details, see the HTTPS section in the OFSAAI Administration Guide.

What should I do if my HIVE connection fails with the following exception:

java.sql.SQLException: [Cloudera][HiveJDBCDriver](500164) 

Error initialized or created transport for authentication: 

[Cloudera][HiveJDBCDriver](500168) Unable to connect to server: 
GSS initiate failed. 

                com.ibm.security.krb5.KrbException, status code: 37 

                message: PROCESS_TGS at 
com.ibm.security.krb5.KrbTgsRep.<init>(KrbTgsRep.java:20)

This happens if there is a clock skew between the client and the KDC server. To resolve this, 
there are two solutions:

• Solution 1:

Synchronize the clocks between the servers. For more information, refer 
http://docs.oracle.com/cd/E19253-01/816-4557/setup-192/index.html

• Solution 2:

1. Set clockskew parameter on the server side (KDC) krb5.conf file and replace the same 
file in  HIVE_LIBRARY_PATH folder. Parameter value should be decided on the 
basis of the time difference between the two machines.

2. Get the epoch time on the two servers by firing “date +%s” on the command line.

3. Clockskew param value should be chosen as a value sufficiently larger than the 
difference of the preceding two calculated values.

4. Set “clockskew = <value>” in the /etc/krb5.conf on the KDC server.

5. Restart Kerberos services.

What should I do if my schema creator log has the following exception:

Failed to detect a valid hadoop home directory 

java.io.IOException: HADOOP_HOME or hadoop.home.dir are not set. 

at org.apache.hadoop.util.Shell.checkHadoopHome(Shell.java:302) 

at org.apache.hadoop.util.Shell.<clinit>(Shell.java:327) 

at org.apache.hadoop.util.StringUtils.<clinit>(StringUtils.java:79) 
at 
org.apache.hadoop.security.Groups.parseStaticMapping(Groups.java:13
0) 

at org.apache.hadoop.security.Groups.<init>(Groups.java:94) 

at org.apache.hadoop.security.Groups.<init>(Groups.java:74) 

at 
org.apache.hadoop.security.Groups.getUserToGroupsMappingService(Gro
ups.java:303) 

at 
org.apache.hadoop.security.UserGroupInformation.initialize(UserGrou
pInformation.java:283) 

http://docs.oracle.com/cd/E19253-01/816-4557/setup-192/index.html
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at 
org.apache.hadoop.security.UserGroupInformation.setConfiguration(Us
erGroupInformation.java:311) 

at HdfsDbUtil.connect(HdfsDbUtil.java:162) 

at 
SchemaParserUtil.validateHiveConnection(SchemaParserUtil.java:1359) 

at SchemaParserUtil.checkAllPreChecks(SchemaParserUtil.java:1011) 

at Main.execute(Main.java:317) 

at Main.main(Main.java:145)

This occurs when  HADOOP_HOME environment variable is not set. You can ignore this 
exception since we do not mandate to install HIVE where OFSAA is installed.

What should I do if the sliced data model upload takes a long time to complete?

If the metadata cache size is set to a lower value than the actual count of each metadata type 
(hierarchy, dataset, dimension etc), then it gets into performance degrade issues. We have to 
increase the cache size for each  metadata type according to the count in the environment.

Following are the parameters in DynamicServices.xml to be configured depends  on the 
metadata count in your environment. 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000"/> 

 <PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000"/> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000"/> 

 <PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="3000"/> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000"/> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000"/> 

Metadata count can be derived based on the following queries:

select count(1) from metadata_master where metadata_version=0  --- for all metadata 

select count(1) from metadata_master where metadata_version=0  and metadata_type=1  --- for 
measure 

select count(1) from metadata_master where metadata_version=0  and metadata_type=2  --- for 
Dimension 

select count(1) from metadata_master where metadata_version=0  and metadata_type=3  --- for 
HCY 

select count(1) from metadata_master where metadata_version=0  and metadata_type=4  --- for 
DATASET 

select count(1) from metadata_master where metadata_version=0  and  metadata_type=59  --- 
for BP's 

select count(1) from metadata_master where metadata_version=0  and  metadata_type=54   --- 
for Alias 

select count(1) from metadata_master where metadata_version=0  and  metadata_type=5  --- 
for CUBES 
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select count(1) from metadata_master where metadata_version=0  and  metadata_type=856  --- 
for Derived Entity

For LDAP authentication, which server connects with the LDAP server, the Application server 
(where ofsaai is installed), or Web Application server (where EAR is deployed)?

For LDAP authentication, the Application server (ficapp) connects with the LDAP server.

The LDAP server in the setup listens on secure protocol ldaps (port 636). I have the root certificate 
of the LDAP server for SSL, and would like to know where to offload this certificate?  

You need to import the certificate into the JDK/JVM used by Reveleus server in ficapp layer.

How to relocate FTPSHARE folder?

You can run the PortC.jar utility. For more details, refer Changing IP/ Hostname, Ports, and 
Deployed Paths of OFSAA Instance section in the OFSAAI Admin Guide available on OHC 
Documentation Library.

How do we identify the list of ports that are used by/configured in an OFSAA environment?

1. Navigate to $FIC_HOME directory on Target.

The file PortsDef.log will be available in the $FIC_ HOME directory. It will contain the 
ports information.

What should I do if I get the following error message, "Error while fetching open cursor value 
Status : FAIL"?

This error occurs while executing envCheck.sh because the user does not have access to 
V$parameter. This error does not occur due to sysdba or non sysdba privileges provided 
they have access/grants to V$parameter.

What should I do when an entity containing many attributes (>100 columns) is selected as Source 
entity and the Data Mapping (T2T definition) save operation takes longer than expected with the 
hourglass in the UI continuously rotating?

The workaround is:

1. Locate the webserver deployed area webroot/conf/excludeURLList.cfg file.

2. Modify the following entries:

• [SQLIA]./dataIntegrator/ to [ALL]./dataIntegrator/

• [SQLIA]./ETLExtractionServlet to 
[ALL]./ETLExtractionServlet

3. Save the changes and restart the webserver.

4. Resave the definition.

What should I do if I get the following error message when I try to start the OLAP server?

./olapdataserver: error while loading shared libraries: 
libessapinu.so:

cannot open shared object file: No such file or directory FATAL ERROR :- OLAP DATA 
SERVER start up failed.

This error occurs when OLAP component is not configured and OLAP feature in OFSAA is not 
used. However, this error can be ignored.

What should I do if I get the error "FATAL ERROR-Problem with OFSAA Service" during 
OFS_AAAI_PACK installation?

Increase the sleep counter (default value is 80) to a higher value in the following section of the 
OFS_AAAI_PACK/OFSAAIUpdate.sh file:

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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if [ $count -eq 0 ] ; then sleep 80;

count=` grep -i "FICServer Initialization Complete"

$FIC_HOME/ficapp/common/FICServer/bin/nohup.out|wc -l ` fi

if [[ $count -gt 0 ]] ; then echo OFSAA Service - OK

 

else

echo FATAL ERROR-Problem with OFSAA Service

exit 1

fi

How do I upgrade to Oracle Database 12c Release 1 or 2, if my previous database versions are 
Release 11.2.0.2+, 12.1.0.1 or 12.1.0.2?

If you are upgrading the Database Server from the previous versions to the current versions 
mentioned in the following table:

Table S–2 

Sl. No. Source Database Version Destination Database Version

1 11.2.0.2+ or 12.1.0.1 12c Release 1 (12.1.0.2)   

2 11.2.0.3+, 12.1.0.1 or 12.1.0.2 12c Release 2 (12.2.0.1) 

Perform the instructions mentioned in the following MOS documents:

• Doc ID 2412630.1

• Doc ID 2075401.1

Application Pack FAQs
What is an Application pack?

An Application Pack is suite of products. For more information, refer About Oracle Financial 
Services Analytical Applications (OFSAA) Application Packs.

Can I get a standalone installer for OFSAA 8.0.7.0.0?

No. OFSAAI is part of every application pack and installs automatically.

How does OFSAA 8.0.7.0.0 Application pack relate to OFSAA 7.x series?

8.0.7.0.0 is a new major release consolidating all products from OFSAA product suite.

Can existing OFSAA 7.x customers upgrade to OFSAA 8.0.7.0.0 Application Pack? 

There is no upgrade path available. However, we will have migration kit / path for every 
product to 8.0.7.0.0 application pack. Further details will be available with Oracle Support.

Does OFSAA 8.0.7.0.0 Application pack UPGRADE automatically existing environments?

No. Refer Point 5. OFSAA 8.0.7.0.0 application pack has to be installed in an new environment 
and subsequently migration path / migration kit needs to be run to migrate from 7.x to 8.0. Note 
that we will have migration path only from the previously released version of OFSAA products.

Where can I download OFSAA 8.0.7.0.0 Application Pack?

You can download the OFSAAI 8.0.7.0.0 Application Pack from Oracle Software Delivery 
Cloud (OSDC).

https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=541614943224384&id=2412630.1
https://edelivery.oracle.com/osdc/faces/Home.jspx?_afrLoop=377944348633486&_afrWindowMode=0&_adf.ctrl-state=6hxlu86p6_4
https://edelivery.oracle.com/osdc/faces/Home.jspx?_afrLoop=377944348633486&_afrWindowMode=0&_adf.ctrl-state=6hxlu86p6_4
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=541614943224384&id=2075401.1
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What are the minimum system and software requirements for OFSAA 8.0.7.0.0 Application 
Pack?

Refer to Hardware and Software Requirements section.

Is my environment compatible with OFSAA 8.0.7.0.0 Application Pack? 

Environment Check utility performs the task. It is part of install and can also be run separately.

Has OFSAA 8.0.7.0.0 Application Pack is supports all Operating systems?

LINUX, AIX, SOLARIS. Refer to Technology Matrix for the technology matrix that OFSAA 
suite products are/ will be qualified on.

How can I install OFSAA 8.0.7.0.0 Application Pack?

Refer to Oracle Financial Services Advanced Analytical Infrastructure Installation And 
Configuration Guide published in OHC Documentation Library for the application pack 
installers.

Does this installation require any Third party Software? 

Oracle Financial Services Advanced Analytical Infrastructure Installation And Configuration 
Guide published in OHC Documentation Library lists the third party software that needs to be 
installed.

What languages are supported during OFSAA 8.0.7.0.0 Application Pack installation?

US English is the language supported.

What mode of installations OFSAA Application Pack supports? [i.e., Silent, GUI]

OFSAA Application Packs supports both, GUI and Silent Mode.

Does OFSAA 8.0.7.0.0 Application Pack support Multi tier Installations?

OFSAA 8.0.7.0.0 does single tier installation. For more information refer to OFSAAI FAQs 
section.

Does this Application Pack validate all Pre-requisites required for this installation i.e., 
Memory, Disk Space etc.?

Yes. The pre-requisite checks are done by the respective application pack installer. 

What happens if it aborts during installation of any application with in Application pack?

Customer needs to restore the system and retrigger the installation

Does this Application pack 'Rolls Back' if any of application installation fails due to errors?

Rollback of installation is not supported.

Does the Application pack install all applications bundled?

All application pack system files are installed but there is an option to enable the licensed 
products.

Can I re-install any of the Application Packs?

Yes. You can retrigger in case of failure.

Does this Application pack allow enabling / disabling any of the applications 

installed?

Yes. You cannot disable once the product is enabled in an environment.

I have installed one application in an Application pack, can I install any of new applications 
within the Application pack later ?

http://docs.oracle.com/cd/E55339_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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No, installation is not required. Enabling the application is an option to use it later.

How many OFSAA Infrastructures can be installed in a single server?

There is no issue in installing separate OFSAAI installations, each with their own PFT/FTP 
installations and separate associated database instances and separate Web Server installations 
on the same server as long as adequate memory is allocated for each instance and as long as 
each OFSAAI installation is installed using a separate UNIX user and profile. Care should be 
taken if running multiple OFSAAI installations 

on a single server. Adequate memory will be required for each installation as several OFSAAI 
processes (model upload, DEFQ services, etc) take significant amounts of memory. So it 
depends on your server memory.

Is it possible to Install OFSAA 8.0.7.0.0 Application pack on an existing 'Infodom' where 
another OFSAA 8.0.7.0.0 application is installed?

Yes. However, the Behavioral Detection Application Pack and Compliance Regulatory 
Reporting Application pack are the exceptions. They need to be installed in a different 
INFODOM.

Can I select an Infodom in Application pack during installation?

Yes. You can select or change the required infodom. 

Can I install all Application Packs in a 'Single Infodom'?

Yes. But Behavioural Detection Application Pack and Compliance Regulatory Reporting 
Application Pack are the exceptions. They need to be installed in a different INFODOM.

Is it possible to install applications on different Infodom within the Application pack? (That 
is if you want to install LRM & MR in two infodoms)

Applications within application pack have to be installed in the same information domain in the 
same environment.

How many Infodoms can be created over a single OFSAA Infrastructure of 8.0.1.0.0?

You can install only one infodom during installation. But after installation, you can create 
multiple infodoms.

Is the 'Data Model' bundled specific to an Application pack or to an individual application?

A merged data model for all applications within the application pack is bundled and uploaded.

Is it possible to install OFS Enterprise Modeling later ?

OFS Enterprise Modeling is a separate product and can be enabled as an option later from any 
application pack that bundles Enterprise Modeling.

Does the Application pack create sandbox automatically for the required applications?

Yes, Sandbox creation is part of application install process.

Are upgrade Kits available for individual applications or the complete Application Pack?

Maintenance Level (ML) Release / Minor Release upgrades are available across all 
applications.

Can I upgrade AAI only?

Yes, you can upgrade AAI alone.

Can I upgrade one application within the Application Pack? i.e., LRM will be upgraded in 
Treasury Application pack, but MR won't be upgraded.

No. Not possible Upgrade is applied across packs.
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Is it possible to uninstall any Application from the Application pack?

No, it is not possible to uninstall any Application from the Application Pack.

Can I uninstall entire Application Pack?

No, you cannot uninstall the Application Pack.

Is it possible to uninstall only application and retain AAI in the installed environment?

No, you cannot uninstall only the application and retain AAI in the installed environment.

Does Application Pack contain all Language Packs supported?

Language Packs need to be installed on 8.0 application packs.

Can I install an Application Pack over another Application Pack (that is same infodom or 
different infodom)?

Yes, you can install an Application Pack over another Application Pack in the same information 
domain or different information domain. But Behavioural Detection 

Application Pack and Compliance Regulatory Reporting Application Pack, Asset Liability 
Management Application Pack and Profitability Application Pack are the exceptions. They 
need to be installed in a different INFODOM.

Can I use an existing manually created schema as information domain for application pack 
installation?

No. Schemas required by OFSAA applications have to be created using Schema Creator Utility.

Does OFSAA 8.0.7.0.0 support on WebLogic 10.3.6 with Oracle 12c?

Yes, OFSAA 8.0.7.0.0 will support on WebLogic 10.3.6 with Oracle 12c. WebLogic 10.3.6 
supports oracle 12c with some additional configurations. Refer the link 
http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655 for 
additional configurations.

While running the schema creator utility, I get an error "HostName in input xml is not 
matching with the local hostname"?

 One possible reason could be the machine is configured for zonal partitioning. Ensure all the 
known IP Addresses of the machine are present in the /etc/hosts file.

What are the Java versions supported in OFS IFRS Application Pack version 8.0.7.0.0?

OFS IFRS Application Pack supports Java 1.7.x and 1.8.x.

Is this release of the OFS IFRS Application Pack version 8.0.7.0.0 supported on Java 8? 

Yes. To install this release of the OFS IFRS Application Pack version 8.0.7.0.0 on Java 8. For 
more information, refer to specific notes mentioned in the sections Installer and Installation 
PrerequisitesConfigurations supported for Java 8, Configuring the Schema Creator Utility, 
Installing in GUI Mode, and Installing in SILENT Mode.

What should be done if you encounter the following "FATAL" exception in the installation 
log because of insufficient DB process value?

[FATAL] - =====Exception====

java.sql.SQLRecoverableException: IO Error: Got minus one from a read call

at oracle.jdbc.driver.T4CConnection.logon(T4CConnection.java:419)

at oracle.jdbc.driver.PhysicalConnection.<init>(PhysicalConnection.java:536)

at oracle.jdbc.driver.T4CConnection.<init>(T4CConnection.java:228)

at oracle.jdbc.driver.T4CDriverExtension.getConnection(T4CDriverExtension.java:32)

http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655 for additional configurations
http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655 for additional configurations
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at oracle.jdbc.driver.OracleDriver.connect(OracleDriver.java:521)

Contact the DBA team to increase the DB process/sessions value accordingly, which depends 
on the number of database process running at that particular point of time.

Can I upgrade the Oracle Database version from 11g to 12C on which OFSAA 8.0.7.0.0 
version is installed?

Yes, you can upgrade. When the DB Server was Oracle 11g, the ojdbc jar used was ojdbc6.jar. 
But, when the DB is upgraded to 12c, you need to upgrade the ojdbc6.jar to ojdbc7.jar. 

Copy ojdbc7.jar from $ORACLE_HOME/jdbc/lib to the following locations:

• $FIC_HOME/utility/OFSAAGenerateRepository/lib/

• $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/

• $FIC_HOME/ficdb/lib/

• $FIC_HOME/ficapp/icc/lib/

• $FIC_HOME/ficapp/common/FICServer/lib/

• $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/

• $FIC_HOME/ficweb/webroot/WEB-INF/lib/

• $FIC_HOME/ficdb/etl/classes/

What should I do when I get "[ERROR] - Error: APP Setup bin file failed." message during 
OFS_Application_PACK installation? 

This is a generic error message that appears during application installation failure. You should 
check the installation log files for more information about what failed the installation. 
However, if the message is displayed and the log files are not generated, it could be that it is a 
temp directory issue. The resolution is that your UNIX administrator has to disable the 
NOEXEC option. The installers extract the installation files into the /tmp directory, and if 
NOEXEC is enabled, execution of binaries will not happen in the directory and the installation 
fails. Re-run the installer after the configuration is changed. For detailed information, see the 
support note at https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1.

Forms Framework FAQs
What should I do when I have large volume of data to be exported?

It is recommended to use BIP reports or OBIEE reports if you have to export large volume of 
data.

How do I export the columns added to the grid using Field Chooser option?

Perform Grid Export operation to export the columns added to the grid by Field Chooser 
option.

'Expand All/ Collapse All' button is not visible in the Hierarchy Browser window. What should I 
do?

Expand All/ Collapse All button is disabled if the number of hierarchy nodes is more than 50 
and if it is a non-custom hierarchy. Hierarchy with more than 50 nodes is considered as large 
hierarchy and the data will be fetched dynamically when you expand the parent node.

What is the difference between the two Searches available in the Hierarchy Browser window?

In the new Hierarchy Browser window introduced from 7.3.5.1.0 version, there are 2 search 
options available as highlighted in the following figure:

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1
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• DB Search (Top search container): It will search the required node in database and 
displays the result as shown below. This search is performed on full hierarchy nodes.

• UI search (Below the hierarchy): This search will find the required node in the UI and 
will show in tree structure. 

Note: In case hierarchy nodes are more than 50 and if it is a non-custom 
hierarchy, then the UI search will not show the required node in tree 
structure, until all the nodes are expanded and loaded manually in the UI.

What is a Custom Hierarchy?

Custom hierarchies will be having the parameter configuration customQuery as shown below 
and the customized query will be taken from the HIERARCHY_FILTER_MASTER table. 

Configuration in xml:

<CONTROL ID="1003" TYPE="41">

<CONTROLPROPS>

            <EXTRAPARAMETERS>



Error Dictionary

                       FAQs and Error Dictionary S-165

<PARAMETER NAME="customQuery" VALUE="Yes"/>

</EXTRAPARAMETERS>

</CONTROLPROPS>

    </CONTROL>

For custom hierarchy, all the hierarchy nodes are loaded in UI without any limit. 

So, even if the hierarchy nodes are more than 50, the UI search will show the required node in 
tree structure and ExpandAll and ExpandBranch images will be enabled.

Error Dictionary
This contents of this section has been created with the interest to help you resolve the 
installation issues if any. There is a compilation of all the possible errors that might arise during 
the installation process with the possible cause and the resolution to quickly fix the issue and 
proceed further with the installation.

This section includes the following topics:

• Accessing Error Dictionary

• Error Code Dictionary

Accessing Error Dictionary
Instead of scrolling through the document to find the error code, you can use the pdf search 
functionality. In the "Find" dialog available in any of the Adobe Acrobat version that you are 
using to view the pdf document, follow the below instructions to quickly find the error 
resolution.

1. With the Installation pdf open, press Ctrl+F or select Edit > Find.

2. The Find dialog is displayed as indicated.

3. Enter the error code that is displayed on window during Infrastructure installation.

4. Press Enter. The search results are displayed and highlighted as indicated below.

Figure S–1 Error Code

View the details of the issues, its cause, and resolution specific to the error code. Repeat the 
step to find an answer to any other errors that you notice during installation. If you are not able 
to resolve the issue even after following the steps provided in resolution, you can contact 
support.oracle.com along with log files and appropriate screen shots.

support.oracle.com
support.oracle.com
support.oracle.com
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Error Code Dictionary

Table S–3 Error code - OFSAAI-1001

Cause Unix shell is not "korn" shell.

Resolution Change the shell type to "korn". Use chsh unix command to change SHELL 
type.

Shell type can also be changed by specifying shell path for the Unix user in 
/etc/passwd file.

Note: chsh command is not available in Solaris OS.

Table S–4 Error code - OFSAAI-1002

Cause No proper arguments are available.

Resolution Provide proper arguments. Invoke Setup.sh using either SILENT or GUI 
mode.

Example: ./Setup.sh SILENT or ./Setup.sh GUI

Table S–5 Error code - OFSAAI-1004

Cause File .profile is not present in $HOME.

Resolution Create .profile in $HOME, i.e. in the home directory of user.

Table S–6 Error code - OFSAAI-1005

Cause File OFSAAInfrastructure.bin is not present in current folder.

Resolution Copy OFSAAInfrastructure.bin into installation kit directory.

Table S–7 Error code - OFSAAI-1006

Cause File CustReg.DAT is not present in current folder.

Resolution Copy CustReg.DAT into installation kit directory.

Table S–8 Error code - OFSAAI-1007

Cause File OFSAAI_InstallConfig.xml is not present in current folder.

Resolution Copy OFSAAI_InstallConfig.xml into installation kit directory.

6Error code - OFSAAI-1001

6Error code - OFSAAI-1002

6Error code - OFSAAI-1004

6Error code - OFSAAI-1005

6Error code - OFSAAI-1006

6Error code - OFSAAI-1007



Table S–9 Error code - OFSAAI-1008

Cause File validateXMLInputs.jar is not present in current folder.

Resolution Copy validateXMLInputs.jar into installation kit directory.

Table S–10 Error code - OFSAAI-1009

Cause File log4j.xml is not present in current folder.

Resolution Copy log4j.xml into installation kit directory.

Table S–11 Error code - OFSAAI-1010

Cause Unknown error occurred.

Resolution Make sure to provide proper argument (SILENT or GUI) to the Setup.sh 
file.

Table S–12 Error code - OFSAAI-1011

Cause XML validation failed.

Resolution Check InfrastructurePreValidations.Log for more details.

Table S–13 Error code - OFSAAI-1012

Cause Property file with locale name does not exist.

Resolution Copy MyResources_en_US.properties to the setup kit directory and keep 
en_US in LOCALE tag of OFSAAI_InstallConfig.xml.

Table S–14 Error code - OFSAAI-1013

Cause File OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml not 
found.

Resolution Copy OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml to 
the setup kit directory.

Table S–15 Error code - OFSAAI-1014

Cause XML node value is blank.

Resolution Make sure all node values except SMTPSERVER, PROXYHOST, 
PROXYPORT, PROXYUSERNAME, PROXYPASSWORD, 
NONPROXYHOST, or RAC_URL are not blank.
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6Error code - OFSAAI-1008

6Error code - OFSAAI-1009

6Error code - OFSAAI-1010

6Error code - OFSAAI-1011

6Error code - OFSAAI-1012

6Error code - OFSAAI-1013

6Error code - OFSAAI-1014



Table S–16 Error code - OFSAAI-1015

Cause XML is not well formed.

Resolution Execute the command dos2unix OFSAAI_InstallConfig.xml to convert 
plain text file from DOS/MAC format to UNIX format.

OR

Make sure that OFSAAI_InstallConfig.xml is valid. Try to open the file 
through Internet Explorer for a quick way to check validity. If it is not 
getting opened, create new OFSAAI_InstallConfig.xml using the XML_
Utility.jar.

Table S–17 Error code - OFSAAI-1016

Cause User installation directory contain blank spaces.

Resolution Provide an installation path that does not contain spaces. Check the tag 
USER_INSTALL_DIR in OFSAAI_InstallConfig.xml file. This path 
should not contain any spaces.

Table S–18 Error code - OFSAAI-1017

Cause User installation directory is invalid.

Resolution Provide a valid installation path. Check if you are able to create the 
directory mentioned in USER_INSTALL_DIR tag value of OFSAAI_
InstallConfig.xml file.

Error Dictionary
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6Error code - OFSAAI-1015

6Error code - OFSAAI-1016

6Error code - OFSAAI-1017
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